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,QWURGXFWLRQ�

This chapter provides an overview of the WirelessOffice client/server system, system components, 
as well as new and standard features. 

6\VWHP�2YHUYLHZ�

The WirelessOffice system is a client/server application that provides effortless, wireless 
messaging capabilities to both one-way and two-way pagers, digital PCS phones and hand-held 
wireless devices. It can also accept two-way device message response via E-mail Messenger.  

WirelessOffice is made up of software modules, called components, which reside on two separate 
computers: the client and the server. The client component runs on a personal computer or 
workstation and sends messaging requests to the server. The Server component runs on a Windows 
NT/2000 computer and services the messaging requests made by the components. Once you install 
and configure the server, users can compose and send alphanumeric messages to selected 
recipients within your system’s database. 

The following figure illustrates how a WirelessOffice system works:  

WirelessOffice clients are connected to the WirelessOffice Server via a local area network (LAN) 
or wide area network (WAN) using the TCP/IP protocol. The Server connects to wireless 
infrastructures via direct connection (for customer-owned wireless terminals), modem connection 
(for wireless carrier providers) or SMTP (Simple Mail Transfer Protocol). When you send a 
message through your client workstation, the request is sent to the Server and then on to the 
embedded dispatcher. The dispatcher passes the request to the appropriate wireless infrastructure 
based on information stored in the server’s database. 
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6\VWHP�&RPSRQHQWV�

The WirelessOffice Server acts as a hub to the WirelessOffice client components that are linked 
with TCP/IP. The Server processes and dispatches all incoming messages via modem, SMTP or 
RS-232 connection to the wireless messaging terminals.  
 
The following table briefly describes the WirelessOffice components: 
 

Components Former Name Description 

WirelessOffice 
Administrator 

Administration 
Client 

Provides remote administration of server-based users, security 
settings, groups, departments, and service providers, as well as 
direct messaging capabilities and logging status review. 

WirelessOffice 
Messenger 

Messaging 
Client 

Creates, schedules and sends messages with personal address 
book as well as server address book access. 

Command 
Messenger 

SendPage Implements command-line messaging that forwards alerts from 
third-party software. 

File Messenger FilePage Monitors shared file directories for ASCII text files, composed in a 
message format. Message-enables other operating system files 
and third-party file-writing software.  

Separately Sold WirelessOffice Components 

E-mail 
Messenger 

EPage Enables any SMTP-compliant e-mail software to send and 
forward page-enabled messages. Allows two-way devices to 
send responses back to WirelessOffice.  

Web Messenger JPage Offers a Web-based Java application for direct messaging and 
real-time message status from any Internet browser.  

Alarm 
Messenger 

SitePage Monitors RS-232 data stream and deciphers incoming ASCII 
characters against predetermined settings, immediately 
generating and sending alerts/notifications to designated 
recipients. Messages can be configured to escalate, ensuring 
prompt attention. 

Voice 
Messenger 

 Provides escalated message acknowledgment from any cell 
phone or telephone using Interactive Voice Response (IVR). 

 

1HZ�)HDWXUHV�

• Security profiling for all WirelessOffice users with 100 possible security levels (page 28) 

• User Name/Password authentication for server connections (page 13) 

• Two-way message response via E-mail Messenger 

• Escalation messaging using Command Messenger (page 97), File Messenger (page 113) and 
Alarm Messenger 

• Escalated message cancellation/escalation using WirelessOffice Administrator (page 62), E-
mail Messenger, Web Messenger, Voice Messenger and Alarm Messenger 

• Department membership and access assignments for users (page 38 and 41) 

• WirelessOffice Administrator ability to disconnect server users (page 55) 

• Export views to a comma-delimited file (page 18) 
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• Enhanced import wizard (page 65) 

• Increased user and group database capacity (21) 

• Security level assignments for groups and departments (page 26) 

• Enhanced sound event associations (page 54) 

• Windows Me and Windows 2000 compatibility 

 

6WDQGDUG�)HDWXUHV�

• Automatic communication port detection 

• On-site, dial-up or SMTP communication to virtually any wireless carrier 

• Remote administration from Windows 95/98/NT/2000 computers 

• Dynamic database updates 

• Runs as a Windows NT/2000 service 

• SMTP dispatch to wireless carriers 

• Automatic activity and message log maintenance, as well as carrier and port logging 
capability 

• Support for modem pools 

• Scheduled and delayed messaging 

• Device availability scheduling on a per user basis 

• WirelessOffice Administrator, WirelessOffice Messenger, File Messenger, and Command 
Messenger components 

• SQL Server database compatibility 

• Message sending via TAP or SMTP protocol to on-site or off-site wireless terminals 

• Sending capacity of up to 10,000 messages per hour 

• Integrates with existing file-writing and command-line utility programs as well as other 
operating systems 

• Extensive help documentation and user-friendly configuration wizards 

• E-mail Messenger e-mail and two-way messaging component (sold separately) 

• Web Messenger web-based Java component (sold separately) 

• Alarm Messenger RS-232 monitoring and detailed alerting component (sold separately) 
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*HWWLQJ�6WDUWHG�

This chapter lists hardware and software requirements, discusses pre-installation considerations, 
describes how to install and remove the WirelessOffice Server, as well as the components. 

6\VWHP�5HTXLUHPHQWV�

Requirements 
(Minimum) 

WirelessOffice 
Server 

Input 
Component: 
Alarm 
Messenger 
(sold 
separately) 

Input 
Components: 
File Messenger, 
Web Messenger 
(sold separately), 
E-mail 
Messenger (sold 
separately)  

Input 
Components: 
WirelessOffice 
Administrator, 
WirelessOffice 
Messenger & 
Command 
Messenger 

Input 
Component: 
Voice 
Messenger 
(sold 
separately) 

IBM-compatible 
PC with 
Pentium 200 
MHz**  

IBM-
compatible PC 
with Pentium 
200 MHz  

IBM-compatible 
PC with Pentium 
200 MHz 

IBM-compatible PC 
with 486 DX  

IBM-compatible 
PC with 
Pentium 200 
MHz  

64 MB RAM 64 MB RAM 64 MB RAM 16 MB RAM 64 MB RAM 

At least 50 MB 
available hard 
disk space 

At least 50 MB 
available hard 
disk space 

At least 50 MB 
available hard disk 
space 

At least 20 MB 
available hard disk 
space 

At least 50 MB 
available hard 
disk space 

Mouse Mouse Mouse Mouse Mouse 

LAN interface LAN interface LAN interface LAN interface LAN interface 

Network card*  Network card*  Network card* Network card* Network card*  

Serial com. 
port(s) 

Serial com. 
port(s) 

N/A N/A Voice/Data 
Modem 

Hardware 

TAPI-compliant 
modem (dial-up 
connections) 

N/A N/A N/A Speakers, 
audio card & 
microphone 
(optional) 

Windows NT 
4.0 Workstation 
or Server with 
Service Pack 
6a or later         
Windows 2000 
with latest S.P. 

Windows NT 
4.0 
Workstation or 
Server with 
Service Pack 
6a or later         
Windows 2000 
with latest S.P. 

Windows NT 4.0 
Workstation or 
Server with 
Service Pack 6a 
or later         
Windows 2000 
with latest S.P. 

Windows 95/98/Me 
Windows NT 4.0 
Workstation or 
Server with Service 
Pack 6a or later         
Windows 2000 with 
latest S.P. 

Windows 2000 
Professional or 
Server with 
latest S.P. 

TCP/IP 
protocol 

TCP/IP 
protocol 

TCP/IP protocol TCP/IP protocol TCP/IP 
protocol 

Software 

Latest MDAC 
Microsoft 
Access ODBC 
driver*** 

Latest MDAC 
Microsoft 
Access ODBC 
driver*** 

Latest MDAC 
Microsoft Access 
ODBC driver*** 

Latest MDAC 
Microsoft Access 
ODBC driver*** 

Latest MDAC 
Microsoft 
Access ODBC 
driver*** 

* A network card is only required for networked systems. An MS Loopback adapter may be used if the 
WirelessOffice system is a stand-alone. Instructions are listed on next page. 

**If sending more than 100 escalated messages at a time, increase system speed and RAM. 

***Go to www.microsoft.com. In the search field type “MDAC download”. Use the Microsoft Universal Data 
Access Download Page with the latest build (do not need SDK version).  
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Before you install the software, you should plan your system installation with certain 
considerations in mind. Review and plan your existing network or computer scheme before 
installation for a seamless WirelessOffice integration: 

Networking Configuration: Does your network have subnets? If so, make sure systems that will 
be using WirelessOffice components can connect with the server. 

Network Adapter Card: WirelessOffice requires a network card for networked systems.  If your 
system is going to be networked, TCP/IP must be installed as a protocol.  You are required to enter 
an IP Address.  You should be able to ping the IP Address of the WirelessOffice machine.  

For a stand-alone machine that will host both WirelessOffice Server and WirelessOffice 
Administrator, WirelessOffice Messenger and/or Alarm Messenger the network adapter card is not 
a requirement to run TCP/IP.  Microsoft offers a network adapter card called MS Loopback 
Adapter, which will simulate the network card on a standalone PC. Although a network card is not 
a requirement, the TCP/IP protocol is required for the communication between applications. If you 
do not have a network card, please follow these instructions: 

Step 1. To Install MS Loopback 

1. Go to Start | Settings | Control Panel | Network | Adapter tab. 

2. Delete all other adapters. Then click Add. 

3. Select MS Loopback Adapter. During setup, Specify an IP Address with 127.0.0.1 as 
the IP Address. Type 1.1.1.1 as the Subnet Mask. The Default Gateway does not need 
to be changed. Click OK. 

Step 2. To Install the TCP/IP protocol 

1. Go to Start | Settings | Control Panel | Network | Protocols tab. Click Add. 

2. Select TCP/IP protocol. Click OK. 

Firewall: To use WirelessOffice through a firewall, the following ports must be opened:  

To the Server Port 

Dynamic 1024+* 

From the Server  

WirelessOffice Messenger 12396 

WirelessOffice Administrator 12397 

Alarm Messenger 12398 

Internet Port  

Web Messenger 1515 Java 

* The firewall output connect ports are currently dynamically chosen by the RPC run-time. 



Getting Started 

   7

System Hardware and Software Requirements: Make sure that the server and component 
systems meet the minimum requirements before loading the CD. 

WirelessOffice Server and Client Components: Map out which system will become the 
WirelessOffice Server. Some WirelessOffice components need to be loaded only once and others 
require loading onto the system that will be implementing them. 

Server Considerations: You must log on with Windows NT/2000 administrative privileges to 
install the server software.  Only one WirelessOffice Server may be installed on a computer. All 
WirelessOffice client components can be installed on the same system as the server. Windows NT 
Server is preferred over NT Workstation for higher messaging volume systems. 

WirelessOffice Administrator Considerations: Install WirelessOffice Administrator on the 
server system or any remote system running Windows 95, 98, Me, NT or 2000. 

WirelessOffice Messenger Considerations: Install the WirelessOffice Messenger on any network 
system running Windows 95, 98, Me, NT or 2000. A special “Messenger only” installation is 
included on the CD-ROM for easy network distribution. Please see “Distributing WirelessOffice 
Messenger to Networked PCs” on page 10. 

Command Messenger Considerations: Install Command Messenger on each target system that 
will be implementing it. The network system must be running Windows 95, 98, Me, NT or 2000. 
For instance, if you will be message-enabling Performance Monitor using command-line 
messaging, install Command Messenger onto the monitoring system. 

File Messenger Considerations: You can install File Messenger on any network system running 
Windows NT/2000, but your third party applications must be able to share a directory on that 
system. File Messenger only needs to be loaded onto one computer that is networked with the 
server, but may be loaded on as many systems as needed.  

Arrange to use File Transfer Protocol (FTP) of Microsoft Internet Information Server to share 
files across the directory from other operating system computers. IIS 3.0 or higher can be installed 
with the FTP protocol in order to receive text messages into the machine running File Messenger. 
FTP can be set up with an anonymous login, receiving files to the c:\inetpub\ftproot\ directory. File 
Messenger must have an entry in the Directories tab that matches your FTP setup.  

Alarm Messenger Considerations: Install Alarm Messenger on any network system running 
Windows NT/2000, including the server.  

E-mail Messenger Considerations: You can install E-mail Messenger on any network system 
running Windows NT/2000 (including the WirelessOffice Server) with one exception. Due to 
Internet Protocol (IP) port conflicts, you cannot install E-mail Messenger on your e-mail server. 
You must be able to ping your domain name before installing E-mail Messenger. If you decide that 
mobile.company.com will be your domain, you must be able to get a REPLY by going to the 
Command Prompt and pinging mobile.company.com. 

Once E-mail Messenger is configured and a domain is established, any network system with e-mail 
software can send E-mail Messenger messages. To receive external requests and for two-way 
functionality, E-mail Messenger must be accessible from the Internet and not behind a firewall. 

Web Messenger Considerations: Install Web Messenger on your networked Windows NT/2000 
Web server system. After configuring your Web server, any system with an Internet browser 
networked to the Web server will be able to access Web Messenger. If you are using Internet 
Explorer version 5.0 to view the application, you must install Microsoft Virtual Machine. 
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Voice Messenger Considerations: Install Voice Messenger on any Windows 2000 network 
system, including the server. Connect the recommended voice modem to that system. 

Other Considerations: The product CD contains the product manual in .pdf format, a royalty-free 
Adobe Acrobat Reader, and a woreadme.txt file that contains additional information. 

8SJUDGLQJ�:LUHOHVV2IILFH�

To upgrade from a previous version of WirelessOffice, the Installation Wizard will convert and 
integrate the past version database and settings information. You will be required to enter a new 
Authorization Code when upgrading to WirelessOffice 3.0. A default security setting will be 
applied globally to the database. There is no need to remove the previous version of 
WirelessOffice before upgrading.  

Note: If upgrading from WirelessOffice version 2.0, you do not need to use the 
Administrator Tools to upgrade the database – the database conversion occurs 
automatically when you install WirelessOffice 3.0. 

You cannot run both versions of WirelessOffice 2.0 and 3.0 on the same system. 
 

Air Apparent or Site Alert products require that you use the Administrator Tools to update the 
database after installing WirelessOffice version 3.0. Database updating information is located in 
“Appendix A: Administrator Tools” on page 186. 

The WirelessOffice Access database may be exported to SQL Server. For information on when to 
use SQL Server and how to upsize, please see “SQL Server Database Conversion” on page 191. 

,QVWDOOLQJ�:LUHOHVV2IILFH�

The WirelessOffice CD contains an installation wizard program.  This program allows you to 
install any combination of the following software components on the target install computer: 

• WirelessOffice Server 
• WirelessOffice Administrator 
• WirelessOffice Messenger 
• Command Messenger 
• File Messenger 
• E-mail Messenger - sold separately, but bundled on the WirelessOffice product CD 
• Web Messenger - sold separately, but bundled on the WirelessOffice product CD 
• Alarm Messenger - sold separately, but bundled on the WirelessOffice product CD 
• Voice Messenger - sold separately, but bundled on the WirelessOffice product CD 

    7R�LQVWDOO�:LUHOHVV2IILFH� 
Before installing, make sure you have your assigned Authorization Code. The code is located on 
the back of the CD jewel case. If you are upgrading from a previous version of WirelessOffice or 
Air Apparent, you will be issued a new Authorization Code.   
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1. Insert the WirelessOffice 3.0 CD into the CD-ROM drive. If AutoPlay is enabled, the setup 
program will automatically start. If AutoPlay is not enabled, go to Start, then select Run. 
Type D:\setup.exe where D:\ represents the CD-ROM drive letter. 

2. The Welcome window automatically displays. Click Next.  

3. The Software License Agreement dialog will now display. Click Yes if you accept the terms. 

4. The User and Company Information dialog box displays. Type your name in the Name box. 
Enter the name of your company in the Company box. Click Next. The system will then 
search for any previous software versions for upgrading information. 

5. The Enter Destination dialog box displays. To install WirelessOffice in the default directory 
click Next. Or to specify an existing folder, click the Browse button, then select a folder from 
the Existing Folders list box. Click Next.  

6. The Select WirelessOffice Components dialog displays. Choose the components you wish to 
install (or upgrade). All components can be installed on the same system if desired, assuming 
minimum hardware and software requirements are met.  

7. Select Administrator Tools if you will need to upgrade an Air Apparent or Site Alert 
database, will be converting the database to SQL Server, or require Adobe Acrobat Reader to 
view the System Administrator Manual in .pdf format. Click Details to specify which 
Administrator Tools you would like to install. Click Next.  

8. The Enter Information dialog will display. Type your Authorization Code, which is located 
on the back of the CD jewel case, into the space provided and click Next. If you are 
upgrading, your old Authorization Code will display. A new Authorization Code is required. 
Click Next. 

9. In the Select Program Folder dialog click Next to accept the default folder. Or to specify a 
new folder, enter the folder name in the Program Folders box, then click Next. Or to specify 
an existing folder, select a folder from the Existing Folders list box, then click Next. 

10. If you checked Web Messenger in the Select WirelessOffice Components dialog box, the 
Enter Web Messenger Destination dialog will appear next.  Select the correct directory to 
install Web Messenger so your Web server can see it. Typically you should use the default 
c:\inetpub\wwwroot\webmsgr location. If you did not check Web Messenger or are upgrading 
it, this dialog will not appear. 

11. The Start Copying Files dialog box displays. Verify the current settings, then click Next. 
You will see a progress indicator as the system copies the program files onto your computer.  

12. The Specify WirelessOffice Server dialog box displays. Enter the Server name or Internet 
address of the computer running the server, so WirelessOffice Administrator can be opened.  
The server name is preferred, especially if IP addresses change frequently. Locate the server 
name by right-clicking on the Network Neighborhood desktop icon and select Properties. 
Find the Computer Name on the Identification tab. Click Next. 

13. The Specify Administrator Password dialog box displays. To login to WirelessOffice 
Administrator you will be required to enter the Login Name of ‘Administrator’ and this 
Password. Type a Password and then Confirm Password. The password should be 1-20 
characters in length. It can be changed at any time in WirelessOffice Administrator. Please see 
“To modify the server Setup tab” on page 22. 
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Note: Do not lose this password. It is required to initially login to WirelessOffice 
Administrator using the ‘Administrator’ Login Name. 

 

14. The services, if selected, are then installed. The Select Desktop Shortcuts dialog displays. 
Select the appropriate check boxes to create desktop shortcuts for WirelessOffice 
Administrator, WirelessOffice Messenger, and Alarm Messenger (if selected to install). Click 
Next. 

15. The Setup Complete dialog displays. Select View WirelessOffice Release Notes to auto-
launch the release notes after finishing installation. Click Finish. Reboot only if instructed. 

16. This concludes the WirelessOffice installation.  

'LVWULEXWLQJ�:LUHOHVV2IILFH�0HVVHQJHU�WR�1HWZRUNHG�3&V�

The main installation program, which is launched when you run setup.exe from the CD-
ROM, is the full installation program for all WirelessOffice components.  When installing 
under Windows 95/98, certain components will not be visible because they are only meant 
to be run under Windows NT/2000.  However, when running the full install under Windows 
95/98/Me, the user is allowed to select WirelessOffice Administrator and/or WirelessOffice 
Messenger.  WirelessOffice Administrator does run under Windows 95/98/Me, and this is 
provided for those administrators who wish to configure and monitor WirelessOffice Server 
from Windows 95/98/Me.   

In order to distribute the WirelessOffice Messenger ONLY (to Windows 95/98/Me/ 
NT/2000 users), without risking end users inadvertently installing WirelessOffice 
Administrator, a ‘Messenger only’ installation is provided on the installation CD-ROM in a 
folder called ‘sysadmin util’ which is a straight install of WirelessOffice Messenger.  This 
install can be placed on a network drive to which users can attach and run the installation. 

The CD contains diskette images of the software in case you need to distribute 
WirelessOffice Messenger from 3.5-inch floppy diskettes. 

Note: When installing WirelessOffice Messenger over the network using the Messenger 
only installation, the system administrator can set up the wonet.ini file in the root 
directory of this install program to pre-configure the network address of the 
WirelessOffice Server.   

 

[Server] 

HostName=<Internet Address> 

 

Example: 

[Server] 

HostName=100.10.10.10 
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5HPRYLQJ�:LUHOHVV2IILFH�

Removing the software deletes only those files and directories that are initially installed. Log and 
database files remain on your system. 

� 7R�UHPRYH�:LUHOHVV2IILFH��
1. From the taskbar, click Start, point to Settings, and then click Control Panel. Double-click 

the Add/Remove Programs icon. 

The Add/Remove Programs Properties dialog box displays (as depicted on a Windows NT 
system, other operating systems may differ):  

2. Select Emergin WirelessOffice from the list box, then click Add/Remove.  The Confirm 
File Deletion dialog box displays. Click Yes.  

Note: Close Control Panel after opening the Add/Remove Programs Properties 
dialog so the software removal is complete. 
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8VLQJ�:LUHOHVV2IILFH�$GPLQLVWUDWRU��

6WDUWLQJ�WKH�6RIWZDUH�

WirelessOffice Administrator must initially be opened using the ‘Administrator’ User Name. This 
is the only account that may administer the Server Configuration settings and may only be used to 
login to one application at any given time.   

� 7R�VWDUW�WKH�VRIWZDUH��
1. Launch WirelessOffice Administrator by double-clicking the desktop icon. 

2. To launch from the taskbar, click Start, point to Programs, select Emergin WirelessOffice 
then WirelessOffice Administrator. 

The Welcome to WirelessOffice dialog displays:  

3. In the User Name text box type Administrator upon first entry to WirelessOffice 
Administrator. Type the Password that was established during installation. Select Remember 
password to allow future logins to that system’s WirelessOffice Administrator to be 
automatically surpassed. To force each user to login with their User Name and Password, do 
NOT check Remember password. 

4. Type the Server name established during installation. Click OK. The WirelessOffice 
Administrator window displays. 

Note: The WirelessOffice ‘Administrator’ account is not related to Windows NT/2000 
administrative privileges. 

To add/start/stop server services, click Tools and select Change Authentication 
Mode. Select Windows and WirelessOffice. Exit and re-start WirelessOffice 
Administrator. Configure the server(s) as needed. Change the authentication mode 
back to WirelessOffice. Please see “Change Authentication Mode” on page 19 for 
more information. 
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8QGHUVWDQGLQJ�6\VWHP�%DVLFV�

This section provides basic system information that you should know before you begin. The first 
time you start WirelessOffice Administrator you will notice that there are two main application 
windows. These are called: Server Activity and Server Administration. Each of these main 
windows has five sub-windows. You can switch between the sub-windows by clicking on the five 
tabs at the bottom of each main window. You can choose to lay out the windows to your liking.  
The default layout is horizontal – you are able to see the most information on your screen this way. 

�� 0DLQ�$SSOLFDWLRQ�:LQGRZ�
Before you begin, it is important that you become familiar with the WirelessOffice Administrator 
main application window. 

��
Menu Bar 

Toolbar 

Tabs 

Status Bar 

Tabs 
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0HQX�%DU�
The menu bar provides options that you can use to activate WirelessOffice and standard Windows 
functions. The step-by-step instructions detailed later in this manual refer to the menu bar 
functions. 

File Edit View 

Properties 
New >                            
>User 
>Group 
>Department  
>Carrier 
>Port 
Save As 
Print 
Print Preview 
Print Setup 
Change Server 
Exit 

Delete 
Delete All 
Select All 
Find 

Toolbar 
Status Bar 
Activity View 
Administration View 
Large Icons 
Small Icons 
List 
Details 
Tabs  
Refresh 

Tools Window Help 

Server Configuration 
Compose Message 
Send Administrator Alert 
Resend Message(s)  
Message Log Statistics  
View Backup Activity Log 
Import Wizard         
Change Authentication 
Mode 

Cascade 
Tile Horizontally 
Tile Vertically 
Server Administration 
Server Activity 

Help Topics 
Tip Of The Day 
Emergin Knowledge Base 
About WirelessOffice 
Administrator 
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�� 7RROEDU�
The toolbar provides an alternative method to accessing the menu bar options. Once you are 
familiar with the icons, you can directly select various functions from the toolbar. 

Icons Description  Icons Description  Icons Description 

 
New User  

 
Refresh  

 
Small Icons 

 
New Group  

 
Find  

 
List 

 
New 
Department 

 
 

Server 
Configuration 

 
 

Details 

 
New Carrier 

 
 

Compose 
Message 

 

 

Cascade 
Windows 

 
New Port 

 
 

Statistics 
 

 
Tile Windows 
Horizontally 

 
Properties 

 
 

Print 
 

 
Tile Windows 
Vertically 

 
Delete  

 
Large Icons  

 
Help Topics 

�� 6WDWXV�,FRQV�
There are four sets of status icons to become familiar with: Connections, Activity Log, Message 
Log and Scheduled Messages. There are no status icons for the Escalated Messages tab. 

�� &RQQHFWLRQ�6WDWXV�,FRQV�
The following table describes each icon depicted in the Connections window:  

Icons Description  Icons Description 

 
WirelessOffice Administrator 

 
 E-mail Messenger  

 
WirelessOffice Messenger 

 
 Web Messenger 

 Command Messenger 
 

 
Alarm Messenger 

 
File Messenger  

Any component developed by a 
third party 
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�� $FWLYLW\�/RJ�6WDWXV�,FRQV�
The following table describes each icon that is depicted in the Activity Log window: 

Icons Description  Icons Description 

 
The server was started. 

 

 
A message was sent. 

 
System configuration data was 
added. 

 

 

Warning — a system limit was 
exceeded, e.g., too many characters. 

 
System configuration data was 
modified. 

 

 

Error — a system error has occurred, 
e.g., user has no defined devices. 

 

System configuration data was 
deleted. 

 

 

Connection — a client has connected 
or disconnected from the server. 

�� 0HVVDJH�/RJ�6WDWXV�,FRQV�
The following table describes each icon that is depicted in the Message Log window: 

Icons Status/Description  Icons Status/Description 

 

Partial Success — the wireless 
carrier rejected at least one 
message from a multi-recipient 
message. 

 

 

Unknown — the system cannot 
determine the status of the message, 
generally caused by stopping the 
service when a message is queued. 

 
Queued — the wireless carrier 
has not dispatched the message. 

 
 

No Ports Configured — the port is not 
configured. 

 

Accepted — the wireless carrier 
acknowledged and accepted 
message. 

 

 
No Direct Connection — a direct 
connect carrier is not configured. 

 
Rejected — the wireless carrier 
rejected the message. 

 

 

No Device Configured — the user has 
no device defined or currently 
enabled. 

 
Failed — a critical system error 
occurred. 

 
 

No Modem Configured — a modem 
has not been configured. 

 
Acknowledged — a two-way 
device responded to a message.  
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�� 6FKHGXOHG�0HVVDJH�6WDWXV�,FRQV�
The following table provides a description of each Scheduled Message status icon. 

Icons Status/Description 

 

Delayed Message — the message is scheduled for 
later delivery (one time only). 

 
Daily Message — the message will be sent on a 
daily basis. 

 
Weekly Message — the message will be sent on a 
weekly basis. 

 
Monthly Message — the message will be sent on a 
monthly basis. 

�� 6WDWXV�%DU�
The status bar is found under the lower tab bar. The information it displays varies depending on 
which window is active. The status bar displays the total number of: 

• User connections 
• Activity Log entries 
• Message Log entries 
• Scheduled messages 
• Escalated messages 

• User records 
• Group records 
• Department records 
• Configured carriers 
• Configured ports

 
Additionally, as you move your mouse pointer over the various toolbar icons, the left side of the 
status bar explains the action associated with the icon. 

$UUDQJLQJ�:LQGRZV�

WirelessOffice Administrator allows you to configure your window views. Arranging the window 
views can be done two ways: 

• By selecting Window from the menu bar, click Cascade, Tile Horizontally or Tile 
Vertically. 

• By clicking the layout icons from the toolbar.           

3ULQWLQJ��6DYLQJ�:LQGRZV�&RQWHQWV�

WirelessOffice Administrator allows you to print or save the contents of any window. Printing can 
be initiated in two ways: You can select Print from the File menu bar, or click the Printer icon on 
the toolbar. You can also save the tabbed views as comma-delimited, as well as text files. 
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&KDQJH�$XWKHQWLFDWLRQ�0RGH�

In order to stop, start or add servers you must first change the authentication mode to require both 
Windows and WirelessOffice authentication. 

� 7R�FKDQJH�DXWKHQWLFDWLRQ�PRGH��
1. Click Tools and select Change Authentication Mode.  

The Authentication Mode dialog displays: 

2. Select WirelessOffice Only to display the Welcome to WirelessOffice dialog that does not 
require operating system authentication by the remote machine. WirelessOffice Administrator 
users simply login with their name and password and select a server to connect to. Users 
cannot start or stop servers. This is the default setting. 

3. Select Windows and WirelessOffice to display the WirelessOffice Login dialog, which 
requires operating system authentication on the remote machine. WirelessOffice 
Administrator users login with their name and password and can view/add/start/stop servers. 

Note: If remote WirelessOffice Administrator systems will need to login to 
WirelessOffice Server and do not have operating system administrative 
privileges for the server system, use the WirelessOffice Only setting. 
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6WDUWLQJ�DQG�6WRSSLQJ�WKH�6HUYHU�

In order to stop, start or add servers you must first change the authentication mode to require both 
Windows and WirelessOffice authentication (see “Change Authentication Mode” on the previous 
page). Once that setting is configured, you must be logged into the Windows NT/2000 system with 
operating system administrative privileges. 

� 7R�VWDUW�WKH�VHUYHU��
1. Open WirelessOffice Administrator by double-clicking the desktop icon. Or if the application 

is already open, click File from the menu and select Change Server.  

The WirelessOffice Login dialog box displays: 

2. Click the Add button. The Add Service dialog box displays. 

3. Enter host name or IP address information and make sure the WirelessOffice Server is 
chosen as the service type. Click Add. 

4. If the server is not already running, click the Start Service arrow icon. Type your User Name 
and Password if not already done. Click Connect. 

Note: If WirelessOffice Administrator is loaded on the WirelessOffice Server system, locate 
the server name or address by right-clicking the Network Neighborhood desktop icon 
and select Properties. Find the Computer Name on the Identification tab. 

� � �7R�VWRS�WKH�VHUYHU��
1. To stop the server, select Change Server from the File menu. The WirelessOffice Login 

dialog box displays. 

2. Select the server and press the Stop Service button. 
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&RQILJXULQJ�:LUHOHVV2IILFH�6HUYHU�

This chapter describes how to customize your system setup and details server capacity, server 
configuration, as well as port, carrier, department, user and group setup. 

6HUYHU�&DSDFLW\�

The following table lists the recommended maximum software capacity for system configuration:  

Parameter Recommended Maximum 

COM Ports per Server 20 

Carriers 200 

Groups 2,500 

Departments 2,500 

Messages in Message Log 1,500 

 

The following table lists the software capacity for system configuration: 

Parameter Maximum Capacity 

Users 50,000* 

Devices per User 10 

Members per Group 1,000 

Members per Department Reflects user licensing 

*User maximum capacity will depend on your software license.                                                           
SQL Server database recommended for 3,000 users and above. 

 

0RGLI\LQJ�6HUYHU�&RQILJXUDWLRQ�

When you install WirelessOffice, the system provides default server settings. These include 
information about protocol, security, automatic purging of log entries, maximum message length, 
database type, authorization code, ‘Administrator’ password, and auto resend.  

Note: Only the ‘Administrator’ User Name has access to these settings. Other 
WirelessOffice Administrator connections, logged in by different user names, will 
not have access. Also, only one ‘Administrator’ User Name connection will be able 
to login at any given time. Create user login accounts for other applications, e.g. 
Command Messenger as the Login Name with appropriate security settings.  
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��������� ��7R�PRGLI\�WKH�VHUYHU�6HWXS�WDE��
1. From the Tools menu bar, select Server Configuration. 

 The Server Configuration dialog displays, open to the Setup tab. 

2. Select Disable Security to remove the security level and access rights evaluation 
requirements. Users will still need to login with their User Name and Password. The only 
security measure left intact will be WirelessOffice Administrator Server Configuration 
settings, which is only available to the ‘Administrator’ account. Please see “Security Settings” 
on page 28 for more information about security. 

3. Select Disable Scheduling to globally remove the ability to schedule new messages and to 
stop the sending of currently scheduled messages. If a scheduled message exists, it will be 
deleted at the time and date it was scheduled to send at. If a scheduled message is set to recur 
indefinetely, the message will remain in place and become active if scheduling is re-enabled.  
Escalated messages are not affected. 

4. On Startup controls what happens when the server starts up. Select Resend expired 
scheduled messages to send upon startup any messages that were scheduled while the server 
was not running. 

5. Select Resend queued messages to send upon startup any queued messages not yet sent when 
the server was last stopped. 

6. Enter the maximum number of characters allowed per message in the Maximum Length text 
box. Most carriers can break messages into fragments. For example, you can send a 2000 
character length message to a carrier that accepts 256 character message blocks. The message 
will then be broken into 8 fragmented messages. This setting differs from the carrier Block 
Size setting. 

7. To update the Authorization Code, click the Change button in the Authorization Code area. 
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The Change Authorization Code dialog displays: 

8. After changing the Authorization Code, click OK. The Server Configuration dialog will 
redisplay. 

9. Select Change Administrator Password to make a change to the password that grants access 
to the main ‘Administrator’ user account (which has access to the Server Configuration 
settings). This password was initially established during installation.  

Note: If the password is lost or forgotten, in order to reset this password you must re-install 
WirelessOffice on this system. Be sure to retain your database. The install will set a 
new password for this account. 

([SLUHG�$XWKRUL]DWLRQ�$FFHVV�

If you did not purchase WirelessOffice, the product is running in DEMO mode and will only 
function for a limited period of time. At the end of this trial period, you will see the following type 
of message in the Event Viewer, Application section when you attempt to start the server to launch 
any WirelessOffice components:  

WirelessOffice Administrator cannot start because it is not registered.  
Please contact Emergin at 1-888-922-7638 or 1-561-361-6990. 

To re-enable WirelessOffice Server and the components you were using, you will be issued a valid 
Authorization Code upon purchase of the products. Please see “To modify the server Setup tab” on 
the previous page. 
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� 7R�PRGLI\�WKH�VHUYHU�/RJJLQJ�WDE��
For more information about server logging, refer to “Appendix C: Server Logging” on page 205. 

 
1. Click the Logging tab of the Server Configuration window. 

The Logging tab dialog will display:  

2. The Log file directory displays the location of the message and activity log files on the 
Server system. If you wish to use a different directory, click the Browse button. 

3. In the Message Log section, select your archiving options. As the number of sent messages 
increases, the size of the Message Log also increases. Adjust the number of days or messages 
to automatically archive at according to your messaging volume. In order to maintain 
optimum performance, the Message Log can be archived in one of three ways: daily, weekly, 
or monthly. 

Note: The Archive file name will change corresponding to your choice of archiving 
frequency. Recommended archiving frequency is 5 days or 1500 messages. 

 

4. Click the Activity Log tab to view Activity Log settings. Enter the Maximum file size (in 
kilobytes) of the Activity Log (default is 128). When the file becomes full it is renamed to .old 
and a new file is created.  Click OK. You do not have to restart the server to realize the 
changes.       

� 7R�VHW�XS�WKH�VHUYHU�'DWDEDVH�WDE��
The Database tab allows the system administrator to switch between data sources or upgrade to 
SQL Server. Each data source refers to a different database. All data sources on the server 
computer beginning with “WirelessOffice 3.0” appear in the list. User ID and Password are only 
active when you are using a Microsoft SQL Server data source. 
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� 7R�VHW�XS�WKH�VHUYHU�6073�WDE��
1. Click the SMTP tab of the Server Configuration window. 

The SMTP tab dialog displays: 

2. The SMTP tab allows SMTP Settings to be configured for the use of e-mail to submit 
messages to carriers that support SMTP messaging to devices.  Type the name or Internet 
address of an onsite SMTP gateway, e.g. mail.domain.com. The Port address is usually 25. 

3. Timeout and Retry delay can be set, however we suggest using the default settings.  

4. Sender ID indicates who the e-mail is coming from, e.g. reply@mail.domain.com. This text 
box cannot be left blank.  

Note: If using two-way response via E-mail Messenger, the Server and the Sender ID 
From fields must be properly configured. 

 

� 7R�VHW�XS�WKH�VHUYHU�$XWR�5HVHQG�WDE��
The Auto-Resend tab allows you to globally specify certain time intervals for the auto-resend 
feature. If the Enabled box is checked, global auto-resend settings will be applied to all devices 
that have Global rather than Custom checked in their auto-resend settings.  For more information, 
see “Global Auto-Resend Settings” on page 54.  
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6HFXULW\�

The following table defines the terms you will need to know to configure security settings: 

Term Definition 

User Security Level Reflects a number in the range of 0 to 100, allowing messaging capabilities. 

Administrator Security 
Level (for Users) 

Reflects a number in the range of 0 to 100, allowing WirelessOffice 
Administrator editing, viewing, adding and deleting capabilities. 

Same or Lower Qualifier that is coupled with the Security Level to define access. Allows 
messaging or WirelessOffice Administrator access to the same level and all 
levels below the user’s assigned security level. 

Same Qualifier that is coupled with the Security Level to define access. Allows 
messaging or WirelessOffice Administrator access to the same level as the 
user’s assigned security level. 

User Rights Security rights affecting messaging and WirelessOffice Messenger 
capabilities. 

 Group Messaging When selected, the user can send messages to groups according to their 
security level and same/same or lower qualifier.  

 Departmental 
Messaging 

When selected, the user can send messages to departments that have 
been defined as accessible in their user profile. No security level is 
evaluated. 

 Message Scheduling When selected, the user can schedule messages. 

 Personal Address 
Book 

When selected, the user can configure their own Personal Address Book in 
WirelessOffice Messenger. 

 Device Editing When selected, the user can add, delete and modify their device(s) in 
WirelessOffice Messenger. 

Administrator Rights 
(for Users) 

Security rights affecting WirelessOffice Administrator abilities to view, add, 
edit, and/or delete configurations or logs.  

 Users When selected, the user can view, add, edit or delete user profiles 
according to their security level and same/same or lower qualifier. 

 Groups When selected, the user can view, add, edit or delete group profiles 
according to their security level and same/same or lower qualifier. 

 Departments When selected, the user can view, add, edit or delete department profiles 
according to their security level and same/same or lower qualifier. 

 Carriers When selected, the user can view, add, edit or delete carrier profiles.  

 Ports When selected, the user can view, add, edit or delete port profiles.  

 Connections When selected, the user can view or disconnect client connections.  

 Activity Log When selected, the user can view or delete activity log entries.  

 Message Log When selected, the user can view or delete message log entries according 
to their security level and same/same or lower qualifier. 

 Scheduled 
Messages 

When selected, the user can view, edit or delete scheduled message 
entries according to their security level and same/same or lower qualifier. 

 Escalated Messages When selected, the user can view, escalate, or cancel escalated message 
entries according to their security level and same/same or lower qualifier. 
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6HFXULW\�([DPSOHV�

The following table describes sample scenarios of security level and access rights: 

User Name General 
Messaging 
Capabilities 

WirelessOffice 
Administrator Capabilities 

WirelessOffice 
Messenger 
Capabilities 

Administrator 

Cannot configure security settings. 
Granted all access and highest 
security level by default. 

All users, 
groups, & depts. 
Msg scheduling 
allowed. 

Access all views, with full 
editing/adding/deleting rights. 

Only account that can modify 
Server Configuration settings. 

General msging, 
msg scheduling, 
personal addressbk  
and personal 
Message Log. 

Jane Smith 

User Security Level – 50 same or 
lower                                        
Admin Security Level – 0 same        
User Rights: group msging, dept 
msging, schedule msgs                   
Admin Rights: none                          
Admin Activity Rights: none 

Users/groups 
assigned 50 and 
lower. Dept 
msgs only to 
those defined in 
user profile. Msg 
scheduling 
allowed. 

No access allowed. General 
messaging, 
message 
scheduling, 
personal Message 
Log. 

Bob Logan 

User Security Level – 100 same or 
lower                                                
Admin Security Level – 50 same 
or lower                                            
User Rights: all                                
Admin Rights: all                              
Admin Activity Rights: all 

All users/groups. 
Depts must be 
defined in user 
profile. Message 
scheduling 
allowed. 

Access allowed. Can only 
edit/add/delete users, groups 
and depts with 50 or below. 
Msg Log, Scheduled Msgs 
and Escalated Msgs only 
display msgs sent by users 
with 50 or below. Ports, 
carriers, connections, and 
activity log are available. 

General msging, 
msg scheduling, 
personal addressbk 
availability, and 
ability to edit own 
device. Personal 
Message Log. 

Enrique Lopez 

User Security Level – 0 same          
Admin Security Level – 0 same        
User Rights: none                            
Admin Rights: none                          
Admin Activity Rights: none 

PIN/Carrier 
method or 
FastPIN 

No access allowed. Messaging with 
FastPIN, personal 
Message Log. 

Beverly Tallow 

User Security Level – 50 same        
Admin Security Level – 50 same      
User Rights: all                                
Admin Rights: all                              
Admin Activity Rights: all 

Users/groups 
with 50 security 
level. Depts 
must be defined 
in user profile. 
Msg scheduling 
allowed. 

Access allowed. Can only 
edit/add/delete users, groups 
and depts with level 50. Msg 
Log, Scheduled Msgs and 
Escalated Msgs only display 
msgs sent by users with level 
50. Ports, carriers, con-
nections, & activity log avail. 

General msging, 
msg scheduling, 
personal addressbk  
availability, and 
ability to edit own 
device. Personal 
Message Log. 

Jonathan Brite 

User Security Level – 100 same or 
lower                                     
Admin Security Level – 0         
User Rights: all 

Needs to be able to message all 
users and receive messages from 
people with lower security levels.     

 

All users/groups. 
Depts must be 
defined in user 
profile. Message 
scheduling 
allowed. 

No access allowed. 

To allow lower security level 
users to send msgs, add him 
to a department and give dept 
msging accessibility to those 
users who need to msg him. 

Or configure all users 
including Jonathan with same 
security level. 

General msging, 
msg scheduling, 
personal addressbk 
availability, and 
ability to edit own 
device. Personal 
Message Log. 
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6HFXULW\�6HWWLQJV�

WirelessOffice requires each user to login when connecting a WirelessOffice component to the 
WirelessOffice Server. Security configuration entails a login password, security level (0-100), 
granting or denying access, and various user and administrator rights. Once the server default 
settings have been configured, individual security access assignments can be adjusted for each user 
in their User Properties. There is one account that is not configurable and that is the 
‘Administrator’ account, which is granted by default the highest security level and all access rights. 
It is also the only account that can access Server Configuration. Please see “To add new users or 
devices” on page 41. 

Note: The ‘Administrator’ account can globally disable security on the Setup tab of Server 
Configuration. Please see “To modify the server Setup tab” on page 22. 

To help configure and plan your security system on paper, please see “Appendix E: 
Security Worksheet” on page 210. 

� 7R�VHW�XS�WKH�VHUYHU�'HIDXOW�8VHU�5LJKWV�WDE��
1. Each time a new user is added or the Import Wizard is used, these default security settings are 

applied. Click the Default User Rights tab of the Server Configuration window. These 
settings affect all newly added users. 

The following dialog depicts the default system settings for the Default User Rights tab: 

2. Select Grant login access to new users to give newly added users login access. 

3. On the User Rights tab, set up default security rights for messaging access. Security Level 
reflects a number between 0 and 100. If a user is assigned Security Level 50 with same or 
lower access, that user will be able to view and send messages to all other users with the same 
security level and below.  

Note: If the user rights security level is set to 0, WirelessOffice Server access will be 
granted but no global address book will be accessible for message sending. Message 
sending will be limited to PIN/carrier method (FastPIN) and in WirelessOffice 
Messenger, a personal address book if rights are granted. 
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4. In the User Rights section, select the appropriate rights that will be assigned by default to all 
newly added users.  

5. Select Group Messaging to enable the ability to send to groups with the same security access 
level (same, same or lower) as the user. Individual member security levels will not be 
evaluated. 

6. Select Departmental Messaging to enable the ability to send only to specified departments. 
Individual department member security levels will not be evaluated. 

7. Select Message Scheduling to allow the user to send scheduled messages. Select Personal 
Addressbook to allow the user to configure their own WirelessOffice Messenger address 
book. Select Device Editing to allow the user the ability to access and configure their own 
devices in WirelessOffice Messenger. 

8. Next, click the Administrator Rights tab of the Default User Rights window to configure 
default user access to WirelessOffice Administrator.  

The following dialog depicts initial default system settings for the Administrator Rights tab 
of the Default User Rights window: 

9. Security Level reflects a number between 0 and 100 and is used for WirelessOffice 
Administrator access. If a user is assigned Security Level 50 with same or lower access, that 
user will be able to view and modify other users/groups/departments with the same security 
level and below.  

Note: If the Administrator Rights Security Level is set to 0, WirelessOffice Administrator 
access will NOT be granted. 

  

10. In the Administration section, select the appropriate rights that will be assigned by default to 
all newly added users. Selection of any of these server administration properties gives a user 
access to viewing, adding, modifying and deletion rights.  

11. In the Activity section, select the appropriate rights that will be assigned by default to all 
newly added users. Selection of any of these server activity properties gives a user access to a 
variety of viewing, resending, modifying, cancellation and deletion rights. 
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0DQDJLQJ�&20�3RUWV�

Before you can use WirelessOffice to send messages, you must configure each serial 
communication (COM) port used for output. To send using SMTP, a port does not need to be 
defined, but a carrier does. For more information about configuring SMTP carriers, please see “To 
add a new carrier” on page 33. 

Ports are configured as either direct (on-site) or modem (dial-up) connections. A direct connection 
links to an on-site wireless terminal with an RS-232 cable. A modem connection links to a remote 
wireless carrier through a modem. The recommended maximum number of ports per server that 
can be defined is 20. Port settings can be modified or deleted at any time. 

Note: All modems must first be defined in Control Panel. The latest modem driver specific 
to your modem is recommended. 

 

'HILQLQJ�3RUWV�

The Port Configuration Wizard allows you to configure ports and can be accessed four ways: 

• From the File menu, select New and then Port. 

• Click the Port icon on the toolbar. 

• Right-click within the Ports window and select New Port. 

• Press CTRL+T.  

� 7R�GHILQH�D�SRUW��
1. Start the Port Configuration Wizard (described above). 

2. Select a modem or COM port from the displayed list. Ports are auto detected by 
WirelessOffice. 

3. If you have selected a modem, the Next button becomes a Finish button. Click the appropriate 
button. 
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If Next was selected, the list of available direct connect carriers now displays: 

4. Select a direct connect carrier, then click Finish.  

5. If no direct carriers have been configured, the list will be empty. Please see “To add a new 
carrier” on page 33. 

�

'HOHWLQJ�3RUWV�

There are four ways to delete a port: 

• Select the port you wish to delete in the Port window.  Press the DELETE key and answer 
Yes in the confirmation dialog box. 

• Select the port you wish to delete in the Port window. Click the Delete icon on the toolbar. 

• Select the port you wish to delete in the Port window. From the Edit menu, choose Delete. 

• Right-click on the port you wish to remove and select Delete. 
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0DQDJLQJ�&DUULHUV�

Before you can add users to the database, you must define all wireless carriers responsible for 
message transmission.  The recommended maximum number of carriers that can be defined is 200. 
Carriers and their connection settings can be modified or deleted at any time. 

If your system has multiple communication ports and modems, you can take advantage of the 
modem pooling feature. For each defined carrier, you can specify when additional modems should 
be used and how many modems are allocated to that carrier.  

'HILQLQJ�$�1HZ�&DUULHU�

The Carrier Wizard allows you to specify details about the wireless carriers and their connection 
settings. You can also configure the modem pooling settings for each carrier using this wizard. 

There are four ways to access the Carrier Wizard: 

• From the File menu, select New, then Carrier. 

• Click the Carrier icon on the toolbar. 

• Right-click within the Carriers window and select New Carrier. 

• Press CTRL+S.  

&DUULHU�6HWWLQJV�

Before configuring a new carrier, it is recommended that you call your carrier’s customer service 
contact and verify the following information. A fill-in table is provided in “Appendix D: Carrier 
Questionnaire” on page 209 for easy compilation of carrier information. 

1. Modem access phone number or e-mail domain to the carrier’s terminal 

2. Preferred baud rate, parity, data bits, flow control for dial-up connections 

3. Largest message block size allowed 

4. Total messages per connection and volume of messages per minute allowed 

5. PIN number for specific WirelessOffice users that subscribe to that carrier 
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� 7R�DGG�D�QHZ�FDUULHU��
1. Start the Carrier Wizard (described on the previous page).  

The Carrier Wizard – Step One dialog displays: 

2. Enter the name of the wireless carrier in the Name text box. 

3. Choose the Protocol. Select SMTP if the messaging terminal will be contacted via Internet 
and has an e-mail address. For all other connections, select TAP. 

TAP — an acronym for Telecator Alphanumeric Protocol. TAP has become the messaging 
industry standard protocol for sending message requests from automated equipment. 

SMTP — an acronym for Simple Mail Transfer Protocol. SMTP is the TCP/IP protocol 
governing electronic mail transmissions and receptions. 

If you selected TAP, the following screen displays:  

4. For the Connect Type, select Direct in cases where a cable links the server to an on-site 
wireless terminal. Choose Modem in all other cases. Enter the Baud rate (1200 or 2400 
suggested) and the number of Maximum Retries, which reflects the number of times 
WirelessOffice will try to dispatch a message if it is unsuccessful on the first attempt. Click 
Next.  
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If you have selected Modem, the following screen displays: 

5. Type the dial-up Phone No. for the carrier. Type 9, as your dialing prefix if required to exit 
the PBX system. A comma adds a one second delay (multiple commas may be required). 
Optionally Enable modem pooling. Then click Finish.  

Modem pooling — enables multiple modems to dispatch messages at the same time to the 
same carrier, which decreases throughput time. If enabled, configure the settings on the 
carrier’s Modem Pooling tab after completing the Carrier Wizard. Please see “Modifying a 
Carrier” on page 35.  

6. If you have selected Direct instead of Modem, you will be shown a list of available COM 
ports. If you wish to connect this carrier to a COM port, select the port then click Finish. 

7. If you chose the SMTP option, you will be asked to enter the carrier’s e-mail domain. Contact 
your carrier for the correct Destination Domain address or visit their web site. 

8. Type the Destination Domain such as skytel.com and click Finish. 

Note: After completing the Carrier Wizard, be sure to review Carrier Settings. Please see 
the next section, “Modifying a Carrier” on page 35. 



Configuring WirelessOffice Server 

   35

0RGLI\LQJ�D�&DUULHU 

� 7R�PRGLI\�D�FDUULHU��
It is important to review the Carrier settings after completing the Wizard. There are four ways to 
access Carrier information: 

• From the Carriers tab on the Server Administration screen, select the carrier you wish to 
modify. Double-click the specific carrier. 

• Select the specific carrier and then click the Properties icon from the toolbar. 

• Select the specific carrier and right-click. Select Properties. 

• Select the specific carrier. Click File from the menu and select Properties. 

&DUULHU�3URSHUWLHV�

The following are descriptions of the various tabs listed in the carrier properties. Depending on the 
carrier protocol type (TAP or SMTP) and connection method (direct or modem), different 
properties tabs will be shown.  

� 7R�PRGLI\�WKH�&DUULHU�WDE��
1. You may make changes to Name and Notes. The Configuration area allows you to change 

Protocol, and Enable Logging.  

2. To diagnose carrier configuration problems, select Enable Logging. Do this only when 
problems occur in sending messages. Please see “Appendix C: Server Logging” on page 205. 
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� 7R�PRGLI\�WKH�&RQQHFWLRQ�6HWWLQJV�WDE��
The Connection Settings tab allows you to make changes to the Connect Type, Phone number 
and other serial port settings. 

Note: The default Parity, Data Bits, and Flow Control settings are appropriate for most 
installations. These settings should correspond to the carrier’s needs. Maximum 
Retries reflects the number of times WirelessOffice will try to dispatch a message if 
it is unsuccessful on the first attempt. 

� 7R�PRGLI\�WKH�0RGHP�3RROLQJ�WDE��
1. The Modem Pooling tab allows you to enable and configure modem pooling. 

2. In the Pooling threshold box, enter the number of messages to be queued for that carrier 
before the system will begin using another modem in the modem pool. 

3. In the Maximum Ports box, enter the total number of modems you want to be available for 
the current carrier. 
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� 7R�PRGLI\�WKH�7$3�6HWWLQJV�WDE��
The TAP Settings tab allows you to configure advanced settings for the TAP protocol.  

1. It is recommended that you call the carrier to confirm Block Size and Maximum messages 
per connection. The latter is essential information if sending high message volume. Please 
see “Appendix D: Carrier Questionnaire” on page 209. 

2. If the wireless carrier requires a password, type it in the Password box. 

Note: Block size is the number of characters allowed per message sent to the device before 
being broken into fragments. The default settings for block size and maximum 
messages per connection are appropriate for most installations. Change only if 
instructed by the carrier. 

� 7R�PRGLI\�WKH�6073�6HWWLQJV�WDE��
The SMTP Settings tab allows you to configure the carrier’s e-mail Destination Domain of the 
wireless carrier. The Destination Domain for this dialog could be mobile.att.net. Contact 
your carrier for the correct destination domain setting or visit their web site. 

'HOHWLQJ�&DUULHUV�

When you delete a carrier record, you delete all devices that are defined to that carrier. There are 
four ways to delete a carrier: 

• Select the carrier you wish to delete in the Carrier window. Press the DELETE key. 
• Select the carrier you wish to delete in the Carrier window. Click the toolbar Delete icon. 
• Select the carrier you wish to delete in the Carrier window. Select Edit then Delete. 
• Right-click the carrier you wish to remove and select Delete. 

 
Note: When a carrier is deleted, all user devices assigned to this carrier are deleted. 
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0DQDJLQJ�'HSDUWPHQWV�DQG�0HPEHUV�

To submit the same message at one time to department members, you can create company 
departments. Define your departments before adding users, as each new user setup dialog includes 
a departmental membership inclusion button. Departments may also be defined after adding users. 

Note: To speed up dispatching to a large department that has many users on the same 
carrier, contact the carrier and request a PIN to represent those members. 

 

Department security features include: 

• Each department is given a security level in order to allow appropriate access to 
WirelessOffice Administrator users for adding, deleting and modifying departments. 

• Users logging into WirelessOffice Server can selectively have access to departmental 
messaging. Access can be limited to only certain departments. 

$GGLQJ�'HSDUWPHQWV�

There are four ways to add departments: 

• From the File menu, select New, then Department. 

• Click the Department icon on the toolbar. 

• Right-click within the Departments window and select New Department. 

• Press CTRL+D.  

� 7R�DGG�QHZ�GHSDUWPHQWV��
1. Add a new department by using one of the four methods listed above. 

The New Department dialog box displays: 

2. Enter the name of the department in the Name box. Enter any descriptive data in the Notes 
box.  
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3. Set the Security Level (0-100) in order that WirelessOffice Administrator users with the same 
or same or lower security level can access those departments for administration purposes 
(adding, deleting and modifying). If the user has the same security level, they will not be able 
to edit the department security level. This security level setting does not reflect message 
sending abilities.  

For example: If a security level of 50 is given to the Sales Department, all WirelessOffice 
Administrator users with an Administrative Security Level of 50 and higher will be able to 
view and access this department. Users with a security level of 50 will not be able to modify 
the department’s security level. Users with security level of 49 and lower will not see the 
Sales Department. 

4. If no security is desired, enter the same security level that all users have been assigned and 
disable security in the Server Configuration Setup tab. Please see “To modify the server Setup 
tab” on page 22. 

5. Click the Members tab. If no users have been defined yet, proceed to the next section 
“Managing Users and Devices” on page 41. 

The New Department, Members tab dialog displays:  

6. To add department members, select the name from the Available Users list box, then click  
>>. Your selection displays in the Members list box. You can also double-click the name to 
move between boxes. Press the CTRL key to make multiple selections at one time. 

7. To remove your selection, select the name from the Members list box, then click <<. Your 
selection redisplays in Available Users. 

8. If desired, click the Send Test Message button under the Members list box to test the 
system’s ability to send a departmental message. 

Note: After Department names have been defined, you can assign user membership while 
configuring the User profile. 
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0RGLI\�$Q�([LVWLQJ�'HSDUWPHQW�

The department properties dialog box allows you to change the department name, add or delete 
members to an existing department, and change the security level. 

� 7R�PRGLI\�D�GHSDUWPHQW�UHFRUG���
1. Double-click the department you want to modify.  

The department’s properties dialog displays: 

2. On the Department tab, change information to the department’s Name, Notes, or Security 
Level. 

3. Click the Members tab. Use the >> and << buttons to place users in the correct fields. Names 
in the Members box will be part of the department.  

'HOHWLQJ�'HSDUWPHQWV�

When you delete a departmental record, you delete the members defined to that department not 
their individual user record. There are four ways to delete a department: 

• Select the department you wish to delete in the Departments window.  
Press the DELETE key and answer Yes in the confirmation dialog box. 

• Select the department you wish to delete in the Departments window.  
Click the Delete icon on the toolbar. 

• Select the department you wish to delete in the Departments window.  
From the Edit menu, select Delete. 

• Right-click on the department you wish to remove and select Delete. 
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0DQDJLQJ�8VHUV�DQG�'HYLFHV�

A user is any person that will either be receiving WirelessOffice messages and/or will be 
connecting to the WirelessOffice Server via a WirelessOffice client application. You can import 
single or multiple .csv files with user information (each import can reflect different default security 
settings). Please see “Using the Import Wizard” on page 65. 

 

Before adding users, make sure you have configured the following properties: 

• System default security settings (page 28) 

• Ports (page 30) 

• Carriers (page 32) 

• Departments (page 38) 

• Your security system using the Security Worksheet (page 210) 

$GGLQJ�8VHUV�

There are four ways to add users: 

• From the File menu, select New, then User. 

• Click the User icon on the toolbar. 

• Right-click within the Users window and select New User. 

• Press CTRL+U.  

��7R�DGG�QHZ�XVHUV��
1. Add a new user by using one of the four methods described above. 

The New User dialog box displays: 
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2. Type the user’s Full Name. Set up WirelessOffice client application accounts to login with, 
e.g. “Command Messenger”, with appropriate security rights and no defined devices. The 
Login Name can reflect the Full Name or can be different. 

3. Type the user’s E-mail Address (optional). 

4. Enter any descriptive information in the Description text box. Information such as the 
person’s title, specialty, company name, field route, etc. may be useful. 

5. Click the Department Membership button to associate the user with one or more 
departments. If departments have not already been established, please see “To add new 
departments” on page 38 before continuing. 

6. Security Level reflects a number between 0 and 100 and is used as a measure of accessibility 
to the server database for messaging. Default security level is defined in the Server 
Configuration Default User Rights tab. Please see “Security Settings” on page 28 for more 
information. 

7. In the Login area, allow login access by selecting Grant Access. To disable login capabilities 
for this user, select Deny Access. 

8. Type a Login Name that the user will implement when logging in via a WirelessOffice client 
application. Recommended format is the user’s full first and last name. 

9. Type a Password and then Confirm Password. Character length can range from 0 to 20. A 
password is not required, but suggested if you are enforcing security. 

10. Click Security Settings to make any changes from the system default user settings. Please see 
“To set up the server Default User Rights tab” on page 28 for security level and rights 
configuration setting information. 

The Security Settings dialog displays: 

11. On the User tab of the Security Settings dialog, select same or lower or same as the security 
level access (this setting is only available to the ‘Administrator’ account).  

12. Select which User Rights should be granted for messaging capabilities. If you select 
Departmental Messaging, click the Dept. Access button to select which departments will be 
accessible to the user. 
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The Department Access dialog displays: 

13. Select which departments will be accessible to the user by highlighting the department name 
in the Available Departments window and then clicking >> to add the department to the 
Access to window. Click OK when finished. 

14. Click the Administrative tab on the Security Settings dialog to set the WirelessOffice 
Administrator security level and grant access to server administration and activity settings. 

The Administrative tab of the Security Settings dialog displays: 

15. Security Level reflects a number between 0 and 100 and is used as a measure of accessibility 
to server settings and configuration in WirelessOffice Administrator. A security level of 0 
denies access to WirelessOffice Administrator. A security level of 1 through 100 gains access. 
Please see “Security Settings” on page 28 for more information. 

16.  Select same or lower or same as the security level access (this setting is only available to the 
‘Administrator’ account). 

17. Select which Server Administration and Server Activity rights should be granted. When 
selected, a right enables the user to view, add, delete and modify records. Click OK when 
finished. 
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$GGLQJ�8VHU�'HYLFHV�

� 7R�DGG�XVHU�GHYLFHV��
1. Click the Add Device button on the User tab of the New User or user properties window to 

set up the user’s mobile device. 

The Device Wizard – Step One window displays: 

2. Select the Device Type. If you have a two-way cell phone, select Two-Way. You can send 
messages to a user’s e-mail address, please see “To send messages to an e-mail address” on 
page 46. Click Next. 

The Device Wizard – Step Two dialog displays: 

3. Type the user’s Personal Identification Number in the PIN box. If the device is a two-way cell 

phone, pager or PDA, the address may be in e-mail format. Type the beginning of the address 
as the PIN, e.g. jane.doe if the full address is jane.doe@metrocall.com. 

4. From the Carrier list box, select the wireless carrier. If the carrier is not listed, click New to 
configure a new carrier. Click Finish. The device is added and a tab is created for it. Click on 
the carrier name tab to further configure the device settings. 
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The properties dialog for the new user’s device displays:  

5. The Enabled check box, when selected, enables the device to be included when messages are 
sent to that user. 

6. Edit the Configuration area as needed. Select Enable message numbering to number 
fragmented messages from 0 to 99. Once 99 is reached, the count is re-started from 0. 

7. Select Enable responses to include the message identification number assigned by 
WirelessOffice. This allows a user’s two-way device response message to be linked to the 
original message. This field is grayed out if a One-Way Pager or Cell Phone were selected as 
the device type. This field must be selected for two-way device responses to reach 
WirelessOffice. For more information on two-way messaging, please see “Two-Way 
Messaging” in the E-mail Messenger Administrator Manual. 

8. Click Availability to customize device availability, implementing an Always On or a 
Custom message receipt time schedule. Please see “Device Availability” on page 52 for 
further information. 

9. Click Auto-Resend to specify time intervals for the auto-resend feature per individual device. 
Select Global to implement the server-defined global auto-resend settings or select Custom to 
override the global settings. Configure the schedule as appropriate. Please see “Device 
Specific Auto-Resend Settings” on page 53 for further information. 

10. Enter the maximum number of characters allowed per message in the Maximum message 
length box. Enter the maximum number of fragmented messages allowed for this device in 
the Maximum number of fragments box. Messages that exceed the Maximum message 
length value are split into multiple messages (fragments) so that the entire message can be 
delivered. Call the carrier to receive maximum message length requirements. 

11. Click the Send Test Message button to test the system’s ability to send messages to the new 
device. Check the status of the test message in the Message Log. The test message does not 
reflect configuration options such as message numbering, enable responses, availability, etc. 

12. Click Delete Device to remove the device if so desired. 

13. Click OK if you’re finished adding users/devices. To add another device click the User tab 
and repeat this process. Ten devices may be associated with each user. 
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� 7R�VHQG�PHVVDJHV�WR�DQ�H�PDLO�DGGUHVV��
1. In the Device Wizard – Step One window select Two-Way as the Device Type. Click Next. 

2. Type the PIN as the e-mail address that goes before the @ symbol and domain (e.g. jane.doe). 
An SMTP carrier must be pre-defined using your corporate e-mail domain (e.g. 
companyname.com) as the Destination Domain. Please see “To add a new carrier” on page 
33. Click Finish. 

Note: E-mail Messenger is not required to send e-mail to a user’s device. In order to send 
SMTP carrier messages you must define the SMTP Server and From fields in 
Server Configuration (page 25). 

$GGLQJ�D�'HYLFH�WR�DQ�([LVWLQJ�8VHU�

To add a device to an existing user, select then double-click a user’s name, and follow steps 1 
through 13 in the previous section, “To add user devices”, on page 44. 

Note: When a message is sent to a user with several configured devices, a message is sent 
to each device that is enabled and available according to its availability schedule. 

0RGLI\LQJ�8VHUV�RU�'HYLFHV�

The user properties dialog box allows you to modify users or their devices, add more devices, add 
new users, and view message statistics for that user. 

� 7R�PRGLI\�XVHUV�RU�GHYLFHV��
1. Double-click the specific user from the User tab of the Server Administration window. The 

user’s properties dialog displays. 

2. From this screen you can modify all the user’s properties, including user’s name, description, 
department membership, device configuration, security levels and rights, and login name and 
password. 

3. A Statistics tab shows message information for that user. For more information, see “To view 
user statistics” on page 63. 

'HOHWLQJ�8VHUV�

When you delete a user record, you delete all devices that are defined for that user. If the user is 
part of a group or department, the membership is automatically updated. There are four ways to 
delete a user: 

• Select the user you wish to delete in the Users window. Press the DELETE key and 
answer Yes in the confirmation dialog box. 

• Select the user you wish to delete in the Users window. Click the toolbar Delete icon. 

• Select the user you wish to delete in the Users window. On the Edit menu, select Delete. 

• Right-click on the user you wish to remove and select Delete. 
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0DQDJLQJ�*URXSV�DQG�0HPEHUV�

To submit the same message to multiple users, you can create a group and define its members. 
Each group is given a security level in order to allow appropriate access to WirelessOffice 
Administrator users for adding, deleting and modifying departments and for messaging access 
evaluation. Groups differ from departments in that message access is evaluated by security level 
rather than user access definitions. 

Note: To speed up dispatching to a large group that has many users on the same carrier, 
contact the carrier and request a PIN to represent those group members. 

$GGLQJ�1HZ�*URXSV�DQG�0HPEHUV�

The New Group dialog box allows you to specify details about new groups and their members. 

There are four ways to add groups: 

• From the File menu, select New, then Group. 

• Click the Group icon on the toolbar. 

• Right-click within the Groups window and select New Group. 

• Press CTRL+G. 

� 7R�DGG�QHZ�JURXSV�DQG�PHPEHUV��
1. Add a new group by using one of the four methods listed above.  

The New Group dialog box displays: 

2. Enter the name of the group in the Name box. Enter any additional notes in the Notes box. 
Select the appropriate Security Level. Security level for groups reflects both the ability to 
send messages to groups (compares against the User Security Level) and the ability to 
administer groups (compares against the Administrative Security Level). 
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3. Click the Members tab. To add group members, select the name from the Available Users 
list box, then click  >>. Your selection displays in the Members list box. You can also 
double-click the name to move between boxes. Press the CTRL key to make multiple 
selections at one time. 

4. To remove your selection, select the name from the Members list box, then click <<. Your 
selection redisplays in Available Users. 

5. If desired, click the Send Test Message button under the Members list box to test the 
system’s ability to send a group message. 

0RGLI\�$Q�([LVWLQJ�*URXS�

The group properties dialog box allows you to change the group name and add or delete members 
to an existing group. 

� 7R�PRGLI\�D�JURXS�UHFRUG���
1. Double-click the group record you want to modify. The group’s properties dialog displays. 

2. On the Group tab, change information to the group’s Name and/or Notes. 

3. Click the Members tab. Use the >> and << buttons to place users in the correct fields. Names 
in the Members box will be part of the group.  

'HOHWLQJ�*URXSV�

When you delete a group record, you delete the members defined to that group not their individual 
user record. There are four ways to delete a group: 

• Select the group you wish to delete in the Groups window.  
Press the DELETE key and answer Yes in the confirmation dialog box. 

• Select the group you wish to delete in the Groups window.  
Click the Delete icon on the toolbar. 

• Select the group you wish to delete in the Groups window.  
From the Edit menu, select Delete. 

• Right-click on the group you wish to remove and select Delete.  
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6HQGLQJ�0HVVDJHV�

There are three ways to start a new message: 

• From the Tools pull-down menu, select Compose Message. 

• Click the Compose Message icon on the toolbar. 

• Press CTRL+M. 

� 7R�VHQG�D�PHVVDJH��
1. Start a new message (see above). The New Message dialog displays. 

2. Click the To: button. The WirelessOffice - Message Recipients dialog box displays. 

3. To choose a message recipient, select the name from the Directory list box and click Add. 
You can also double-click the recipient name. 

4. Your selection displays in the Recipients list box.  To remove your selection, select the name 
from the Recipients list box and click Remove (or double-click it). 

5. When you have finished selecting the recipient(s) for your message, click OK. 

6. Type your message in the Message text box (4,096 character maximum). Overall maximum 
server message length is set in Server Configuration. Please see “To modify the server Setup 
tab” on page 22. 

7. Click the Send button. Review the Message Log to view the status of the message and verify 
that it was successfully sent. 

Note: You can also type the recipient name in the To: text box and the software will 
automatically complete their name. Press ENTER to add the name to the recipient 
list. 
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6FKHGXOLQJ�0HVVDJHV�

Messages can be scheduled to be sent at a future time/date or at regularly scheduled intervals. 
Once a scheduled message is defined, it is stored in the Scheduled Messages tab of the Server 
Activity window. Appropriate user access rights for the user login account must be assigned in 
order to schedule messages. 

� 7R�VFKHGXOH�D�PHVVDJH��
1. Click the Schedule button in the New Message dialog. 

 The Message Scheduler dialog box displays: 

2. Type a Description.  Select the time, frequency and date if required for the message to be 
sent. 

3. You can use the spin controls to independently increment or decrement any part of the time 
and date (i.e. month, day, year, hour, minute, or AM/PM). 

Note: This feature will delay delivery of the message to all recipients. Once the 
scheduled message is configured you can later modify the record and deselect the 
Enabled field if necessary. 

0HVVDJH�2SWLRQV�

WirelessOffice allows you to specify certain options, including an automatic spell check. A custom 
signature can be appended to all of your messages. Two-way message replies can be displayed as 
pop-up dialogs so you see a user’s response immediately. 

The Message Options dialog allows you to: 

• Automatically spell check your message before sending 
• Clear recipients from the To: box after sending 
• Clear message text after sending and/or close window 
• Send your signature at the end of your message 
• Display two-way message replies in pop-up dialogs 
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� 7R�VHW�PHVVDJH�RSWLRQV��
1. Click the Options button in the New Message dialog to open the Message Options dialog. 

2. Enable Auto Spell Check before sending if desired. Select any After sending options, such 
as Clear Recipients, Clear Message Text or Close Window. 

3. Enter you custom signature in the Message Signature text box. Click the Enabled check box 
to enable the message signature.  

4. In the Message Replies section, select Display in pop-up dialog for two-way message 
responses to be displayed in a special dialog. Escalated message responses will not display as 
a pop-up. All message replies, included escalated responses, also display in the Message Log. 
Click OK when done.  

)DVW3,1�)HDWXUH�

Use this feature to send a message to a recipient when only their PIN (Personal Identification 
Number) and the name of their carrier is known or their user information has not been added to the 
Users list. It may also be implemented when users do not have access to the server database. 

� 7R�XVH�WKH�)DVW3,1�IHDWXUH��
1. Start a new message. Select the FastPIN icon from the toolbar.  

The FastPIN Recipient dialog displays: 

2. Type the PIN. Select the Carrier from the drop-down list. Click OK. Multiple FastPIN 
recipients may be configured. Repeat steps 1-2 to add recipients. 

3. Type your message. Click the Send button. To set up a delayed message, refer to “Scheduling 
Messages” on page 50. 
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6HQGLQJ�DQ�$GPLQLVWUDWRU�$OHUW�

� 7R�VHQG�DQ�$GPLQLVWUDWRU�$OHUW��
1. From the Tools pull-down menu, select Send Administrator Alert. The Send 

Administrator Alert dialog displays. 

2. Type your message, then click Send.  

3. The Administrator Alert will instantly send to all WirelessOffice Administrator and 
WirelessOffice Messenger connections as a pop-up message, as shown above. In Alarm 
Messenger, the message will appear as an entry in the Activity Log. 

'HYLFH�$YDLODELOLW\�

� 7R�VHW�RU�FKDQJH�GHYLFH�DYDLODELOLW\��
1. In the user’s profile, select the device tab you wish to edit availability for. 

2. Click the Availability button to set or change the schedule.  

The Device Availability dialog displays: 

3. This screen allows you to customize device activation. You can select the days and time 
period for the mobile device to be active.  For example, the screen above shows that the 
device is active Monday through Friday, 9 AM to 5 PM. 
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$XWR�5HVHQG�0HVVDJH�2SWLRQV�

If you are sending messages to a carrier that supports TAP protocol version 1.6 or later, you can 
take advantage of the auto-resend feature. When auto-resend is enabled, WirelessOffice 
automatically schedules failed messages for dispatch at a later time interval configured by the 
system administrator.  This feature only works with terminals that can report a TAP response code 
of 512 or “wireless device temporarily out of range”. 

For example: Jane Benedict was sent a message while her digital phone was out of range.  
WirelessOffice reports a failure (512), and reschedules the message for 6 minutes later (as shown 
in the Scheduled Messages tab).  Auto-resend messages in the scheduled log will have 
“AutoResend1” as their description, where 1 represents the retry number that WirelessOffice is 
attempting. 

Note: You can select Resend Failures in the Message Properties window to manually 
resend any failed message, no matter what error message was returned. Please see 
“To resend failures” on page 58. 

  

'HYLFH�6SHFLILF�$XWR�5HVHQG�6HWWLQJV�

WirelessOffice allows you to specify certain time intervals for the auto-resend feature per 
individual devices. Auto-resend only activates for unsuccessful messages that receive error 
message 512,  “wireless device temporarily out of range”, in the Status Description text box of 
the Message Properties window. 

� 7R�VHW�XS�GHYLFH�VSHFLILF�DXWR�UHVHQG���
1. Double-click the specific user. Click the appropriate device’s tab. Select the Auto-Resend 

button.  

The Auto-Resend Properties for PIN xxxxxxx dialog displays: 

2. If Custom is selected, the local settings for the wireless device will take precedence over the 
global settings.   

3. Select Enabled and enter the appropriate retry schedule in up to five retry time fields. 
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*OREDO�$XWR�5HVHQG�6HWWLQJV�

WirelessOffice allows you to specify certain time intervals for the global auto-resend feature.  

Note: Auto-resend only activates for unsuccessful messages that receive error message 512,  
“wireless device temporarily out of range”, in the Status Description text box of the 
Message Properties window. 

� 7R�VHW�XS�JOREDO�DXWR�UHVHQG���
1. Select Tools from the menu, and click Server Configuration. Select the Auto-Resend tab. 

The Server Configuration dialog displays:  

2. Select Enabled and set up a retry time schedule. 

3. If Enabled is checked, global auto-resend settings will be applied to all user devices that have 
global checked in their auto-resend setup.  

4. If a user has Custom auto-resend selected for their device(s), those retry times will take 
precedence.    

6RXQG�(YHQWV�

You can receive audio notification of certain events that occur in WirelessOffice.  

� 7R�DFWLYDWH�VRXQG�HYHQWV��
1. Click Start from the taskbar, select Settings then Control Panel. Click the Sounds icon. The 

Sounds Properties dialog displays. 

2. Highlight the WirelessOffice event(s) to associate with audio notification. Events include 
message cancelled, message escalated, message response, message scheduled, message sent, 
new escalated message, user connect, and user disconnect.  

3. In the Sound area, click the Browse button to select your sound choice. Click OK. 
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0DQDJLQJ�:LUHOHVV2IILFH�6HUYHU��

This chapter describes the functions available to help you manage the WirelessOffice Server.  You 
will manage the server by monitoring or viewing Server Connections, Activity and Message Log 
entries, Scheduled Messages, Escalated Messages, User and Device data, Group Membership, 
Department Membership, Carriers, and Port Settings. All views can be saved as a comma-
delimited CSV file for report producing, analysis and troubleshooting. Each view may be printed 
as well. 

9LHZLQJ�DQG�'LVFRQQHFWLQJ�6HUYHU�&RQQHFWLRQV�

The Server Connections tab displays all WirelessOffice client applications that are currently 
connected to the server. Server connections may be disconnected from within this view. Each user 
account is only allowed one server connection.  

� 7R�YLHZ�RU�GLVFRQQHFW�6HUYHU�FRQQHFWLRQV��
1. Click the Connections tab. A list of server connections is displayed. 

2. To disconnect a connection, select the desired connection and right-click. From the list, select 
Disconnect. 

3. A message confirming the disconnect will display. Once disconnected, an Administrator Alert 
message will automatically be sent to that user’s desktop. It states that the connection was 
disconnected by the User Name of the disconnecting WirelessOffice Administrator. 

4. The disconnected client application will remain open, but will lose the capability to access or 
interact with the server.  

 

Right-Click
List
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0DQDJLQJ�$FWLYLW\�/RJ�(QWULHV�

The Activity Log displays server-client events including server startup, configuration additions, 
modifications, and deletions, message transmissions, message deletions, warnings, and errors. 

� 7R�YLHZ�$FWLYLW\�/RJ�HQWULHV��
Click the Activity Log tab. A list of Activity Log entries is displayed:  

� 7R�GHOHWH�DOO�ORJ�HQWULHV��
1. Click the Activity Log tab.  The Activity Log entries are displayed. 

2. Right-click the Activity Log entry (in the list view portion of the window) and select Delete 
All.  Or, from the Edit pull-down menu, choose Delete All.  A confirmation message 
displays. Click Yes.  

� 7R�YLHZ�WKH�%DFNXS�$FWLYLW\�/RJ��
1. To view the Backup Log, select View Backup Activity Log from the Tools menu. 

2. The Backup Log file contains activity log information that has been moved from the current 
activity log, based on the file size specified in Server Settings. Refer to section, “To set up 
the server Logging tab” on page 24. 

Example:  If you have set the maximum file size of the activity log to 100 kilobytes, when the 
log reaches that limit, it is copied into the backup file.    
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0DQDJLQJ�0HVVDJH�/RJ�(QWULHV�

The Message Log displays messaging events including the date and time a message was 
originated, the name of the message recipient, the message status and the message text.  You can 
also resend one or more messages from the Message Log.  Acknowledged messages received from 
a two-way device can be configured to display as a pop-up dialog upon receipt. Please see 
“Message Options” on page 51. 

Message status includes:  

• Failed  
• Queued 
• Rejected 
• Unknown 
• Partial Success 
• Accepted 

• Acknowledged 
• No Direct Connection 
• No Device  
• No Modem  
• No Port

 

��7R�YLHZ�0HVVDJH�/RJ�HQWULHV��
1. Click the Message Log tab.  

A list of Message Log entries displays: 

2. Detailed status can be obtained by double-clicking on a message or from the File menu select 
Properties for the highlighted message. 

3. After viewing the entries, you should delete entries if they are no longer useful. 

� 7R�GHOHWH�LQGLYLGXDO�ORJ�HQWULHV��
1. Click the Message Log tab. The Message Log entries display. 

2. Select the entry or entries that you want to delete. You can select multiple entries by holding 
down the CTRL key while making your selections. 

3. Right-click on a selected entry and select Delete.  Or, from the Edit pull-down menu, select 
Delete. You can also press DEL on the keyboard. A confirmation message displays.  Click 
Yes. 
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� 7R�GHOHWH�DOO�ORJ�HQWULHV��
1. Click the Message Log tab.  The Message Log entries display. 

2. Right-click inside the Message Log window and select Delete All.  Or, from the Edit pull-
down menu, choose Delete All.  

3. A confirmation message displays. Click Yes.  

� 7R�UHVHQG�RQH�RU�PRUH�PHVVDJHV��
1. Click the Message Log tab.  The Message Log entries display. 

2. Select the message or messages you want to resend. You can select multiple entries by 
holding down the CTRL key while making your selections. 

3. Right-click a specific message and select Resend.  Or, select the Resend Messages from the 
Tools pull-down menu.  The message(s) will be immediately resent. 

� 7R�UHVHQG�IDLOXUHV��
The resend failures feature allows you to resend messages that were not received by all recipients. 
Using this, you can resend your message to only the recipients who did not receive it.  

Note: Resending failures is different than the Auto-Resend feature. Please see “Auto-
Resend Message Options” on page 53 for more information. 

 

1. Select the failed message. Double-click the chosen message.  

2. Alternatively, you can select the Properties icon on the toolbar. 

3. Click the Resend Failures button. 
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9LHZLQJ�0HVVDJH�/RJ�6WDWLVWLFV�

Using the Statistics feature, you can display statistical information about messages that the server 
has processed by recipient, sender or carrier. 

� 7R�YLHZ�VWDWLVWLFV��
1. Select the Message Log window. To access the Statistics window, you must first open the 

Message Log. 

2. From the Tools menu, select Message Log Statistics. Or click the Statistics icon on the 
toolbar.   

The Message Log Statistics dialog displays in place of the Message Log: 

3. Use the View Statistics by: drop-down list to view statistics by Recipient, Sender or 
Carrier.  

4. If you wish to change the Time Span for logging statistics, click the Change button. Select 
the parameters that you require. Click OK. 

5. To return to the Message Log window, click the Statistics icon on the toolbar or select 
Message Log Statistics from the Tools menu.  

Note: Statistical information is also available on the User Properties dialog. Please see “To 
view user statistics” on page 63. 
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9LHZLQJ�6FKHGXOHG�0HVVDJHV�

All scheduled messages on the server are displayed in the Scheduled Messages window. 

� 7R�YLHZ�VFKHGXOHG�PHVVDJHV��
1. Click the Scheduled Messages tab.  

2. Select the message, then select Properties from the toolbar. You can enable and disable 
scheduled messages, change the schedule, add or delete recipients and alter the message. 

� 7R�GHOHWH�D�VFKHGXOHG�PHVVDJH��
There are four ways to delete a Scheduled Message: 

• Select the Scheduled Message. Click the Delete icon on the toolbar. 

• Select the Scheduled Message. From the Edit menu, select Delete. 

• Select the Scheduled Message. Right-click, then choose Delete. 

• Select the Scheduled Message. Press the DELETE key. 
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9LHZLQJ�(VFDODWHG�0HVVDJHV�

All escalated messages on the server are displayed in the Escalated Messages window. They are 
sent exclusively from Alarm Messenger, File Messenger and Command Messenger. You can 
configure sounds to be associated with escalated message events. Please see “Sound Events” on 
page 54. 

� 7R�YLHZ�HVFDODWHG�PHVVDJHV��
1. Click the Escalated Messages tab. Detailed information is displayed. 

2. Select the message and click the Properties icon from the toolbar or right-click and select 
Properties. 

3. The Message Escalation Properties dialog displays. On the Properties tab, review 
information such as owner, Escalation ID, current level, number of levels, status, next 
escalation time, message origination time, and message text.   

4. Click the Recipients tab to review recipients for each designated level. Active escalated 
messages will open to the current scheduled level’s recipients. 

5. Click the Escalate button to immediately escalate the message to the next level. Click the 
Cancel button to cancel the escalation. See “Escalating and Canceling Escalated Messages” 
on the next page for more information. 
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(VFDODWLQJ�DQG�&DQFHOLQJ�(VFDODWHG�0HVVDJHV�

By escalating an escalated message, you manually accelerate the message to the next level before 
its scheduled occurrence. For example, if a message is currently on Level Two and the Next 
Escalation time is set for 20 minutes away, you can “escalate” it to Level Three for immediate 
message sending. 

Escalated messages may be cancelled or escalated in either WirelessOffice Administrator, with a 
two-way wireless device via E-mail Messenger, with a cell or land phone via Voice Messenger, or 
in Web Messenger. Escalated messages originating from Alarm Messenger may be cancelled or 
escalated in Alarm Messenger as well.  

Note: Only one user from a group or department escalated message need acknowledge an 
escalation for it to be cancelled or advanced to the next level. 

� 7R�HVFDODWH�RU�FDQFHO�DQ�HVFDODWHG�PHVVDJH��
1. To escalate a message from within WirelessOffice Administrator, select the specific message 

in the Escalated Messages tab window. Right-click on the specific message and select 
Escalate. You can also double-click the message to view the Message Escalation Properties 
dialog and click the Escalate button. 

2. The escalated message will be upgraded to the next level status and immediately sent to the 
predefined recipients. Any levels beyond the current one will be escalated as well. The next 
level is rescheduled for the current time plus the originally defined Time Interval. 

3. To cancel an escalated message from within WirelessOffice Administrator, select the specific 
message. Right-click the message and select Cancel. You can also double-click the message 
to view the Message Escalation Properties dialog and click the Cancel button.  The message 
will be cancelled and no further levels will be escalated to and sent messages for. Canceling a 
message signifies that the message has been appropriately responded to and does not need to 
alert any other recipients on the escalation level list.  

4. After selecting Cancel, a message will ask if you would like to notify previous recipients. If 
‘Yes’ is selected, a message will be sent to all current and previous level recipients stating that 
the message was cancelled and by whom. 

Note: For information about escalating and canceling messages in Alarm Messenger, please 
see “Viewing and Canceling Escalated Messages” in the Alarm Messenger 
Administrator Manual. For information about canceling messages using E-mail 
Messenger or Web Messenger, please see “Cancellation and Escalation” in their 
respective manuals. Please see “Calling into Voice Messenger” in the Voice 
Messenger manual. 

9LHZLQJ�8VHU�DQG�'HYLFH�'DWD�

User records display a list of all users defined in the database. By selecting a particular user record, 
you can view the user’s login and user name, e-mail address, password information, security level, 
security settings, wireless carrier(s) information and user statistics. 
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� 7R�YLHZ�XVHU�DQG�GHYLFH�GDWD��
1. Click the Users tab of the Server Administration window. Double-click the user record that 

you want to view. 

2. The user’s properties, devices and statistics display. 

� 7R�YLHZ�XVHU�VWDWLVWLFV��
1. Select the Statistics tab to view the user’s statistics. 

2. If you wish to change the time span for logging statistics, click the Change button. Select the 
parameters that you require. Click OK. 

9LHZLQJ�*URXS�0HPEHUVKLS�

Group records display a list of all groups defined in the database. By selecting a particular group 
record, you can display a list of members that are defined to the group and review the security 
level and number of members. 

� 7R�YLHZ�JURXS�PHPEHUVKLS��
1. Click the Groups tab. A list of group names displays. 

2. Double-click the group record you want to view. The group’s properties dialog displays. 

3. Select the Members tab to view group membership. 

9LHZLQJ�'HSDUWPHQW�0HPEHUVKLS�

Department records display a list of all departments defined in the database. By selecting a 
particular department record, you can display a list of members that are defined to the department 
and review the security level and number of members. 

� 7R�YLHZ�GHSDUWPHQW�PHPEHUVKLS��
1. Click the Departments tab. A list of department names displays. 

2. Double-click the department record you want to view. The department’s properties dialog 
displays. 

3. Select the Members tab to view department membership. 
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9LHZLQJ�$YDLODEOH�&DUULHUV�

Carrier records display a list of all wireless carriers and their connection settings. 

� 7R�YLHZ�DYDLODEOH�FDUULHUV��
1. Click the Carriers tab. A list of carrier records displays. 

2. Double-click the carrier record you want to view. The carrier’s properties dialog displays. 
Select any of the carrier tabs for review or editing. 

9LHZLQJ�3RUW�6HWWLQJV�

You can display port settings to view configured COM ports, their selected baud rate, detailed 
logging status, and connection type. For more information about port logging, refer to “Appendix 
C: Server Logging” on page 205. 

� 7R�YLHZ�SRUW�VHWWLQJV��
1. Click the Ports tab. A list of port names displays. 

2. Right-click and select Logging  Enabled. To edit information first delete the port and then 
add a new port with the correct information.
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8VLQJ�WKH�,PSRUW�:L]DUG�

The Import Wizard allows you to import users from a pre-existing comma-delimited (.csv) file. 
The file should include the user’s full name, login name, password, e-mail address, PIN, and 
carrier, in an Excel-type spreadsheet format. Each import adds users to the existing database. 

Before importing, set the security Default User Rights in Server Configuration. These default 
security settings will automatically be applied to the imported users. You may choose to break 
your user list into several .csv spreadsheets, each designed to have different security level and right 
defaults. Please see “Security Settings” on page 28 for more information. 

Note: When importing a file with carrier names that are already defined in the 
WirelessOffice Server, the .csv file carrier names must exactly match the carrier 
spellings in the server. If a carrier is imported that has not yet been defined, the 
Import Wizard will ask you to add that carrier. User names can be imported without 
a defined carrier, but will need to be revisited to add devices. 

,PSRUWLQJ�D�)LOH�

� 7R�LPSRUW�D�ILOH��
1. From the Tools pull-down menu, select Import Wizard. The Import Wizard dialog 

displays. Choose Import a CSV File and click Next. The Import Wizard – Step 1 dialog 
displays. 

2. Click the Browse button to select the CSV file. Click Open. The location of the database is 
now displayed in the File text box. Click Next. 

The Import Wizard – Step 2 dialog displays:  

3. Select Grant Login Access to allow users the ability to login as a client application user. 
Select the way the Login Name and the User Name Format appear in the file. If you are 
unsure how the name was entered in the CSV, click the View button.  

4. In the Login Name area, you can select Use User Name so that no field needs to be defined 
in the import file and WirelessOffice will simply use the User Name. Click Next.
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The Import Wizard – Step 3 dialog displays: 

5. Arrange the columns by choosing their order from the drop-down list. If you are unsure how 
the name was entered in the CSV, click the View button. Each field must be defined.  

6. The Carrier  drop-down list includes the choice to specify a server-defined carrier that all 
imported users will be associated with. If you select specify, the Import Wizard – Choose 
Carrier  dialog will display. Select the carrier to associate with ALL imported users. Click 
Next.  

7. In the Import Wizard –Step 4 dialog, verify that the import information is correct and click 
Next to begin importing. The Import Wizard status screen displays the progress. 

8. Import status is displayed, including any errors or warning. Click the View Log button for 
detailed information. Click Finish. 

Note: During import processing, the number of users listed reflects your software license 
maximum. 

You can import different spreadsheets. Each import only adds users to the database 
and does not overwrite existing profiles. Each import uses the default security 
settings defined in Server Configuration.  

 

8QGRLQJ�D�3UHYLRXV�,PSRUW�

� 7R�XQGR�D�SUHYLRXVO\�LPSRUWHG�&69�GDWDEDVH��
1. From the Tools pull-down menu, select Import Wizard . The Import Wizard dialog 

displays. 

2. Click Undo a previous import then click Next.  Click the Browse button to locate the file 
and select the UNDO file. Click Next. 

3. The Import Wizard – Undo  screen displays the progress. 

4. If any problems are indicated on-screen, click the View Log button. Click Finish.
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8VLQJ�:LUHOHVV2IILFH�0HVVHQJHU�

WirelessOffice Messenger provides users with a simple messaging tool that creates, schedules and 
sends messages with a personal address book option, as well as server address book accessibility. 
The Message Log provides real-time message status.  

1HZ�:LUHOHVV2IILFH�0HVVHQJHU�)HDWXUHV�

• User Name/Password authentication for server connections (page 68) 
• Department message sending and membership viewing (page 86) 
• Security profiling for all WirelessOffice Messenger users (page 41) 
• Auto-display of message replies option (page 81) 
• Windows Me and Windows 2000 compatibility 

6WDQGDUG�:LUHOHVV2IILFH�0HVVHQJHU�)HDWXUHV�

• Personal Address Book option for each user 
• Messaging using server-defined users and groups 
• Automatic message resend 
• Personal device editing option 
• Message scheduling option 
• Message signature 
• Auto spell check 
• FastPIN quick messaging using PIN and Carrier 

6WDUWLQJ�WKH�6RIWZDUH�

WirelessOffice Messenger allows message sending from Windows 95/98/Me/NT and 2000 
systems.  

� 7R�VWDUW�WKH�VRIWZDUH��
1. From the taskbar, click Start, then Programs. Click the Emergin WirelessOffice folder, then 

WirelessOffice Messenger.  

2. Or double-click the WirelessOffice Messenger desktop shortcut (if available). 
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/RJLQ�WR�:LUHOHVV2IILFH�0HVVHQJHU�

If you did not choose a server when installing the WirelessOffice software, you will need to 
configure the server connection. Please see “To start the server” on page 20, for instructions on 
how to start WirelessOffice.  

�� � 7R�ORJLQ�WR�:LUHOHVV2IILFH�0HVVHQJHU��
1. Start the WirelessOffice Messenger application, see “Starting the Software” on the previous 

page for instructions. 

The Welcome to WirelessOffice dialog displays: 

2. Enter your User Name assigned by the system administrator. Type your Password to login to 
the WirelessOffice Server. You can only be logged in once at any given time to the Server 
with your User Name. If you are using the ‘Administrator’ account, you will need to create a 
new user login account with the appropriate security settings and rights. 

3. Type the name or Internet address of the WirelessOffice Server you wish to access. Use the 
drop-down arrow to choose a previously selected server. Use the X button to remove any 
unwanted servers from the list. Consult your system administrator for assistance. 

4. Select Remember password if you wish to auto-login in the future. Click OK. 

&KDQJH�<RXU�3DVVZRUG�

After entering WirelessOffice Messenger, you can change your password. 

1. Click File then Change Password. 

2. Type your Old Password and then type your New Password. 

3. The next login will require use of your new password.  
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8QGHUVWDQGLQJ�6\VWHP�%DVLFV�

This section provides basic system information that you should know prior to using your 
WirelessOffice Messenger software. There are four main application windows. These are called: 
New Message, Message Log, Scheduled Messages and Address Book. You can switch between 
the windows by selecting them from the view menu or by clicking the tabs at the bottom of each 
screen. 

Before you begin, it is important that you become familiar with the four WirelessOffice Messenger 
application windows: 

��1HZ�0HVVDJH�:LQGRZ�

1HZ�0HVVDJH�0HQX�%DU�
The menu bar provides options that you can use to activate WirelessOffice and standard Windows 
functions. The step-by-step instructions detailed throughout the WirelessOffice Messenger section 
refer to the menu bar functions: 

File Edit View Help 

Open 
Save 
Properties 
Send Message 
Message Scheduler 
Change Password 
Change Server 
Exit 

Undo 
Cut 
Copy 
Paste 
Remove 
Font Properties 
Check Spelling 

Toolbar 
Status Bar  
Tabs 
Switch To 
Large Icons 
Small Icons 
List 
Details 
Arrange Recipients 

Help Topics 
Tip of the Day 
Emergin Knowledge Base 
About WirelessOffice 

Menu Bar 

Toolbar 

Status Bar

Tabs 
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1HZ�0HVVDJH�7RROEDU�
The toolbar provides an alternative method to accessing the menu bar options. Once you are 
familiar with the icons, you can directly select various functions from the toolbar. 

 

The table below explains each icon in the WirelessOffice Messenger toolbar: 

Icons Description Icons Description  Icons Description 

 
Send Message 

 
Delete 

 

 
Paste 

 
Open File 

 
Undo 

 

 
Font Properties 

 
FastPIN 

 
Cut 

 

 
Spell Check 

 
Save Text 

 
Copy 

 

 
Help Topics 

 
Properties 

 
 

  
 

�� �

�� 1HZ�0HVVDJH�6WDWXV�%DU�

The status bar is found at the bottom of all four main application windows below the tab bar. The 
information displayed varies with each window. In the New Message window, the Status Bar 
shows how many characters your message contains and how many recipients are selected. To the 
right of this information, the server name and the server activity indicator appear. This feature is 
common to all four main application windows. Additionally, as you move your mouse pointer over 
the various toolbar icons, the left side of the status bar explains the action associated with the icon. 
This feature also appears in all four main application windows. When the green light displays, that 
indicates a request is being made to the server. 
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0HVVDJH�/RJ�:LQGRZ�

The Message Log window is used to view message status for messages sent from your 
WirelessOffice Messenger. Detailed message status can be viewed by clicking the Properties icon 
on the toolbar or by double-clicking the message. 

�� �

�� 0HVVDJH�/RJ�0HQX�%DU�
The table below shows the choices available in the WirelessOffice Messenger Message Log menu 
bar: 

File Edit View Help 

Properties 
Save As 
Print 
Print Preview 
Print Setup        
Change Password 
Change Server 
Exit 

Delete 
Delete All 
Edit Message 
Resend Message 
Find 

Toolbar 
Status Bar  
Tabs 
Switch To 
Refresh 

Help Topics 
Tip of the Day 
Emergin Knowledge Base 
About WirelessOffice 

Status Icons 
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�� 0HVVDJH�/RJ�7RROEDU�

 

The table below explains each icon in the WirelessOffice Messenger Message Log toolbar: 

Icons Description  Icons Description 

 
Resend Message 

 

 
Refresh 

 
Edit 

 

 
Find 

 
Properties 

 

 
Help Topics 

 
Delete 

   

�� 0HVVDJH�/RJ�6WDWXV�,FRQV�
The following table provides a description of each message status icon:  

Icons Status/Description  Icons Status/Description 

 

Partial Success — the wireless 
carrier rejected at least one 
message from a multi-recipient 
message. 

 

 

Unknown — the system cannot 
determine the status of the message, 
generally caused by stopping the 
service when a message is queued. 

 
Queued — the wireless carrier 
has not dispatched the message. 

 
 

No Ports Configured — the port is 
not configured. 

 

Accepted — the wireless carrier 
acknowledged and accepted 
message. 

 

 
No Direct Connection — a direct 
connect carrier is not configured. 

 
Rejected — the wireless carrier 
rejected the message. 

 

 

No Device Configured — the user 
has no device defined or currently 
enabled. 

 
Failed — a critical system error 
occurred. 

 
 

No Modem Configured — a modem 
has not been configured. 

 
Acknowledged — a two-way 
device responded to a message. 
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�� 0HVVDJH�/RJ�6WDWXV�%DU�
This status bar displays the total number of messages sent to the server. 

6FKHGXOHG�0HVVDJHV�:LQGRZ�

The Scheduled Messages window is used to view scheduled message status. Messages detailed in 
this window originate from this system. Detailed message status can be viewed by clicking the 
Properties icon on the toolbar or by double-clicking the selected message. 

�� 6FKHGXOHG�0HVVDJHV�0HQX�%DU�
This table shows the choices available in the WirelessOffice Messenger Scheduled Messages 
menu bar: 

File Edit View Help 

Properties 
Save As 
Print 
Print Preview 
Print Setup              
Change Password 
Change Server 
Exit 

Delete  
Find 

Toolbar 
Status Bar  
Tabs 
Switch To 
Refresh 

Help Topics 
Tip of the Day 
Emergin Knowledge Base 
About WirelessOffice 
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�� 6FKHGXOHG�0HVVDJHV�7RROEDU�

 

 

This table explains each icon in the WirelessOffice Messenger Scheduled Messages toolbar: 

Icons Description Icons Description 

 
Properties 

 
Find 

 
Delete 

 
Help Topics 

 
Refresh 

 
 

 

�� 6FKHGXOHG�0HVVDJHV�,FRQV�
This table provides a description of each scheduled message status icon: 

Icons Status/Description 

 

Delayed Message — the message is scheduled for later 
delivery (one time only). 

 
Daily Message — the message will be sent on a daily basis. 

 
Weekly Message — the message will be sent on a weekly 
basis. 

 

Monthly Message — the message will be sent on a monthly 
basis. 

 

�� 6FKHGXOHG�0HVVDJHV�6WDWXV�%DU�
This status bar displays the total number of scheduled messages. 
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$GGUHVV�%RRN�:LQGRZ�

The Address Book window is used to view information about users, groups and departments in 
three types of address books – server, personal and combined. In the combined address book, 
notice that there are six different types of icons that resemble people: 

• Dark green icons — represent users stored in the server’s directory.  

• Dark green icon with a yellow glow — represents you. 

• Green and tan group of three — represents server-based groups of individual users.  

• Red and tan group of three — represents server-based departments comprised of 
individual users. 

• Light blue icons — represent users in your Personal Address Book. 

• Light blue and tan group of three — represents groups in your Personal Address Book. 

Your user account may have security rights that affect the address book listings. Certain address 
book components may or may not be visible to you. Contact your system administrator for more 
information about access rights. 
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�� $GGUHVV�%RRN�0HQX�%DU�
This table shows the choices available in the WirelessOffice Messenger Address Book menu bar: 

File Edit View Help 

New User 
New Group 
Properties 
Save As 
Print 
Print Preview 
Print Setup 
Change Password 
Change Server 
Exit 

Delete 
Select All 
Find 

Toolbar 
Status Bar  
Tabs 
Switch To  
Large Icons 
Small Icons 
List 
Details 
Arrange Users 
Address Book 
Refresh 

Help Topics 
Tip of the Day 
Emergin Knowledge Base 
About WirelessOffice 

�� $GGUHVV�%RRN�7RROEDU�

 

This table explains each icon in the WirelessOffice Messenger Address Book toolbar: 

Icons Description  Icons Description  Icons Description 

 
Send Message 

 

 

View Server 
Address Book  

 

 
Small Icons 

 
Properties 

 

 

View Personal 
Address Book  

 

 
List 

 
Delete 

 

 
View All Users 

 

 
Details 

 
Refresh 

 

 
Large Icons 

 

 
Help Topics 

 
Find 

 
  

   

 

�� $GGUHVV�%RRN�6WDWXV�%DU�
This status bar displays the total number of Users, Groups and Departments in the current window. 



Using WirelessOffice Messenger 

   77

6HQGLQJ�D�0HVVDJH�

� 7R�VHQG�D�PHVVDJH��
1. From the New Message main window, click To. 

The WirelessOffice - Message Recipients dialog box displays: 

2. To select a message recipient, select the desired Address Book icon. Then select the name 
from the Address Book list box. Click Add. You can also double-click the recipient to have 
them added. Your selection displays in the Recipients list box. To remove your selection, 
select the name from the Recipients list box and click Remove. 

3. When you have finished selecting the recipient(s) for your message, click OK.  

The WirelessOffice – New Message dialog box redisplays with the message addressed to the 
selected message recipient(s): 

4. Type your message in the Message text box (4,096 character maximum). Click the Send 
button on the lower left-hand side of the window. 

5. A status message in the Message Log tab displays, indicating that the request has been sent. 
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8VLQJ�WKH�5HFLSLHQW�'LUHFWRU\�

The Recipient Directory contains recipients from the server’s database and your Personal Address 
Book (if available).  It allows you to address your messages by selecting recipients to whom you 
want to send the message. 

The Recipient Directory is used to select single or multiple recipients to whom you want to send a 
message. To select a recipient, you can click on the user, group or department name in the Address 
Book list, then click Add, or double-click on the recipient name. You can select multiple entries at 
once by holding down the CTRL key while making your selections. These are then “copied” from 
the Directory List (from the bottom pane of the window) to the Recipients List (the middle pane of 
the window). 

To help you find users as your list grows, column header buttons are provided.  Click on the 
column header buttons to sort the list by Name, Type or Source. You can also use options on the 
context menu (accessed with a right-click) to change the view of the list.  

• The Type column indicates whether the entry is an individual user, group or department.  

• The Source column indicates whether the user came from the server’s database or your own 
personal address book. 

• To find a user by Name, type the name in the To: box. As you type, the names that match 
your entry display in the list with the first match selected.  

Note: WirelessOffice allows you to start typing the name of a recipient and the software 
automatically completes their name. 

  

Recipients List 

Directory List 



Using WirelessOffice Messenger 

   79

)DVW3,1�)HDWXUH�

Use this feature to send to a recipient when you only know their PIN (Personal Identification 
Number) and the name of their carrier. If your user account has limited message sending rights, use 
the FastPIN feature to send messages.  

� 7R�XVH�WKH�)DVW3,1�IHDWXUH��
1. Select the FastPIN icon from the toolbar. 

The FastPIN Recipient dialog displays:  

2. Type the PIN number. Select the Carrier from the drop-down list. Click OK. 

3. Type your message in the Message text box. 

4. From the File pull-down menu, select Send Message. Or click the Send button on the toolbar. 
(At this point, you also have the option to delay the message or schedule it for delivery at 
predefined intervals. Refer to “Scheduling Messages” on the next page.) 

5. A status message in the Message Log tab displays, indicating that the request has been sent. 

FastPIN icon
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6FKHGXOLQJ�0HVVDJHV�

To send a message at a future time or at regularly scheduled intervals, use the Scheduled Messages 
feature. The scheduled messages tab may not be accessible for your account. Contact your system 
administrator for further information. 

� 7R�VFKHGXOH�D�PHVVDJH��
1. Click the Schedule button on the New Message dialog.   

The Message Scheduler dialog box displays: 

2. Enter the date and time that you want the message to be sent and click OK. You can use the 
spin controls to independently increment or decrement any part of the time and date (i.e. 
month, day, year, hour, minute, or AM/PM).   

Note: This feature will delay delivery of the message to all recipients. If you opted to send a 
scheduled message, note that an alarm icon appears on the right hand side of the 
message window. Click it to cancel the scheduling before sending. 

0HVVDJH�2SWLRQV�

WirelessOffice allows you to specify certain options, including an automatic spell check. A custom 
signature can be appended to all of your messages. This feature can be useful for automatically 
adding your name, business phone, or any pertinent information to your messages. 

The Message Options dialog allows you to: 

• Automatically spell check your message before sending 
• Clear recipients from the To: box after sending 
• Clear message text after sending 
• Switch to Message Log 
• Send your signature at the end of your message 
• Display a pop-up dialog when your two-way message responses arrive 
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� 7R�DGG�PHVVDJH�RSWLRQV��
1. Click the Options button in the New Message dialog to open the Message Options dialog. 

2. Enable Auto Spell Check before sending if desired. Select any After sending options, such 
as Clear Recipients, Clear Message Text or Switch to Message Log. 

3. Enter you custom signature in the Message Signature text box. Click the Enabled check box 
to enable the message signature. 

4. In the Message Replies area, select Display in pop-up dialog for two-way message responses 
to be displayed in a special dialog. Escalated message responses will not display as a pop-up. 
All message replies, included escalated responses, also display in the Message Log. Click OK 
when done. 

6RXQG�(YHQWV�

You can receive audio notification of certain events that occur in WirelessOffice. 

� 7R�DFWLYDWH�VRXQG�HYHQWV���
1. Click Start from the taskbar, select Settings, then Control Panel. Click the Sounds icon. The 

Sounds Properties dialog displays. 

2. Highlight the WirelessOffice event(s) to associate with audio notification. You can associate 
sounds with scheduled message, message response and message sent events. 

3. In the Sound area, click the Browse button to select your sound choice. Click OK. 
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9LHZLQJ�WKH�0HVVDJH�/RJ�

The Message Log displays messaging events including the date and time a message was 
originated, the name of the message recipient, the message status, and the message text. You can 
also resend a message from the Message Log. You can configure WirelessOffice Messenger to 
display pop-up dialogs whenever a new Acknowledged two-way message replies arrives. Please 
see “Message Options” on page 80.  

Message status includes: Failed, Delayed, Rejected, Queued, No Device, No Modem, No Port, No 
Direct Connection, Unknown, Partial Success, Accepted, and Acknowledged. 

�� � 7R�YLHZ�0HVVDJH�/RJ�HQWULHV��
1. Click the Message Log tab.  

2. Or click View from the pull-down menu, select Switch To then choose Message Log.  

� 7R�UHVHQG�D�PHVVDJH��
1. Click the message you want to resend.  

2. There are three ways to resend a message: 

• Click the Resend Message icon on the toolbar. 
• From the File pull-down menu, select Resend Message. 
• Right-click and select Resend. 

� 7R�HGLW�D�PHVVDJH��
You can edit an already sent message’s recipients or text if needed before resending. 

1. Click the message you want to edit.  

2. There are three ways to edit a message: 

• Click the Edit icon on the toolbar. 
• From the Edit pull-down menu, select Edit Message. 
• Right-click and select Edit. 
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� 7R�GHOHWH�D�PHVVDJH��
1. Click the message you want to delete.  

2. There are four ways to delete a message: 

• Click the Delete icon on the toolbar. 
• From the Edit pull-down menu, select Delete or Delete All. 
• Right-click and select Delete or Delete All. 
• Press the DELETE key. 

� 7R�UHVHQG�IDLOXUHV��
The resend failures feature allows you to resend messages that were not received by all recipients 
in a group or department. Using this, you can resend your message to only the recipients who did 
not receive it. 

1. Select the failed message. 

2. Double-click the chosen message. Alternatively, you can choose the Properties icon on the 
toolbar. The Message Properties dialog displays, open to the Recipient Status tab. 

3. Click the Resend Failures button. 

9LHZLQJ�6FKHGXOHG�0HVVDJHV�

This section details the features of the Scheduled Messages window. The scheduled messages 
feature may not be accessible for your account. Contact your system administrator for further 
information. 

� 7R�YLHZ�VFKHGXOHG�PHVVDJHV��
1. Click the Scheduled Messages tab.  

The WirelessOffice – Scheduled Messages dialog displays: 

2. Scheduled messages awaiting transmission display. Change scheduling information by 
double-clicking on the message. 
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� 7R�GHOHWH�D�VFKHGXOHG�PHVVDJH��
1. Click on the Scheduled Message you want to delete.  

2. There are four ways to delete a Scheduled Message: 

• Click the Delete icon on the toolbar. 
• From the Edit pull-down menu, choose Cut. 
• Right-click and select Delete. 
• Press the DELETE key. 

9LHZLQJ�WKH�$GGUHVV�%RRN�

This section details the features of the Address Book. If no entries have been made to the Personal 
Address Book, you will see users, groups and departments listed in the main WirelessOffice 
Server. The server-based and personal address book may have limited viewing or accessibility. 
Contact your system administrator for further information. 

� 7R�YLHZ�WKH�$GGUHVV�%RRN��
1. Click the Address Book tab. 

2. Or to access this screen via the View pull-down menu, select Switch To. Select Address 
Book. 

The WirelessOffice – Address Book dialog displays:  
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9LHZLQJ�8VHU�DQG�'HYLFH�'DWD�

The combined server and personal Address Book displays a list of available recipients in the server 
database, as well as in your personal address book database. By selecting a particular user, you can 
view the name of their wireless carrier, the device type and device status. Device status is either 
Active or Inactive.  

� 7R�YLHZ�XVHU�DQG�GHYLFH�GDWD��
1. In the combined address book, double-click the user record that you want to view. The 

properties screen will differ depending if it is a server-based or personal address book record. 
The Personal Address Book – Edit User dialog displays for a selected user in the personal 
address book. 

The user properties display for a server-based user:   

2. For further details on a specific user’s device, highlight the device name then click the Device 
Properties icon. The Device Availability window displays. These properties are read-only. 
Please see “To set or change your device availability” on page 91 for more information. 

3. To edit your own device, select your user name from the address book. Your icon should be 
highlighted in yellow. Please see “Managing Your Mobile Devices” on page 89. 

Device Properties 
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9LHZLQJ�*URXS�DQG�'HSDUWPHQW�0HPEHUVKLS�

Selecting a particular group or department record displays a list of its members. Server-based 
groups or departments may not be accessible to your user account.  

� 7R�YLHZ�JURXS�PHPEHUVKLS��
1. Click the group or department record that you want to view. The properties screen will differ 

depending if it is a server-based or personal address book record. The Personal Address 
Book – Edit Group dialog displays for a selected group in the personal address book (there 
are no departments in the personal address book). 

The group properties window displays for a server-based group:  

2. Please note that this window is used only to display membership information.  

3. For further information on a group or department member’s devices, double-click the 
member’s name or highlight it, then click the User Properties icon. 

User Properties 
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0DQDJLQJ�<RXU�3HUVRQDO�$GGUHVV�%RRN�

This section describes how you can set up your own Personal Address Book.  To manage your 
personal address book, you need to know how to add, modify, and delete entries. New users and 
groups may be configured. Your Personal Address Book can contain up to 100 recipient entries 
(depending on your licensing configuration) and each group can have up to 25 members. The 
personal address book may not be accessible according to your user account rights.  

$GGLQJ�8VHUV�

� 7R�DGG�XVHUV���
1. Click the Address Book tab and select the Personal Address Book icon in the toolbar. From 

the File menu, select New User or right-click in the Personal Address Book screen and 
select New User. 

The Personal Address Book - New User dialog box will display: 

2. Type the new user name in the Name text box. 

3. Enter the user’s Personal Identification Number (PIN) in the PIN box. 

4. In the Carrier box, select the appropriate carrier from the drop-down list. 

5. Add any descriptive information about the user, e.g. title, department, or company in the 
Notes text box. Click OK. The new user’s icon displays in the Address Book window. 
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$GGLQJ�*URXSV�

A group is the term used to describe a collection of individual users in your Personal Address 
Book. All users that will be in a group must exist in either the server or personal address book 
before you can create that group. 

� 7R�DGG�JURXSV��
1. Click the Address Book tab and select the Personal Address Book icon in the toolbar. From 

the File menu, select New Group or right-click in the Personal Address Book screen and 
select New Group. 

The Personal Address Book - New Group dialog box displays:  

2. Type the group’s name in the Name box and any Notes.  

3. Click the Members tab. Click on a specific user name in the Directory list and click Add. 
The user will be transferred to the group Members list. You can select multiple users at once 
by pressing the CTRL key while making selections. You can also double-click a name for 
member entry. Repeat these steps until all desired group members are selected. 

4. Be sure to click on the appropriate address book icon to access the correct directory list. Also, 
use the Find feature to quickly locate a user. 

5. To remove a user from the Members list, select their name and click Remove or double-click. 

0RGLI\LQJ�8VHUV�DQG�*URXSV�

If a user or group in your Personal Address Book was entered incorrectly or if a user’s carrier or 
PIN information has changed, you can modify the user record. 

� 7R�PRGLI\�XVHUV�DQG�JURXSV��
1. From the Personal Address Book screen of the Address Book window, select the user or 

group you want to modify and click Properties. Or double-click the entry or press ENTER. 

2. Change the information as required and click OK. 
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'HOHWLQJ�8VHUV�DQG�*URXSV�

When you no longer require a particular user or group entry in your personal address book, you 
can remove it using the following procedure. 

� 7R�GHOHWH�XVHUV�DQG�JURXSV��
1. From the Personal Address Book screen of the Address Book window, select the user or 

group you want to delete and click Delete. 

2. A message will appear asking if you are sure that you want to delete the selected item. Click 
Yes. 

5HIUHVKLQJ�WKH�$GGUHVV�%RRN�

Each time you start WirelessOffice Messenger, the system builds a Directory List by looking at the 
server’s database and your Personal Address Book. Use the Refresh button on the toolbar to 
refresh the Directory List when entries have been added to either the server’s database or your 
Personal Address Book since you last started the WirelessOffice Messenger software. 

0DQDJLQJ�<RXU�0RELOH�'HYLFHV�

This section describes how you can control your devices that are defined in the server’s address 
book. This feature allows you to edit the properties of your device(s) including PINs, carriers and 
scheduled availability. You may also add new devices and remove unused ones. Your message 
statistics are also enabled and viewable.  

Note: This feature may not be enabled for your account, consult your administrator for 
further information. 

�� � 7R�DGG�D�GHYLFH�WR�\RXU�XVHU�UHFRUG��

1. Select your user name from the Address Book. Click  from the properties screen to add a 
new device. 

The Device Wizard – Step One dialog displays: 

2. Choose the type of device and click Next. 
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The Device Wizard – Step Two dialog displays:  

3. Type the PIN number.  Select a carrier. Click Finish. 

� 7R�GHOHWH�D�GHYLFH��

Select a device and click  to delete. 

� 7R�HGLW�D�GHYLFH��

1. Select a device and click  to edit. Alternatively, you can double-click the device. 

The Device Properties dialog displays: 

2. Edit the carrier provider and PIN. Enable or disable the device. You can schedule your mobile 
device Availability . Please see “To set or change your device availability” on the next page. 

3. Select Enable Message Numbering if you receive longer messages and fragmenting occurs. 

4. Select Enable responses to include the message identification number assigned by 
WirelessOffice. This allows a user’s two-way device response message to be linked to the 
original message. This field is grayed out if a One-Way Pager or Cell Phone were selected as 
the device type. Two-way messaging only functions with E-mail Messenger configured. 

5. Configure your Maximum message length or change the Maximum number of fragments. 
Be sure to consult your carrier before changing these settings. 
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� 7R�VHW�RU�FKDQJH�\RXU�GHYLFH�DYDLODELOLW\��
1. Click the Availability button on the Device Properties screen to set or change the schedule. 

The Device Availability dialog displays: 

2. This screen allows you to customize your device activation. You can select the days and time 
period your mobile device is active.  For example, the screen above shows that the device is 
active Monday through Friday, 9 AM to 5 PM. 

� 7R�YLHZ�VWDWLVWLFV��
1. Select the Statistics tab to view your statistics.   

2. If you wish to change the time span for logging statistics, click the Change button. Select the 
parameters that you require. Click OK. 

6DYLQJ�9LHZV�WR�&69�)LOHV�

You can export the contents of tabbed view to a comma-delimited (.csv) file for troubleshooting 
analysis or report production. Text files may also be saved.  

Select the desired tab, right-click and select Save As. In the Save as type field, select the .csv 
format. Choose the folder destination to save the log then click Save. 
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8VLQJ�&RPPDQG�0HVVHQJHU�

This chapter describes Command Messenger, formerly named SendPage. Command Messenger 
will automatically install when chosen from the Select Components to Install dialog.  This 
section provides you with configuration and operating considerations.  

Command Messenger is a command-line utility that provides an interface to third-party 
applications such as firewalls, help desk, monitoring, and network management tools. Programs 
such as Microsoft Performance Monitor, Check Point FireWall-1, and Computer Associates 
Unicenter TNG amongst others are compatible. If the software has a command-line utility, then it 
can send messages to WirelessOffice. The following figure depicts the messaging flow from 
Command Messenger to wireless devices: 

1HZ�&RPPDQG�0HVVHQJHU�)HDWXUHV�

• User Name/Password authentication for server connections (page 94) 
• Department messaging (page 96) 
• Escalation messaging (page 97) 
• User security profiling 

6WDQGDUG�&RPPDQG�0HVVHQJHU�)HDWXUHV�

• Routes alerts via command-line utility from firewall/help desk/monitoring/network 
management software and via desktop shortcut 

• Command-prompt messaging 
• Addresses messages by server-defined user or group name 
• Addresses messages using PIN and server-defined carrier name  
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&RPPDQG�0HVVHQJHU�&DSDFLWLHV�

Command Messenger has certain software messaging capacities: 

Parameter Capacity 

Recipients* per message 1 

Characters per message 4096 

*A recipient can also be a server-defined group or department. 

&RQILJXULQJ�&RPPDQG�0HVVHQJHU�

� 7R�FRQILJXUH�&RPPDQG�0HVVHQJHU��
1. Click Start, point to Programs and select Command Prompt or enter your third-party 

software. From the command line, you will configure Command Messenger. Once Command 
Messenger is connected to the Server, either via Command Prompt or your application, you 
will not have to repeat these steps.  

2. In the command line type: 

cmdmsgr –imbird –u”Command Messenger” -wpassword  

where mbird is the Internet address of the system that WirelessOffice Server is running on, 
Command Messenger is the user Login Name and password is the Password.  

Note: You can only login once at any given time using the ‘Administrator’ account. Create a 
new user name specific to Command Messenger with appropriate security settings. 

User names, recipient names, carriers, passwords, and messages with spaces need to 
be enclosed with double quotes. 

  

3. If you receive a PASS: for all three components, then Command Messenger is ready to send 
messages to WirelessOffice. 

4. If the server was not located or there was a problem with the User Name or Password, a 
FAIL: message will display. 
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&RPPDQG�0HVVHQJHU�&RPPDQGV�

In the command line, the following commands will configure the WirelessOffice Server, display 
information or compose a message: 

Command Action 

-? Lists help information. 

-c[Carrier] Carrier name, included as part of message. Must be server defined. 

-d Indicates the recipient is a department. 

-delay[Seconds] Delay time for an escalated message level. Range is 60-86400 seconds, 
with default of 1800 if unspecified. 

-g Indicates a recipient is a group. 

-i[IPaddress] Sets the IP address or name of the WirelessOffice Server. Must be 
followed by UserName and Password commands. 

-l[0|1] Logging level setting. 0 is off and 1 is on.  Log location is c:winnt\ 
cmdmsgr.log. 

-level[x][Recipient] Level and recipient for an escalated message. For x value, use 1 to 5 
indicating the level number. Use server-defined recipient name (user, 
group or department). If a group or department name, follow with –g or 
–d command to specify. 50 characters maximum. 

-m[Message] Message text, included as part of message.  

-p[PIN] PIN number, included as part of message. 

-rep[x] Repeat last level of an escalated message, where x is the number of 
times to repeat. The x value can be 0 to 255, where 0 will not repeat the 
last level and 255 will repeat infinitely. If omitted, 0 is assumed. 

–t[Recipient] Recipient name defined in WirelessOffice Server, included as part of 
message. Must be predefined in server. If group or department name, 
follow with –g or –d command to specify. 50 characters maximum. 
Names with spaces require double quotes. 

-test Test connectivity to WirelessOffice Server. Enter this after setting the 
server Internet address/name and logging in. 

-u[UserName] Sets the User Name required for login. 50 characters maximum. 

-v Lists default settings. 

-w[Password] Sets the password associated with the User Name for login. 20 
characters maximum. 

 

Note: All information in brackets must be user defined. If using non-standard ASCII text, 
enclose with double quotes. Any parameters with a blank space must be enclosed 
with double quotes. Command options are case sensitive. Command options -c, -t, -u, 
and -w must be defined in the WirelessOffice Server. 



WirelessOffice System Administrator Manual 

96 

6HQGLQJ�D�0HVVDJH�

� 7R�VHQG�D�PHVVDJH��
• If sending messages via a third-party application, Command Messenger must be loaded on 

that system (which must be networked to WirelessOffice Server). Before sending any 
messages, connect to the WirelessOffice Server by typing in the third-party application 
command line or using Command Prompt on that system: 

cmdmsgr -i[wirelessoffice server name or internet address] –
u[User Name] –w[Password] 

• User login name, password, recipient names and carriers must be defined in WirelessOffice 
Administrator. If a user is not configured, use the PIN and carrier method of sending a 
message. 

• Parameters that have blank spaces must be enclosed with double quotes. 

cmdmsgr –t“Jane Benedict” –m”red alert in room 232” 

cmdmsgr –tTechnicians –d –m”failed system in switch room” 

cmdmsgr –t“Field Reps” –g –m”product demo Friday noon”   

• PIN and carrier message format (carrier must be defined in the server): cmdmsgr –
p1234567 –cSkytel –m”alert circuit 178”  

• Command options are case sensitive. 
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&RPPDQG�0HVVHQJHU�([DPSOHV�

�� � 7R�VHQG�PHVVDJHV�
The following examples depict messages sent to a user, department, group, and implementing the 
PIN/Carrier method. 

�� � 7R�GLVSOD\�WKH�FXUUHQW�VHWWLQJV��
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6HQGLQJ�DQ�(VFDODWHG�0HVVDJH�

Optional commands are available to allow a message to escalate up to five levels of recipients. 
Escalated messages sent from Command Messenger reside in WirelessOffice Administrator’s 
Escalated Messages tab until delivery time. Please see “Viewing Escalated Messages” on page 61. 

Example: Send an escalated message to two levels, each with 5 minute delays. The first level 
recipient is John Smith and the second level is the “Management” department. The last level will 
be repeated 3 times or until the escalated message is cancelled. The rules stated in the previous 
section, “Sending a Message”, apply. The following entry reflects the commands needed for 
Command Messenger to send this message and assumes the server connection has already been 
made: 

cmdmsgr –rep3 –level1”John Smith” –delay300 –level2Management –d 
delay300 –m“Red Alert, report immediately to front desk” 

Note: Cancel or advance these messages in WirelessOffice Administrator’s Escalated 
Messages tab, via E-mail Messenger’s two-way device response, via cell or land 
phone using Voice Messenger or in Web Messenger.  

(VFDODWLQJ�DQG�&DQFHOLQJ�(VFDODWHG�0HVVDJHV�

Escalated messages can be cancelled or manually escalated in WirelessOffice Administrator. 
Messages can also be cancelled using two-way messaging via E-mail Messenger or within Web 
Messenger. Please see “Viewing Escalated Messages”, on page 61, for more information on using 
WirelessOffice Administrator to carry out these actions. Please see “Cancellation and Escalation” 
in the E-mail Messenger Manual for more information on two-way escalation cancellation and see 
“Cancellation and Escalation” in the Web Messenger Manual. Please see “Calling into Voice 
Messenger” in the Voice Messenger Manual. 

&UHDWLQJ�'HVNWRS�6KRUWFXWV�IRU�0HVVDJLQJ�

For quick and easy alerting, configure desktop shortcuts that when activated, send a specific 
message via Command Messenger.  

� 7R�FUHDWH�GHVNWRS�PHVVDJLQJ�VKRUWFXWV�
1. Right-click on your desktop. Select New and then Shortcut. The Create Shortcut dialog 

displays. 

2. In the Command line, type the “cmdmsgr” command message. Click Next. 

3. Title the shortcut for easy recognition. Click Finish. 
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3HUIRUPDQFH�0RQLWRU�([DPSOH�

Windows-based Microsoft Performance Monitor is used to measure the performance of a computer 
or other computers on a network. System alerts, using Command Messenger as the messenger, can 
be configured for out-of-compliance conditions. Set up multiple alerts for everything from low 
disk space to when a certain process on a server stops.  

For example, if you want to monitor a server’s running status, set up an alert condition so that the 
Command Messenger program will be run and a message generated when the processor time falls 
below x %. You can set up an alert like this for every server on the network and include in the 
message field such key details as server name, location and alert situation. 

� 7R�XVH�&RPPDQG�0HVVHQJHU�ZLWK�3HUIRUPDQFH�0RQLWRU��
Please refer to Performance Monitor’s on-line Help file for complete instructions and detailed 
information on setting up alerts. The following steps are only meant to show basic setup for 
Command Messenger alerting and reflect the third-party software on a Windows NT 4.0 system at 
time of publication. Performance Monitor is also available on Windows 2000.  

1. Click Start from the taskbar then Programs. Point to Administrator Tools (Common) and 
select Performance Monitor. 

2. Click View from the menu and choose Alert. Select Add to Alert from the Edit menu.  

The Add to Alert dialog displays: 

3. Select the Computer you wish to monitor for an alert. Select the Object, Counter, 
Instance and Alert If parameters as well. Alert If defines the out of tolerance range. 

4. In the Run Program on Alert text box, type the Command Messenger message using the 
required message format:  

cmdmsgr –t”john doe” –m”logical disk space C: is under 10% free 
on \\Interlaken”
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8VLQJ�)LOH�0HVVHQJHU�

File Messenger, formerly named FilePage, provides a simple interface to the WirelessOffice 
Server. File Messenger will automatically install when you check File Messenger from the 
WirelessOffice installation.  Using the File Messenger service, third-party applications and 
operating systems can send messages through the WirelessOffice Server by writing message files 
in a shared directory on the File Messenger system (see the following figure).  

 

File Messenger can run on the WirelessOffice Server system or on any other Windows NT/2000 
system that is connected to the network. File Messenger runs as a Windows NT/2000 service. Your 
third-party applications can run on any operating system that is capable of sharing a directory on 
the File Messenger system.  

Arrange to use File Transfer Protocol (FTP) of Microsoft Internet Information Server to share 
files across the directory from other operating system computers. IIS 3.0 or higher can be installed 
with the FTP protocol in order to receive text messages into the machine running File Messenger. 
FTP can be set up with an anonymous login, receiving files to the c:\inetpub\ftproot\ directory. File 
Messenger must have an entry in the Directories tab that matches your FTP setup. 

1HZ�)LOH�0HVVHQJHU�)HDWXUHV�

• User Name/Password authentication for server connections (page 107) 
• Escalation messaging (page 113) 
• User security profiling (page 41) 
• Department messaging (page 110) 
• Scans for FAT32 file system extensions on Windows 2000 systems 

6WDQGDUG�)LOH�0HVVHQJHU�)HDWXUHV�

• Accepts ASCII files from other operating systems or any file-writing third party application 
• Scans up to five directories on File Messenger local directory for FAT or NTFS file system 

extensions 
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• Pageable alerts for out-of-compliance file situations or formatting problems 
• Simple file format addressing server-defined recipients 
• Confidential file format addressing according to PIN and server-defined carrier 
• Message scheduling and file deletion after message is successfully sent 

)LOH�0HVVHQJHU�&DSDFLWLHV�

File Messenger has certain software capacities: 

Parameter Capacity 

Recipients* per message 1 

Characters per message 2000 

Scanned directories per system 5 

Messages allowed per file 1 

*A recipient can also be a server-defined group or department. 

&RQILJXULQJ�)LOH�0HVVHQJHU�

You must configure File Messenger before you can use its services.  At a minimum, File 
Messenger must know where to look for message files, where to maintain an error log, your user 
name and password to connect with the server and where on the network to find the WirelessOffice 
Server by its name or Internet address.  There are other configurable options available as well. 

� 7R�FRQILJXUH�)LOH�0HVVHQJHU��
1. You must be logged on as the Windows NT/2000 system administrator. Click Start from the 

taskbar, select Settings and click on Control Panel. Double-click the File Messenger icon. 

The File Messenger 3.0 dialog displays:  

2. Use the tabs along the top edge of the File Messenger control panel to access various 
configuration options.  When the dialog first appears, it is open to the Directories tab.  
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The four tabs are briefly described below. To access options under these tabs, click the desired tab. 
 

Tab Description 

Directories This tab shows the current list of shared directories and lets you add or remove 
folders from the list.  It also shows File Messenger’s current status (running or 
stopped) and lets you specify where the error log is maintained. 

Service Use this tab to start or stop the File Messenger service and to specify File 
Messenger’s startup behavior. 

WirelessOffice Use this tab to login, specify the Internet address or the name of the WirelessOffice 
Server, and to specify who should be alerted with a message when certain errors 
occur while File Messenger is processing messages. 

About This tab shows you the current version of File Messenger and provides access to 
general help about using the service. 

8VLQJ�WKH�'LUHFWRULHV�7DE�

Use this dialog to add or remove shared directories, specify the file type(s) of valid message files, 
and specify where the error log will be maintained.  Shared directories are folders that File 
Messenger monitors for message files.   

 

Note: File Messenger can support up to five shared directories using any Windows 
NT/2000 supported file systems.  Windows NT currently supports the FAT and 
NTFS file systems. Windows 2000 supports FAT, FAT32, and NTFS file systems. 
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� 7R�DGG�D�VKDUHG�GLUHFWRU\��
1. Stop the File Messenger service by clicking the Stop button on the Service tab. Return to the 

Directories tab and click the Add button.  

The Directory Properties dialog box displays: 

2. Select the folder to scan. For your reference, the file system (FAT, FAT32, or NTFS) being 
used by the selected folder appears at the bottom of the dialog box.  

3. Type the desired three-letter file name extension (file type) in the Extension field. File 
Messenger will only look for files of this type as candidates for message files in the selected 
folder. 

4. Click OK.  The new folder and file type will display in the Directories tab.  Restart the File 
Messenger service in the Service tab and click OK. 

Note: File Messenger can only scan directories on local hard drives. You cannot add 
directories on network drives. FAT directories only support three-character file name 
extensions. 

� 7R�UHPRYH�D�VKDUHG�GLUHFWRU\��
1. Stop the File Messenger service by clicking the Stop button on the Service tab. 

2. Under the Directories tab, click the directory (folder) you want to delete. 

3. Click the Remove button. The selected folder will disappear from the shared directory list and 
File Messenger will not monitor that folder for message files. 

4. Restart the File Messenger service in the Service tab and click OK. 
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� 7R�FKDQJH�WKH�HUURU�ORJ�ILOH�ORFDWLRQ��
1. Stop the File Messenger service by clicking the Stop button on the Service tab. 

2. Under the Directories tab in the Error Log File area, click the  button.  The Choose Log 
File dialog box displays. The default log name is filemsgr.log. 

3. Locate and select the folder in which you want the Error Log file maintained. Type a file 
name in the File Name field and click OK. The new Error Log File and its path will appear in 
the Directories dialog box. 

4. Restart the File Messenger service in the Service tab and click OK. 

Note: Error and warning messages are logged to the NT/2000 Event Viewer as well as the 
selected text log file. 

8VLQJ�WKH�6HUYLFH�7DE�

Use the Service tab to start or stop the File Messenger service. You can also use this tab to specify 
File Messenger’s startup behavior.  For example, you can specify that File Messenger 
automatically starts when the computer it is loaded on starts (for unattended operation), or you can 
specify that starting and stopping File Messenger be controlled manually.  

�� � 7R�VWDUW�RU�VWRS�)LOH�0HVVHQJHU��

1. Click the appropriate button:   to start, or   to stop. 

2. Click OK if you are finished configuring File Messenger. Otherwise click on the Apply 
button before going to another tab. 

Note: File Messenger is a background service in Windows NT/2000.  If you click OK 
while File Messenger is running, the configuration control panel is closed but the 
service remains loaded and running. When you stop File Messenger, the service 
stops running. 
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� 7R�VWDUW�)LOH�0HVVHQJHU�IURP�:LUHOHVV2IILFH�$GPLQLVWUDWRU��
1. In WirelessOffice Administrator, select Change Server from the File pull-down menu. Click 

the Add button on the WirelessOffice Login dialog box.  

The Add Service dialog displays: 

2. Select the File Messenger service type and enter the server name or Internet address. 

3. Click Add. The WirelessOffice Login dialog box re-displays with the File Messenger service 
listed in the Server List. 

4. You can start and stop File Messenger from this dialog box by selecting it and clicking on 
either the Start or Stop button. Click Close to exit. 

Note: To start File Messenger in WirelessOffice Administrator, the Authentication Mode 
must be set for Windows and WirelessOffice. Please see “Change Authentication 
Mode” on page 19 for more information. 

 

� 7R�FKDQJH�WKH�VWDUWXS�W\SH��
1. Click the desired startup type: Automatic, Manual or Disabled. 

2. Click Apply if you are not finished configuring File Messenger. Otherwise, click OK. A 
change to the startup type will not take affect until the computer is next rebooted.  
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8VLQJ�WKH�:LUHOHVV2IILFH�7DE�

Use this tab to login, specify the name or Internet address of the WirelessOffice Server, test 
connectivity with the server, and specify who should be alerted with a message (if anyone) when 
certain errors occur while File Messenger is processing messages.   

� 7R�ORJLQ�DQG�VSHFLI\�WKH�VHUYHU�DGGUHVV��
1. Click the WirelessOffice tab. Type your User Name and Password (1-20 characters in 

length) to login to the server. You can login to only one application at a time with any given 
login identity. If you are using the ‘Administrator’ account, you will need to create a new user 
login account with the appropriate security settings and rights. 

2. Type the name or Internet address of the WirelessOffice Server. 

3. Click the Test Connectivity button to ensure that File Messenger can communicate with the 
WirelessOffice Server. If Last Connect Attempt and Last Login Attempt both display OK, 
then the test was successful. 

4. Any errors will be displayed as a message. Server Status indicates whether the connection to 
the WirelessOffice Server was successful or not. To locate the correct Server name, open the 
WirelessOffice Administrator and click File and then Change Server. If the server 
connection is not made, Login Status will be blank. Login Status indicates any login 
connection errors, such as the User Name is already logged in (each User Name can only 
login to one client application at a time), the User Name is not specified in the Server, or the 
password is incorrect.  

5. Click OK if you are finished configuring File Messenger. Otherwise click Apply before going 
to another tab. 

Note: If the connectivity test is unsuccessful, verify that your computer has a network 
connection and double-check the name or Internet address of the WirelessOffice 
Server. The login portion will fail if the service is already running (only one login 
per account is allowed at any one time). 
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� 7R�VHW�XS�3DJHDEOH�$OHUWV��
1. Click the Supervisor pull-down list box and select the person that should receive an alert 

message. This list contains users in the WirelessOffice Server database. 

2. Select the desired error condition(s) for which an alert should be sent.   

3. Click OK if you are finished configuring File Messenger. Otherwise click Apply before going 
to another tab. 

8VLQJ�WKH�$ERXW�7DE�

Use this tab to view the version number of File Messenger and to access general help for using File 
Messenger. Click the Help button in the lower-right corner to access the help file. 

8VLQJ�)LOH�0HVVHQJHU�

After configuring File Messenger, you can start using it.  However, you need to understand two 
things: 

• How to control File Messenger, and 

• How to create message files. 



Using File Messenger 

   109

&RQWUROOLQJ�)LOH�0HVVHQJHU�

File Messenger is a background service in Windows NT/2000.  Its operation is simple; while File 
Messenger is running, it monitors shared directories for message files and sends corresponding 
message requests to the WirelessOffice Server.  While File Messenger is stopped, it is removed 
from memory and performs no monitoring.  You will use the File Messenger control panel to start 
and stop the service. 

The File Messenger control panel operates independently of the File Messenger service.  When 
you click the OK button, the configuration control panel will close and the File Messenger service 
will remain in its current state (running or stopped). 

$XWRPDWLF�YV��0DQXDO�6WDUWXS�

If File Messenger is configured for Automatic Startup, the service starts automatically when the 
computer on which it is installed is started.  If File Messenger is configured for Manual Startup, 
you must use the File Messenger control panel to start it.  Refer to the section “To change the 
startup type” on page 106 for more information about startup types.  The WirelessOffice Server 
does not have to be running in order to start the File Messenger service. 

&UHDWLQJ�0HVVDJH�)LOHV�

WirelessOffice File Messenger allows proprietary or third party applications to send messages 
through the WirelessOffice Server.  Messages can be submitted to the WirelessOffice Server by 
creating an ASCII file in one or more specific directories on the File Messenger system.  These 
directories are specified during File Messenger configuration. See “Using the Directories Tab” on 
page 103 for instructions. Message files can be created in four different formats: 

• Simple file format 
• Confidential file format 
• Scheduled message format 
• Escalated message format 

 

Regardless of the format, message files must be created using the following rules:  

• All commands must be separated by a carriage return and line feed sequence. 
• Commands can appear in any order, however, the MESSAGE: command must be the last 

command in the file. 
• No spaces may be entered before or after the equal signs (=). 
 

Note: If enough information exists to send both simple and confidential messages, only the 
confidential message will be sent. 
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8VLQJ�WKH�6LPSOH�)LOH�)RUPDW�

The simple format is used to send a message to users, groups, or departments that are predefined in 
the WirelessOffice Server database and available to the User Name login account. It is called 
simple (or unresolved) because it is the easiest of the two formats to use. The simple format only 
requires that you specify the user’s name (or group/department name if applicable) and the text of 
the message. The WirelessOffice Server resolves the rest of the message addressing using 
information in its database. 

� 7R�XVH�WKH�6LPSOH�)LOH�)RUPDW��
 

ID=<Recipient Name> | TO=<Recipient Name> 
[ISGROUP=yes|no] 
[ISDEPT=yes|no] 
MESSAGE: 
<Text of the message> 

Where:  
ID or TO  Specifies the unique name for the single server-defined user, group or department that 
should receive the message.  The TO command is equivalent to the ID command.   

ISGROUP  Indicates whether the ID or TO command contains an identifier for a group 
(ISGROUP=YES) or a single message recipient (ISGROUP=NO) that is defined in the server 
database.  This command is optional; if you omit it, File Messenger assumes the ID or TO 
command contains a user name. 

ISDEPT  Indicates whether the ID or TO command contains an identifier for a department 
(ISDEPT=YES) or a single message recipient (ISDEPT=NO) that is defined in the server 
database.  This command is optional; if you omit it, File Messenger assumes the ID or TO 
command contains a user name. 

MESSAGE:  Indicates that the characters to follow are the content of the message. The message 
content can contain a maximum of 2000 characters. 

Examples: 

1. Send the message “We’re now using WirelessOffice!” to the user known as “Bob Jones”. 

ID=Bob Jones 
MESSAGE: 
We’re now using WirelessOffice!  
 
2. Send the message “Meet at noon” to the group known as “Lunch”. 

TO=Lunch 
ISGROUP=yes 
MESSAGE: 
Meet at noon 
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8VLQJ�WKH�&RQILGHQWLDO�)LOH�)RUPDW�

Use the confidential format when you want to send a message to a user who subscribes to a 
wireless carrier that is predefined in the system database. It is called confidential (or partially 
resolved) because it allows you to keep the user’s name confidential. It requires that you specify 
the user’s mobile device ID, carrier’s name and the message. The Server’s database resolves a 
portion of the message.  

� 7R�XVH�WKH�&RQILGHQWLDO�)LOH�)RUPDW��
 

PAGERID=<PIN> 
CARRIERID=<Carrier> 
MESSAGE: 
<Text of the message> 
 
 

Where: 

PAGERID  Specifies the unique identifier for the wireless device. 

CARRIERID or SERVICEID  Specifies the unique identifier for the carrier provider. 

MESSAGE:   Indicates that the line(s) to follow are the content of the message. The message 
content can contain a maximum of 2000 characters. 

 

Example: 

Send the message “This is WirelessOffice!” to PIN “1234567” using the “Metrocall” carrier. 

PAGERID=1234567 
CARRIERID=Metrocall 
MESSAGE: 
This is WirelessOffice! 
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6FKHGXOLQJ�0HVVDJHV�

� 7R�XVH�RSWLRQDO�VFKHGXOLQJ�FRPPDQGV��
Optional commands are available to both file formats to allow delayed messaging. Scheduled 
messages sent from File Messenger reside in WirelessOffice Administrator’s Scheduled Messages 
tab until delivery time and may be edited there if needed. Please see “Viewing Scheduled 
Messages” on page 60.  Messages can only be scheduled if the appropriate access rights have been 
configured for the user login account. 

Commands supported: 

TIME – Specifies the time of the message, in 24-hour notation. 

DATE - Specifies the date of the message. 

 

Format: 

TIME=<HHMMSS> 
DATE=<YYYYMMDD> 

 
 

Example: 

Send a reminder message to user “Bob Jones” on April 22, 2000 at 10:45:00 AM. 

ID=Bob Jones 
TIME=104500 
DATE=20000422 
MESSAGE: 
Board meeting at 11 AM in third floor conference room 
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(VFDODWLQJ�0HVVDJHV�

� 7R�XVH�RSWLRQDO�HVFDODWLRQ�FRPPDQGV��
Optional commands allow a message to escalate up to five levels. Escalated messages sent from 
File Messenger reside in WirelessOffice Administrator’s Escalated Messages tab until delivery 
time. You can cancel or manually accelerate an escalated message from within WirelessOffice 
Administrator, using E-mail Messenger’s two-way device response, using a cell/land phone via 
Voice Messenger or in Web Messenger. Please see “Viewing Escalated Messages” on page 61. 

Commands supported: 

ESCALATED — Indicates an escalated message will be configured if (ESCALATED=YES). If 
(ESCALATED=NO) no escalated message will be configured.  This field is required, with a YES 
value, to send an escalated message. 

REPEAT — Indicates an escalated message will repeat the last level until cancellation or it has run 
its course. Range is 0 to 255, where 0 will not repeat the last level and 255 will repeat infinitely. 
This field is optional and if not included 0 is assumed. 

LEVELx — Indicates the level number and recipient name. Level numbers (x) may range from 1 
to 5. The recipient name must reflect a server-defined user, group or department and be accessible 
to that User Name login account. The PIN/Carrier method is not allowed. Maximum character 
length is 50. This field is required for escalation. 

ISGROUP or ISDEPT — Include if the LEVELx recipient name is a group or department. 
Indicates whether the LEVELx command contains an identifier for a group or department 
(ISGROUP=YES or ISDEPT=YES) or a single message recipient (ISGROUP=NO or 
ISDEPT=NO) that is defined in the server database.  This command is optional if NO. This field is 
not required for escalation. 

DELAYx — Specifies the time delay in seconds for each level (x) defined with a recipient name. 
Range is 60 to 86400 seconds, with a default of 1800 (30 minutes) if no time delay is defined. This 
field is optional and not required for escalation. 

MESSAGE: — Indicates that the line(s) to follow are the content of the message. The message 
content can contain a maximum of 2000 characters. 

Example: Send a 2 level escalated alert, both with 5 minute delay times. First level recipient is 
John Smith. Second level recipient is the “Management” department. Last level repeats 3 times. 

ESCALATED=YES 
REPEAT=3 
LEVEL1=John Smith 
DELAY1=300 
LEVEL2=Management 
ISDEPT=YES 
DELAY2=300 
MESSAGE: 
Red Alert – need immediate assistance in room 232
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8VLQJ�(�PDLO�0HVVHQJHU�

E-mail Messenger, formerly named EPage, will automatically install when you select E-mail 
Messenger from the WirelessOffice installation. It will only function if your Authorization Code 
reflects an E-mail Messenger purchase or you are using the DEMO Authorization Code.  

E-mail Messenger allows you to interface your SMTP-compatible e-mail system with 
WirelessOffice so that e-mail can be sent as alphanumeric messages to wireless devices. 
Compatible software packages include Novell GroupWise, Microsoft Exchange and Outlook, 
Eudora Pro, Lotus Notes and many others. If configurable in your e-mail software, you can also 
arrange to have messages sent to your E-mail Messenger address alerting you when important e-
mails have arrived.  

Two-way messaging is possible as well, with E-mail Messenger receiving the message response 
and delivering it to the server. Escalated message cancellation is also possible using E-mail 
Messenger’s two-way messaging capabilities. 

The following diagram depicts the messaging flow through WirelessOffice Server to wireless 
device(s): 

 

Note: You can install E-mail Messenger on any network system running Windows 
NT/2000 (including the WirelessOffice Server), except for the system with your e-
mail server due to Internet Protocol (IP) port conflicts. Once E-mail Messenger is 
configured and a domain is established, any network system with SMTP e-mail 
software is compatible. 

 



WirelessOffice System Administrator Manual 

116 

�� +RZ�(�PDLO�0HVVHQJHU�ZRUNV��
E-mail Messenger is an SMTP gateway that receives SMTP mail messages and forwards them to 
the WirelessOffice Server. The following outlines the process more specifically:  

1. The SMTP message originates from a proprietary e-mail package. 

2. E-mail Messenger receives the entire SMTP message, whether it comes from the e-mail server 
or from a wireless carrier (two-way response).  

3. E-mail Messenger extracts the recipient(s) and message data and passes the message on to the 
WirelessOffice Server, where the system either sends the message to the carrier or logs the 
two-way response. 

1HZ�(�PDLO�0HVVHQJHU�)HDWXUHV�

• User Name/Password authentication for E-mail Messenger configuration (page 119) 
• Two-way message acknowledgement via E-mail Messenger (page 124) 
• Escalated message cancellation and escalation (page 125) 
• Department message sending 
• Security profiling 
• Windows 2000 compatibility 

6WDQGDUG�(�PDLO�0HVVHQJHU�)HDWXUHV�

• Runs as a Windows NT/2000 service 
• Integrates with all SMTP-compatible e-mail software 
• Message alerting, message sending and message forwarding capabilities 
• Message logging 
• Paging domain specification enables only E-mail Messenger addresses to be sent to server 
• Failover domain specification enables troubled messages to be sent to backup domain address 
• Auto-handling of blank spaces and lines 
• Various addressing formats 
• Option to include subject field, signature field and attachment notification 

&RQILJXULQJ�(�PDLO�0HVVHQJHU�

You must configure E-mail Messenger before you can use its services.  At a minimum, E-mail 
Messenger must know where on the network to find the WirelessOffice Server (by its Internet 
address or name). There are other configurable options available as well. 

� 7R�FRQILJXUH�(�PDLO�0HVVHQJHU��
1. Click Start, point to Settings, select Control Panel and then E-mail Messenger. 

2. Or click Start, point to Programs, select Emergin WirelessOffice then E-mail Messenger.  
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The E-mail Messenger control panel Service tab displays:  

3. Use the tabs along the top of the E-mail Messenger control panel to access various 
configuration options. 

The E-mail Messenger control panel tabs are briefly described. To access these options, click on 
the desired tab. 

Tab Description 

Service Use this tab to start or stop the E-mail Messenger service or to specify E-mail 
Messenger’s startup behavior. 

WirelessOffice Use this tab to login, specify the Internet address or name of the WirelessOffice 
Server, test connectivity, specify what options should be sent when E-mail 
Messenger is processing messages, enable/disable logging and specify failover 
and paging domains. 

About This tab shows you the current version of E-mail Messenger and provides access 
to general help about using the service. 

&KDQJLQJ�WKH�$XWKRUL]DWLRQ�&RGH�

If you did not purchase E-mail Messenger with your initial copy of WirelessOffice, you will need 
to enter a new Authorization Code into WirelessOffice Administrator to enable E-mail Messenger. 
If the WirelessOffice system is currently running under the DEMO Authorization Code, the 
software will only function for a limited period of time. At the end of this trial period, you will see 
the following message when you attempt to connect to the Server through the E-mail Messenger 
control panel: 

E-mail Messenger cannot start because it is not registered. 
Please contact Emergin at 1-888-922-7638 or 1-561-361-6990. 

To re-enable E-mail Messenger, you must have a valid Authorization Code. When you purchase 
the product, you will be given an Authorization Code that will fully enable the software. Enter this 
new Authorization Code into the WirelessOffice Server using the WirelessOffice Administrator. 
Please see “Modifying Server Configuration” in the Configuring WirelessOffice Server chapter. 
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8VLQJ�WKH�6HUYLFH�7DE�

Use the Service tab to start or stop the E-mail Messenger service.  You can also use this tab to 
specify E-mail Messenger’s startup behavior.  For example, you can specify that E-mail Messenger 
automatically starts when the computer it is loaded on starts (for unattended operation), or you can 
specify that starting and stopping E-mail Messenger be controlled manually.  

�� � 7R�VWDUW�RU�VWRS�(�PDLO�0HVVHQJHU��

1. Click on the appropriate button:  to start, or   to stop. 

2. Click OK if you are finished configuring E-mail Messenger.  Otherwise click Apply before 
going to another tab.  

Note: E-mail Messenger is a background service in Windows NT/2000.  If you click OK 
while E-mail Messenger is running, the configuration control panel is closed, but 
the service remains loaded and running.  When you stop E-mail Messenger, the 
service stops running.   

� 7R�FKDQJH�WKH�VWDUWXS�W\SH��
1. Click on Automatic, Manual or Disabled. 

2. Click Apply if you are not finished configuring E-mail Messenger.  Otherwise, click OK.  
The change will take effect next time the computer is restarted. 



Using E-mail Messenger 

   119

8VLQJ�WKH�:LUHOHVV2IILFH�7DE�

Use this tab to login, specify the name or Internet address of the WirelessOffice Server, test 
connectivity with the server, specify what e-mail options should be sent while E-mail Messenger is 
processing messages, enable/disable logging, and specify the failover and paging domains.  

� 7R�ORJLQ�DQG�VSHFLI\�WKH�VHUYHU�DGGUHVV��
1. Click the WirelessOffice tab. Type your User Name and Password (1-20 characters in 

length) to login to the server. You can login to only one client application at a time with your 
login identity. If you are using the ‘Administrator’ account, you will need to create a new user 
login account with the appropriate security settings and rights for E-mail Messenger.  

2. Type the name or Internet address of the WirelessOffice Server in the Server text box. The 
Server name is preferred as it is more static than an IP address. 

3. Click the Test Connectivity button to ensure that E-mail Messenger can communicate with 
the WirelessOffice Server. If Last Connect Attempt and Last Login Attempt both display 
OK, then the test was successful. 

4. Any errors will be displayed as a message. Server Status indicates whether the connection to 
the WirelessOffice Server was successful or not. To locate the correct Server name, open the 
WirelessOffice Administrator and click File and then Change Server. If the server 
connection is not made, Login Status will be blank. Login Status indicates any login 
connection errors, such as the User Name is already logged in to the Server (each User Name 
can only login to one client application at a time), the User Name is not specified in the 
Server, or the password is incorrect.  

Note: If the connectivity test is unsuccessful, verify that your computer has a network 
connection and double-check the name or Internet address of the WirelessOffice 
Server. The login portion will fail if the service is already running (only one login 
per account is allowed at any one time). 
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� 7R�VHW�XS�0HVVDJH�2SWLRQV��
1. Select Subject field should be included if you want the recipient to see the subject of the e-

mail (in the device message). 

2. Select Signature field should be included if you want the recipient to see the signature of the 
person who sent the e-mail (in the device message).   

3. Select Attachment notification if you want the recipient to be notified that the e-mail sent 
had an attachment (in the device message). The attachment itself will not be sent. 

� 7R�HQDEOH�ORJJLQJ��
1. In the Logging area, click On to create E-mail Messenger log files when troubleshooting is 

required for incoming e-mail messages.  Enable logging only for diagnostic purposes. 

2. Three files are generated for troubleshooting incoming e-mail.  These files are located in the 
c:\winnt directory: 

• Emsgr.log – log file that details transactions with E-mail Messenger, for example, 
connections to the WirelessOffice Server, valid recipients, etc. 

• Emsgrxxx.log – log file that details incoming SMTP communication with E-mail 
Messenger, where xxx increments are 001, 002, etc. 

• Intmail.log – log file that details the transactions for e-mail failover. 

� 7R�GHVLJQDWH�DQ�H�PDLO�IDLORYHU�GRPDLQ��
The E-mail failover domain is an internal/external e-mail server running in a corporate intranet 
and is set up to auto-reply to messages that cannot connect to the WirelessOffice Server or cannot 
resolve a user/group/department in the server.  This will notify the recipient that an error occurred. 

� 7R�GHVLJQDWH�DQ�H�PDLO�SDJLQJ�GRPDLQ��
When forwarding an e-mail to a recipient, it often includes multiple recipients from other domains.  
In order to prevent each member from receiving a message, it is possible to set up a filtering 
domain.  For example, if the E-mail Messenger domain is set up as wireless.domain.com, then the 
system administrator should set up the E-mail paging domain as wireless.domain.com.   

If e-mail contains multiple recipients, only those with destination domain wireless.domain.com 
will receive the forwarding e-mail to WirelessOffice Server.  If the e-mail paging domain is blank, 
then all recipients from all domains will be passed through to the WirelessOffice Server.  These 
recipients must be set up in WirelessOffice Administrator in order to receive a message to their 
mobile device. 
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Example of an Addressee list: 

john.doe@wireless.domain.com; sallie.johnson@domain.com; michelle.tenor@domain.com 

If the e-mail paging domain is set up with wireless.domain.com, then only john.doe will be 
forwarded to the WirelessOffice Server.  If the e-mail paging domain is blank, then E-mail 
Messenger will attempt to send a message to all recipients.  This e-mail usually results from 
forwarding because it will contain the original recipients of the message e-mail failover domain. 

8VLQJ�WKH�$ERXW�7DE�

Use the About tab to view the version number of E-mail Messenger. Click the Help button in the 
lower-right corner to access the help file.  

&RQWUROOLQJ�(�PDLO�0HVVHQJHU�

E-mail Messenger is a background service in Windows NT/2000.  Its operation is simple; while it 
is running, it accepts SMTP e-mail and sends corresponding message requests to the 
WirelessOffice Server.  While E-mail Messenger is stopped, it is removed from memory and 
performs no service.  You will use the E-mail Messenger control panel to start and stop the service.  
See “To start or stop E-mail Messenger” on page 118 for instructions. 

The E-mail Messenger control panel operates independently of the E-mail Messenger service.  
When you click OK, the configuration control panel will close and the E-mail Messenger service 
will remain in its current state (running or stopped). 
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$XWRPDWLF�YV��0DQXDO�6WDUWXS�

If E-mail Messenger is configured for Automatic Startup, the service starts automatically when the 
computer on which it is installed is started.  If E-mail Messenger is configured for Manual 
Startup, you must use the E-mail Messenger control panel to start it.  See “To change the startup 
type” on page 118 for more information about Startup Types.  The WirelessOffice Server need not 
be running in order to start the E-mail Messenger service.  

&RQILJXULQJ�<RXU�(�PDLO�0HVVDJLQJ�*DWHZD\�

E-mail Messenger is designed to interface with any e-mail system that is capable of outputting 
SMTP-compatible messages.  

� 7R�VHW�XS�D�GRPDLQ��
1. A domain name for the messaging gateway (i.e. wireless.domain.com) must be mapped to the 

Internet address of the E-mail Messenger workstation.  

2. Contact your IT Department to add the new domain record to your central DNS server. 

3. Verify that the domain is connected. Click Start from the taskbar, select Programs then 
Command Prompt and type: c:\ping wireless.domain.com, where 
wireless.domain.com is the newly configured domain name.  

4. The following reply (listed four times) should display, where 100.10.10.10 is the sample 
Internet address of the computer running E-mail Messenger (wireless.domain.com): Reply 
from 100.10.10.10: bytes=32 time<10ms TTL=128. 

5. If a negative response of bad IP address returns, confirm that your IT Department has added 
the DNS record correctly. 

Note: To receive external E-mail Messenger requests and for two-way functionality, E-mail 
Messenger must be accessible from the Internet and not behind a firewall. 

Messages can be sent from wireless devices into WirelessOffice if sent as an e-mail, 
addressed to a server-defined recipient. 

6HQGLQJ�D�7HVW�0HVVDJH�

� 7R�VHQG�D�WHVW�PHVVDJH��
1. Send a message as you normally would from your e-mail software using the “Addressing 

Rules” listed on the next page.  

2. The user name must be pre-configured in WirelessOffice Administrator. Refer to “Managing 
Users and Devices” in the Configuring WirelessOffice Server chapter. 

3. Confirm that the e-mail message you sent is in the WirelessOffice Administrator’s Message 
Log or is received by the recipient’s wireless device.  
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0HVVDJH�&RQVLGHUDWLRQV�

�� (�PDLO�PRQLWRULQJ�DQG�DOHUWLQJ�
If available, you can set up your e-mail software to send alerts to your E-mail Messenger address 
when important messages come in. For example, using the Rules Wizard in Microsoft Outlook it 
can search messages by sender, urgency or key words. 

�� 0D[LPXP�PHVVDJH�VL]H�
E-mail Messenger supports messages up to 2048 characters (or 2K in byte size). 

�� +DQGOH�EODQN�VSDFHV�
Some e-mail packages pad messages with blank lines or prefix messages with blank spaces.  
Because airtime is costly, E-mail Messenger handles these conditions by extracting blank spaces. 

$GGUHVVLQJ�5XOHV�

• Host names do not include blanks. Recipients can be server-defined users, groups or 
departments (depending on security access of the login User Name account).  

• For a server-defined user name such as Jane Benedict, type Jane_Benedict to conform to 
e-mail addressing standards. 

• When the first address character is numeric, the system assumes “PIN.carrier”/“PIN” format. 
Carrier must be defined in the server. 

• When the first character of the address is alpha, the system assumes that the user’s name will 
be resolved in the WirelessOffice database. 

• If you have a carrier set up in WirelessOffice with the name “InHouse”, you can send e-mail 
to PIN@wireless.domain.com and the server will automatically use the “InHouse” carrier. 

6DPSOH�$GGUHVV�)RUPDWV�

Address Format Description 

1234567.Skytel@wireless.domain.com Send message to PIN 1234567 on Skytel carrier 

john.smith@wireless.domain.com Send message to mobile device for John.Smith, who is 
resolved in WirelessOffice Server database 

john_smith@wireless.domain.com Send message to mobile device of server-defined user 
John Smith. 

john.smith@domain.com Send e-mail to john.smith’s corporate e-mail account 

marketing@wireless.domain.com Send message to marketing users’ wireless devices 

2345678@wireless.domain.com Send message to PIN 2345678 using “InHouse” carrier 
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7ZR�:D\�0HVVDJLQJ�

E-mail Messenger offers two-way messaging support via your two-way pager or wireless PDA 
device. For a user to respond to a WirelessOffice message, they must have their two-way device 
defined in their user’s device properties dialog and have Enable responses selected. Please see 
“Adding User Devices” in the Configuring WirelessOffice Server chapter. 

A message sent to a user’s two-way capable device (that has Enable responses selected) will 
include a message identification number that is required when the user responds to the message. 
This enables WirelessOffice to correctly connect the response to the original message.  

Two-way messaging can also acknowledge escalated messages and send commands for canceling 
or escalating a message. Message ID and Escalation ID are required. Please see “Cancellation and 
Escalation” on page 125. 

The following diagram depicts the two-way flow of a message sent in WirelessOffice Messenger: 

1. Create message in WirelessOffice Messenger addressed to Jane Doe, who has a two-way device 
configured with an SMTP carrier and “Enable Responses” selected. 

2. WirelessOffice dispatches message. E-mail Messenger cannot be on same computer as corporate e-
mail server. (SMTP tab in Server Configuration should have Server name: mail.domain.com, Sender 
ID: reply@mail.domain.com.) 

3. Message sends through corporate e-mail system to carrier to a two-way device. Firewall port is open. 

4. Message received. User replies with response or escalation command. Embedded Message ID 
<<1:5>> links response to original message. 

5. Response message returns via carrier to Internet to E-mail Messenger. Firewall port is open. 

6. Message is parsed by E-mail Messenger and sent to WirelessOffice Server. 

7. Message is viewed in WirelessOffice Messenger’s Message Log or can display as a pop-up dialog 
upon arrival. Message is also viewable in WirelessOffice Administrator’s Message Log. 

Note: For two-way messaging to occur, the wireless carrier implemented by the wireless 
device user must be able to handle e-mail responses. Two-way messaging responses 
need a WirelessOffice Message ID in order for the response to be correctly linked to 
the original message. 
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9LHZLQJ�7ZR�:D\�0HVVDJH�5HSOLHV�

Two-way message replies can be viewed in WirelessOffice Administrator’s Message Log. You can 
also configure WirelessOffice Administrator or WirelessOffice Messenger to display a pop-up 
dialog whenever a two-way message response is received. Please see “Message Options” in the 
Configuring WirelessOffice Server chapter. For information about associating sounds to message 
responses in WirelessOffice Administrator, please see “Sound Events” in the same chapter. 

The WirelessOffice Administrator Message Reply pop-up dialog displays for two-way message 
responses when enabled (depicting a RIM BlackBerry response): 

Note: In the Message Log or Message Reply dialog, the response is listed first, followed 
by the original message. The message ID <<20:7>> allows WirelessOffice to match 
the response to the Message Log entry number (20) and the unique device number 
(7). On the device, the Message ID displays at the beginning or end of the message. 

&DQFHOODWLRQ�DQG�(VFDODWLRQ�

E-mail Messenger can cancel and “escalate” escalated messages that were created in Alarm 
Messenger, File Messenger or Command Messenger using two-way messaging. 

�� &RPPDQG�)RUPDW�IRU�&DQFHOODWLRQ�DQG�(VFDODWLRQ�
The e-mail message must contain the Message ID and the Escalation ID. The Message ID must be 
prefixed by ID:, e.g. ID:109. If you select Reply/Reply with text, the IDs will automatically be 
included in the message.  

The following commands are supported and may be placed anywhere in the e-mail body: 

Command Action 

*ACKY Acknowledge and cancel escalated message. Notify 
previous recipients. Notify previous recipients will 
send a cancellation notification and details the user 
that cancelled the message. 

*ACK or *ACKN Acknowledge and cancel escalated message. Do not 
notify previous recipients. 

*NAK Escalate message to next recipient level. All following 
levels will be rescheduled for the current time plus the 
originally defined Time Interval. 

Commands are NOT case sensitive. 
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5HVSRQGLQJ�ZLWK�7ZR�:D\�'HYLFHV�

Two-way pagers and wireless hand-held devices, such as Motorola’s Page Writer 2000™, 
Research In Motion’s (RIM) BlackBerry™ and Palm Incorporated’s Palm VII™ are able to send 
responses to E-mail Messenger messages sent through the WirelessOffice Server. Response 
requirements differ from device to device. The following instructions are for example purposes 
only and reflect the third-party devices at time of publication. Refer to the device’s manual for 
further information if needed. 

 

Motorola Page Writer 2000 response instructions: 

Note: To reply to messages or use escalation commands, Enable responses must be 
selected in the user’s device properties. 

 

1. To respond to a WirelessOffice message, select Reply. 

2. Select Custom Message. Type the response message or for an escalated message response, 
type one of the four message commands (*ACKY, *ACKN, *ACK, *NAK). 

3. Select Send. 

4. Responses will display in WirelessOffice Administrator’s Message Log, as well as in the 
originating message application’s Message Log. 

A WirelessOffice Administrator Message Reply pop-up dialog from a Motorola Page Writer 
2000 device: 

RIM BlackBerry response instructions: 

1. To respond to a WirelessOffice message, press the roller wheel and select Reply with text. 

2. Type the response message or for an escalated message response, type one of the four 
message commands (*ACKY, *ACKN, *ACK, *NAK). 

3. Press the roller wheel and select Send message. 

4. The message reply will display in WirelessOffice Administrator’s Message Log, as well as in 
the originating message application’s Message Log 
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8VLQJ�:HE�0HVVHQJHU�²�3OXV�

Web Messenger – Plus, formerly called JPage, will automatically install when you select Web 
Messenger from the WirelessOffice installation. It will only function if your Authorization Code 
reflects a Web Messenger purchase or within the 45-day time trial period if using the DEMO 
Authorization Code. This section provides you with configuration and operating considerations. 

Web Messenger provides effortless, messaging capabilities from any Java-capable Internet 
browser.  Once you install and configure Web Messenger, your entire organization will benefit 
from the convenience of accessing a global address book of users, groups and departments via the 
Web. Web Messenger supports resolved and unresolved users, which allows your organization to 
send messages to personnel defined in the WirelessOffice Server, or send messages to undefined 
users by PIN and carrier. Web Messenger includes a real-time personal message log, as well as 
escalated message options to cancel or escalate.  

The following figure illustrates how a Web Messenger system works: 

 

Note: Install Web Messenger on your Web server computer, which can be any network 
system running Windows NT/2000 (including the WirelessOffice Server). All 
WirelessOffice components may be loaded on this system if desired. Then configure 
the Web Messenger control panel and review your Web server software ensuring 
that Web Messenger is properly integrated. After configuring your Web server as 
well as WirelessOffice Administrator, any system with an Internet browser will be 
able to access Web Messenger. 
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1HZ�:HE�0HVVHQJHU�²�3OXV�)HDWXUHV�

• User Name/Password authentication for server connection (page 135) 
• Escalated message cancellation and escalation (page 137) 
• Option to globally disable Escalation tab (page 131) 
• Logging enable/disable (page 131) 
• Send messages to departments 
• Security profiling 
• Windows 2000 compatibility 

6WDQGDUG�:HE�0HVVHQJHU�²�3OXV�)HDWXUHV�

• Compatible with any Java-capable Internet browser 
• Real-time personal Message Log 
• Send messages to individual users and groups 
• Send messages using PIN and server-defined carrier 
• Option to globally disable public address book accessibility 
• Runs as a Windows NT/2000 service 

&RQILJXULQJ�:HE�0HVVHQJHU�

You must configure Web Messenger before you can use its services.  At a minimum, Web 
Messenger must know where on the network to find the WirelessOffice Server (by its name or 
Internet address) and the service must be started.  There are other configurable options available as 
well.  To configure Web Messenger, you must be logged on as the operating system administrator. 

� 7R�FRQILJXUH�:HE�0HVVHQJHU��
1. Click Start, point to Settings, select Control Panel then Web Messenger.  Or click Start, 

point to Programs, select Emergin WirelessOffice then Web Messenger.  

The Web Messenger Service tab displays: 

2. Use the tabs along the top edge of the Web Messenger control panel to access various 
configuration options. 
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The Web Messenger tabs are briefly described below: 

Tab Description 

Service Use this tab to start or stop the Web Messenger service and to specify Web 
Messenger’s startup behavior. 

WirelessOffice Use this tab to specify the name or Internet address of the WirelessOffice 
Server, to specify if the public address book is on/off to Web clients, to allow 
escalated message cancellation/escalation, and to enable/disable logging. 

About This tab shows you the current version of Web Messenger and provides 
access to general help about using the service. 

 

Note: Certain configuration changes require that Web Messenger be restarted before your 
changes will take effect.  When you make such a change, you will receive a warning 
message.  If the message warns you that the service must be restarted, it means you 
must stop Web Messenger and restart it. Please see “To start or stop Web 
Messenger” on page 130.  To simplify things, you should stop Web Messenger before 
making configuration changes. 
 

&KDQJLQJ�WKH�$XWKRUL]DWLRQ�&RGH�

If you did not purchase Web Messenger – Plus with your initial copy of WirelessOffice, you will 
need to enter a new Authorization Code into WirelessOffice Administrator to enable Web 
Messenger. If the WirelessOffice system and Web Messenger are currently running under the 
DEMO Authorization Code, the software will only function for a limited period of time. At the end 
of this trial period, you will see the following message when you attempt to connect to the Server 
through the Web Messenger control panel: 

Web Messenger cannot start because it is not registered. 
Please contact Emergin at 1-888-922-7638 or 1-561-361-6990. 

To re-enable Web Messenger, you must have a valid Authorization Code. When you purchase the 
product, you will be given an Authorization Code that will fully enable the software. Enter this 
new Authorization Code into the WirelessOffice Server using the WirelessOffice Administrator. 
Please see the “Modifying Server Configuration” chapter in the WirelessOffice System 
Administrator Manual. 
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8VLQJ�WKH�6HUYLFH�7DE�

Use the Service tab to start or stop the Web Messenger service.  You can also use this tab to 
specify Web Messenger’s startup behavior.  For example, you can specify that Web Messenger 
will automatically start when the computer it is loaded on starts (for unattended operation) or you 
can specify that starting and stopping Web Messenger be controlled manually.  

� 7R�VWDUW�RU�VWRS�:HE�0HVVHQJHU��

1. Click the appropriate button:  to start or  to stop. 

2. Click OK if you are finished configuring Web Messenger. Otherwise click Apply before 
going to another tab. 

Note: Web Messenger is a background service in Windows NT/2000.  If you click OK 
while Web Messenger is running, the configuration control panel is closed, but the 
service remains loaded and running.  When you stop Web Messenger, the service 
stops running.   

 

� 7R�FKDQJH�WKH�VWDUWXS�W\SH��
1. Select Automatic, Manual or Disabled. Manual is the default setting, but Automatic is 

recommended. 

2. Click Apply if you are not finished using the configuration control panel.  Otherwise, click 
OK.  The change will not take effect until the computer is restarted. 
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8VLQJ�WKH�:LUHOHVV2IILFH�7DE�

Use this tab to specify the name or Internet address of the WirelessOffice Server, test server 
connectivity, to specify public address book and escalation tab availability, and to control logging. 

�� � 7R�VSHFLI\�WKH�VHUYHU�DGGUHVV��
1. Click the WirelessOffice tab. Type the Name or IP Address of the WirelessOffice Server 

computer in the text box. The Server name is preferred as it is more static than an IP address. 

2. Click the Test Connectivity button to ensure that Web Messenger can communicate with 
WirelessOffice Server.  

Note: If the connectivity test is unsuccessful, verify that your computer has a network 
connection and double-check the name or Internet address of the WirelessOffice 
Server.  

� 7R�GLVSOD\�WKH�SXEOLF�DGGUHVV�ERRN�RU�HVFDODWLRQ�WDE��
3. Select Display public address book to web clients if Web Messenger users should have 

access to the main address book. See “Public Address Book Availability” on page 135. 

4. Select Display escalation tab in web clients if Web Messenger users should have access to 
the Escalation tab in order to cancel or “escalate” messages using an Escalation ID. See 
“Using the Escalation Tab” on page 137.  

5. Click OK if you are finished using the Web Messenger control panel.  Otherwise click Apply 
before going to another tab. 

Note: The public address book will only display users, groups and departments that are 
accessible to the logged in user. 

� 7R�HQDEOH�ORJJLQJ��
1. Select Enabled to start Web Messenger logging. The log is located in c:\winnt\webmsgr.log. 

2. Only enable logging for diagnostic purposes. 



WirelessOffice System Administrator Manual 

132 

8VLQJ�WKH�$ERXW�7DE�

Use this tab to view the current version number of Web Messenger.  Click the Help button in the 
lower-right corner to access the help file.  

8VLQJ�:HE�0HVVHQJHU�

After configuring Web Messenger, you can start using it.  However, you need to understand two 
things: 

• How to control Web Messenger, and 

• How to setup Web Messenger. 

&RQWUROOLQJ�:HE�0HVVHQJHU�

Web Messenger is a background service in Windows NT/2000. Its operation is simple; while it is 
running, it allows users to send messages to the WirelessOffice Server via an Internet browser.  
While Web Messenger is stopped, it is removed from memory and performs no service.  You will 
use the Web Messenger control panel to start and stop the service.  See “To start or stop Web 
Messenger” on page 130. 

The application control panel operates independently of the Web Messenger service.  When you 
click OK, the configuration control panel will close and the Web Messenger service will remain in 
its current state (running or stopped). 

�� $XWRPDWLF�YV��0DQXDO�6WDUWXS�
If Web Messenger is configured for Automatic Startup, the service starts automatically when the 
computer on which it is installed is started.  If configured for Manual Startup, you must use the 
Web Messenger control panel to start it.  The WirelessOffice Server does not need to be running in 
order to start the service.  
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:HE�6HUYHU�6HWXS�

Once Web Messenger is setup, your Web server will need to be properly configured for the 
application to run correctly. Loading and set up of a Web server (e.g. Microsoft Internet 
Information Server, Netscape Enterprise Server or Microsoft Personal Web Server) may be 
required if it is not already in place. If you are using Microsoft Internet Explorer V5.0 or greater, 
you are required to install Java Virtual Machine. 

You can install Web Messenger in a virtual directory of your existing Web site or as a Web site 
home page.  

Note: If you will be running Web Messenger through a firewall, be sure your company 
firewall supports Java before loading Java Virtual Machine. 

� 7R�VHW�XS�0LFURVRIW�,QWHUQHW�,QIRUPDWLRQ�6HUYHU������IRU�:LQGRZV�17�6HUYHU�V\VWHPV���
For more information about configuring the Web server software, refer to their on-line help. These 
steps reflect a Windows NT 4.0 configuration at the time of publication. Steps may vary for 
Windows 2000 configurations. 

1. Load Windows NT 4.0 Option Pack (if not already installed). It can be downloaded at 
www.microsoft.com/ntserver/nts/downloads/recommended/NT4OptPk/default.asp. 

2. Click Start, point to Programs, select Windows NT 4.0 Option Pack, then Microsoft 
Internet Information Server. Click Internet Service Manager. 

To add a new virtual directory: 

3. Navigate in the Tree View to your Web site, e.g. domain.com. Right-click and select New and 
then Virtual Directory. The New Virtual Directory Wizard dialog displays. 

4. Type the alias name to access Web Messenger, e.g. webmsgr. Click Next. 

5. Click Browse and select c:\inetpub\wwwroot\webmsgr. Click Next.  

6. Select all permissions except write access. Click Finish. 

7. In the Tree View, right-click the newly created virtual directory. Select Properties.  

8. Click the Documents tab. Click Add to select the default document. Type index.htm. 
Click OK and exit the Internet Service Manager. 

To set up as a home page: 

9. Navigate in the Tree View to the Web site, e.g. domain.com or create a new Web site by right-
clicking in the Tree View and selecting New and then Site. 

10. Right-click the Web site name and select Properties. 

11. Click the Home Directory tab and click Browse. Select c:\inetpub\wwwroot\webmsgr. Select 
read, directory browsing allowed and execute (listed in the Application Settings area). 

12. Click the Documents tab. Click Add to select the default document. Type index.htm. 
Click OK and exit the Internet Service Manager. 
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� 7R�VHW�XS�0LFURVRIW�3HUVRQDO�:HE�6HUYHU������IRU�:LQGRZV�17�:RUNVWDWLRQ�V\VWHPV���
For more information about configuring the Web server software, refer to their on-line help. These 
steps reflect a Windows NT 4.0 configuration at the time of publication. Steps may vary for 
Windows 2000 configurations. 

1. Load Windows NT 4.0 Option Pack (if not already installed). It can be downloaded at 
www.microsoft.com/ntserver/nts/downloads/recommended/NT4OptPk/default.asp. 

2. Click Start, point to Programs, Windows NT 4.0 Options Pack then Microsoft Personal 
Web Server. Click Personal Web Manager. 

To add a new virtual directory: 

3. Click Advanced and select Add. Click Browse to select c:\inetpub\wwwroot\webmsgr as 
your Home Directory. Type webmsgr as the alias name. All Access options should be 
selected. Click OK. 

4. Select Enable Default Document. In the Default Document text box, type index.htm. 
Select Allow Directory Browsing. 

To set up as a home page: 

5. Click Advanced and select Add. Set up your Home Page. Click Browse to select 
c:\inetpub\wwwroot\webmsgr as your Home Directory. All Access options should be 
selected. Click OK. 

6. Select Enable Default Document. In the Default Document text box, type index.htm. 
Select Allow Directory Browsing. Exit the Personal Web Server. 

2SHQ�DQG�/RJLQ�WR�:HE�0HVVHQJHU�

� 7R�RSHQ�:HE�0HVVHQJHU��
1. For virtual directory configurations, open your Web browser and access Web Messenger by 

typing your company Web site address with Web Messenger as a directory, e.g. 
www.domain.com/webmsgr. 

2. For new home page configurations, open your Web browser and access Web Messenger by 
typing the newly configured Web page name. For example, http://webmessenger. 

3. If the Web Messenger application does not come up, but a blank screen does, this indicates 
that Java Virtual Machine must be loaded as well. This application may be downloaded at 
www.microsoft.com/java. 
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�� � 7R�ORJLQ�WR�:HE�0HVVHQJHU��
Each login account must be unique and users may only login to one client application at any given 
time. Create new user accounts with appropriate security settings as needed. 

1. On the Login tab, type your User Name and Password. Click Login. 

2. The Compose tab will then open for message sending.  

3XEOLF�$GGUHVV�%RRN�$YDLODELOLW\�

� 7R�DFFHVV�WKH�3XEOLF�$GGUHVV�%RRN��
1. If Display public address book to web clients is checked in the Web Messenger control 

panel WirelessOffice tab, end users will have the ability to see recipients defined in the 
WirelessOffice database. 

The Public Address Book displays all users, groups and departments accessible to the User 
Name login account’s security access and rights: 

Note: If you cannot see all address book recipients and it seems like the downward 
scroll arrow is not working, select a recipient name and press the Page Up or 
Page Down keys on your keyboard. Also use the DOWN ARROW key.  

 

2. If Display public address book to web clients is not checked in the Web Messenger control 
panel, the Web Messenger end-user will not have the ability to see recipients in the 
WirelessOffice database.  Rather, they will be required to use the Custom Address format, 
which uses a PIN number and a server-defined carrier in order to send a message.  
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6HQGLQJ�D�0HVVDJH�

From the Web Messenger applet, you can send messages via the WirelessOffice Server.  

� 7R�VHQG�D�PHVVDJH���
1. With Public Address Book accessibility, click and highlight the desired recipients and select 

the >> button to include as a Recipient. You can also double-click a name to add it. 

2. To address a message using PIN and carrier information, select Custom Address from the 
address book drop-down list. 

3. Type the PIN number and select the server-defined Carrier. Click the  >> button to include 
the PIN/Carrier address as a Recipient. Add more custom PIN numbers and carriers if 
desired. 

4. Type your message in the Message text box (1024 character maximum). To send, click 
Submit Message. The message will be queued in WirelessOffice Server and shown in 
WirelessOffice Administrator’s Message Log and the Web Messenger Message Log tab.  

5. Click the Message Log tab. Click the Refresh button to update the view. 

8VLQJ�WKH�0HVVDJH�/RJ�7DE�

Select the Message Log tab to view all messages sent from Web Messenger using your User Name 
login account. Click Refresh to update the view. Each message entry details message status, 
submittal time and date, sender, recipient, message status description, and the message text. 
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8VLQJ�WKH�(VFDODWLRQ�7DE�

To use the Escalation tab, the Web Messenger configuration control panel must have Display 
escalation tab in web clients selected on the WirelessOffice tab. To cancel or “escalate” an 
escalated message, you must know the Escalation ID number. Escalated messages can be sent from 
Alarm Messenger, File Messenger and Command Messenger.  

&DQFHOOLQJ�DQG�(VFDODWLQJ�0HVVDJHV�

1. Click the Escalation tab. 

2. Type the Escalation ID number. This numbers appears in your wireless device message as 
ID: 1049, for example. 

3. Select Cancel to cancel the message. No previous escalated message recipients will be 
notified about the cancellation. 

4. Select Cancel (Notify all previous Recipients) to cancel the escalated message as well as 
notify current and previous recipients. A cancellation notification message details the user that 
cancelled the message. 

5. Select Escalate to immediately advance the message to the next recipient level. All following 
levels will be rescheduled for the current time plus the originally defined time interval. 

6. Click Submit to send the request. View the escalated message status in WirelessOffice 
Administrator’s Escalated Messages tab.
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8VLQJ�9RLFH�0HVVHQJHU�

Voice Messenger will automatically install when you select Voice Messenger from the 
WirelessOffice installation. It will only function if your Authorization Code reflects a Voice 
Messenger purchase or you are using the DEMO Authorization Code. 

Voice Messenger provides escalated message acknowledgment from any cell phone or telephone 
using IVR (Interactive Voice Response) technology. Escalated messages originate in Command 
Messenger, Alarm Messenger and File Messenger. The caller simply dials the phone number to the 
Voice Messenger modem, logs in and can then cancel or advance as many escalated messages as 
required. To cancel or advance an escalated message, the user must enter the Escalation ID 
number, which is included in the escalated message received on their wireless device.  

The following step-by-step figure illustrates how a Voice Messenger system works: 

 

1. Escalated message is received on wireless device. Escalation ID is part of message, e.g. ID:1409. 

2. Respond to escalation using a cell phone or telephone. 

3. Dial the dedicated modem phone number that accesses the Voice Messenger computer. 

4. Type your Full WirelessOffice Name, Password and the Escalation ID number. Then cancel or 
advance an escalated message. If cancelling a message, you can opt to notify previous escalation 
recipients. 

5. Information is relayed to the WirelessOffice Server, where the desired action occurs. Escalated 
message status is viewed in WirelessOffice Administrator and Alarm Messenger. 

Note: Install Voice Messenger on any networked computer running Windows 2000 
Server or Professional (including the WirelessOffice Server or other 
WirelessOffice application systems).  
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9RLFH�0HVVHQJHU�)HDWXUHV�

• Escalated message acknowledgment (cancellation and immediate advancement) 
• User Name/Password security authentication for call-in access (option to disable) and server 

connection 
• Escalated message cancellation can optionally notify all previous recipients 
• Multiple escalation functions allowed per single call 
• Logging enable/disable 
• Ability to use your own voice recordings 
• Adjustable IVR timing settings 
• Windows 2000 compatibility 
• Runs as a Windows 2000 service 
• Voice/data modem instead of expensive telephony hardware 

&RQILJXULQJ�9RLFH�0HVVHQJHU�

You must configure Voice Messenger before you can use its services.  At a minimum, Voice 
Messenger must know where on the network to find the WirelessOffice Server (by its name or 
TCP/IP address) and the modem must be properly installed and selected.  To configure Voice 
Messenger, you must be logged on as the operating system administrator and have a 
WirelessOffice login account. 

� 7R�FRQILJXUH�9RLFH�0HVVHQJHU��
1. Click Start, point to Settings, select Control Panel and then Voice Messenger. 

2. Or click Start, point to Programs, select Emergin WirelessOffice then Voice Messenger.  

The Voice Messenger control panel Service tab displays:  
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3. Use the tabs along the top of the Voice Messenger control panel to access various 
configuration options. 

The Voice Messenger control panel tabs are briefly described. To access these options, click on the 
desired tab. 

Tab Description 

Service Use this tab to start or stop the Voice Messenger service or to specify Voice 
Messenger’s startup behavior. 

WirelessOffice Use this tab to login, specify the name or TCP/IP address of the WirelessOffice 
Server, test connectivity to the server and disable/enable caller login 
requirements. 

Settings This tab selects which voice/data modem to use, disable/enable logging, set the 
logging directory path, and set inactivity and disconnect timers. 

Voice Wave Files Use this tab to select the .wav file directory location, and to play back all .wav 
files located in that directory. 

About This tab shows you the current version of Voice Messenger and provides access 
to general help about using the service. 

&KDQJLQJ�WKH�$XWKRUL]DWLRQ�&RGH�

If you did not purchase Voice Messenger with your initial copy of WirelessOffice, you will need to 
enter a new Authorization Code into WirelessOffice Administrator to enable Voice Messenger. If 
the WirelessOffice system is currently running under the DEMO Authorization Code, the software 
will only function for a limited period of time. At the end of this trial period, you will see the 
following message when you attempt to connect to the Server through the Voice Messenger 
control panel: 

Voice Messenger cannot start because it is not registered. 
Please contact Emergin at 1-888-922-7638 or 1-561-361-6990. 

To re-enable Voice Messenger, you must have a valid Authorization Code. When you purchase the 
product, you will be given an Authorization Code that will fully enable the software. Enter this 
new Authorization Code into the WirelessOffice Server using the WirelessOffice Administrator. 
Please see “Modifying Server Configuration” on page 21. 



Using Voice Messenger 

   141

8VLQJ�WKH�6HUYLFH�7DE�

Use the Service tab to start or stop the Voice Messenger service.  You can also use this tab to 
specify Voice Messenger’s startup behavior.  For example, you can specify that Voice Messenger 
will automatically start when the computer it is loaded on starts (for unattended operation) or you 
can specify that starting and stopping Voice Messenger be controlled manually. 

� 7R�VWDUW�RU�VWRS�9RLFH�0HVVHQJHU��

3. Click the appropriate button:  to start, or   to stop. 

4. Click OK if you are finished configuring Voice Messenger.  Otherwise click Apply before 
going to another tab.  

Note: Voice Messenger is a background service in Windows 2000.  If you click OK 
while Voice Messenger is running, the configuration control panel is closed, but 
the service remains loaded and running.  When you stop Voice Messenger, the 
service stops running.   

� 7R�FKDQJH�WKH�VWDUWXS�W\SH��

1. Select Automatic, Manual or Disabled. Startup type changes will not take effect until the 
computer is next rebooted. Manual is the default setting, but Automatic is recommended. 

2. Click Apply if you are not finished using the configuration control panel.  Otherwise, click 
OK.  
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8VLQJ�WKH�:LUHOHVV2IILFH�7DE�

Use this tab to login, specify the name or TCP/IP address of the WirelessOffice Server, test 
connectivity with the server and disable/enable caller login requirements. 

� 7R�ORJLQ�DQG�VSHFLI\�WKH�VHUYHU�DGGUHVV��

1. Click the WirelessOffice tab. Type a User Name and Password (1-20 characters in length) to 
login to the server.  Beforehand, set up a “Voice Messenger” User account in WirelessOffice 
Administrator with the following security settings: 100 for the user security level, Grant 
access and Same or lower for user access.  

2. Type the name or TCP/IP address of the WirelessOffice Server computer in the Server text 
box. The computer name is recommended. 

3. Click the Test Connectivity button to ensure that Voice Messenger can communicate with the 
WirelessOffice Server. If Last Connect Attempt and Last Login Attempt both display OK, 
then the test was successful. 

4. Any errors will be displayed as a message. Server Status indicates whether the connection to 
the WirelessOffice Server was successful or not. To locate the correct Server name, open the 
WirelessOffice Administrator and click File and then Change Server. If the server 
connection is not made, Login Status will be blank. Login Status indicates any login 
connection errors, such as the User Name is already logged in (each User Name can only log 
into one client application at a time), the User Name is not specified in the Server, or the 
password is incorrect.  

5. To disable the caller login name and password requirement, deselect Require callers to enter 
their User Name and Password. Callers will immediately be able to type the Escalation ID 
and desired action. Security will be removed and when a caller cancels an escalation and 
notifies previous recipients, that specific caller will not be able to be linked with that 
cancellation. Instead, the notification message will read that the Voice Messenger User Name 
cancelled the message. 
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8VLQJ�WKH�6HWWLQJV�7DE�

Use this tab to select the appropriate voice/data modem, enable/disable logging and to adjust 
inactivity and disconnect timeout intervals. 

� 7R�VHOHFW�D�PRGHP��

1. Using the drop-down combo box, select the voice/data modem you wish to use with Voice 
Messenger. Only available voice-capable modems are listed. 

2. If no modems are auto-detected, refer to “Modem Configuration” on page 146 for information 
about adding a voice/data modem. Be sure to exit the Voice Messenger control panel before 
adding the modem. 

3. When you re-open the application, the new modem should be listed. 

4. Click Apply if you are not finished in the configuration control panel.  Otherwise, click OK. 

���7R�HQDEOH�ORJJLQJ��

1. Stop the Voice Messenger service by clicking the Stop button on the Service tab. Please see 
“To start or stop Voice Messenger” on page 141 for instructions. 

2. Select On to start Voice Messenger logging. Only enable logging for diagnostic purposes. 

3. The log is located by default in c:\winnt\vmsgr.log. Click the ellipsis button to change the log 
file location. 

4. Click Apply if you are not finished in the configuration control panel.  Otherwise, click OK. 

5. Restart the Voice Messenger service in the Service tab and click OK. 

Note: The log file rolls over to vmsgr.old when it reaches 512 kilobytes in size and a new .log 
file is created. Error and warning messages are logged to the 2000 Event Viewer as well 
as the selected text log file. 
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� 7R�DGMXVW�LQDFWLYLW\�DQG�GLVFRQQHFW�WLPHRXW�LQWHUYDOV��

An inactivity warning (moretime.wav) is played if x seconds pass with no activity. The warning 
instructs the caller that it is waiting and that any key press will return the caller to the previous 
function. If no action is taken after this warning, the disconnect message (goodbye.wav) will play 
after y seconds of further inactivity and will then disconnect the call if no key is pressed. 

1. Set the Inactivity warning after (seconds) to a numeral in the range of 20 and 360 seconds 
(6 minutes). The default setting is 60 seconds. 

2. Set the Disconnect after warning (seconds) to a numeral in the range of 10 and 60 seconds. 
The default setting is 10 seconds. 

3. Click Apply if you are not finished using the configuration control panel.  Otherwise, click 
OK. 

8VLQJ�WKH�9RLFH�:DYH�)LOHV�7DE�

Use this tab to change the directory where the .wav (digital wave audio) files are stored and to play 
back .wav files. Voice Messenger provides default .wav recordings, but customized recordings can 
be made by the customer and placed in the appropriate directory. Please see “Recording 
Customized Messages” on page 148. For a complete list of the required .wav file names and the 
script, please see “Appendix F: Voice Messenger Prompts” on page 213. 

Voice Messenger auto-detects for the required .wav files each time the configuration control panel 
is newly opened and the Voice Wave Files tab is selected. If any files are missing, the application 
will display an error message detailing which files are missing.  

��7R�FKDQJH�WKH�GLUHFWRU\�SDWK��

1. Stop the Voice Messenger service by clicking the Stop button on the Service tab. Please see 
“To start or stop Voice Messenger” on page 141 for instructions. 

2. Click the Voice Wave Files tab then click the button with the ellipses.  The Select Voice 
Folder dialog box displays. The default directory is C:\Program Files\Emergin 
WirelessOffice\Voice. It is highly recommended to save the .wav files on a local directory. 

3. Locate and select the folder in which you want the .wav files maintained. Click OK. Click 
Apply if you are not finished using the configuration control panel.  Otherwise, click OK. 

4. Restart the Voice Messenger service in the Service tab and click OK. 
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� ��7R�SOD\�PHVVDJH�UHFRUGLQJV��
Important: In order to play back recordings, the system must have a configured audio card and 
speakers. The service should be stopped while playing files. 

1. In the File Name field, select the recording you wish to play. Each recording displays its 
associated purpose when selected. 

2. Click the green arrow Play button. To stop the playback, click the red square Stop button. 

3. Click Apply if you are not finished using the configuration control panel.  Otherwise, click 
OK. 

8VLQJ�WKH�$ERXW�7DE�

Use the About tab to view the version number of Voice Messenger. Click the Help button in the 
lower-right corner to access the help file.  

&RQWUROOLQJ�9RLFH�0HVVHQJHU�

Voice Messenger is a background service in Windows 2000. Its operation is simple; while it is 
running, it allows users to send escalation acknowledgment commands to WirelessOffice Server 
via a cell phone or telephone call to the modem line.  While Voice Messenger is stopped, it is 
removed from memory and performs no service.  You will use the Voice Messenger control panel 
to start and stop the service.  See “To start or stop Voice Messenger” on page 118 for instructions. 

The application control panel operates independently of the Voice Messenger service.  When you 
click OK, the configuration control panel will close and the Voice Messenger service will remain 
in its current state (running or stopped). 
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$XWRPDWLF�YV��0DQXDO�6WDUWXS�

If Voice Messenger is configured for Automatic Startup, the service starts automatically when 
the computer on which it is installed is started.  If configured for Manual Startup, you must use 
the Voice Messenger control panel to start it.  The WirelessOffice Server does not have to be 
running in order to start the service. See “To change the startup type” on page 118 for more 
information about Startup Types.   

0RGHP�&RQILJXUDWLRQ�

Voice Messenger automatically detects all compatible voice/data modems already installed on 
your computer system. If no voice/data modems are listed, install an appropriate modem driver. 

Note: At this time, the only recommended voice/data modem is the 3COM U.S. Robotics 
56K Voice Faxmodem Pro internal or external version. One line per system is 
supported. It is recommended to configure a dedicated outside line to Voice 
Messenger. View the Release Notes for a list of modems that have been tested after 
manual publication and are compatible (click Start, Programs, Emergin 
WirelessOffice and select Release Notes). A compatible voice/data modem must play 
PCM, 8 kHz sampling, 16 bit data, 1 channel (mono) .wav files. 

�� � 7R�YHULI\�PRGHP�LQVWDOODWLRQ�DQG�&20�SRUW�ORFDWLRQ��
1. Click Start, Settings, Control Panel and then Voice Messenger. 

2. Click the Settings tab. All available voice capable modems are automatically detected and 
listed. [If no modems are listed, follow the instructions below.] 

3. Select the modem you wish to use. 

�� � 7R�DGG�D�PRGHP��
1. Close the Voice Messenger control panel. Shut down the Voice Messenger computer and 

connect a voice-capable modem. Turn the modem’s power on. Restart the computer. 

2. The Windows 2000 Plug and Play feature should guide you through the modem installation. 
Follow the instructions provided by the modem manufacturer. Otherwise, go to Step 3. 

3. Click Start, Settings, Control Panel, then Phone and Modem Options. Select Modems tab. 

4. Click Add. The Add/Remove Hardware Wizard displays. Click Next, allowing the system 
to auto-detect your newly connected modem. 

5. If your modem cannot be detected, you will be prompted to select from a list. Click Next. 

6. Select the Manufacturer and Model of the modem. If using the recommended modem, select 
3COM as the Manufacturer and the appropriate U.S. Robotics 56K Voice selection. 

7. Select the port that the new modem is attached to. Click Next. 

8. After completing the modem driver installation process, re-open the Voice Messenger 
configuration panel and click the Settings tab. The new modem should now be listed. 
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&DOOLQJ�LQWR�9RLFH�0HVVHQJHU�

When calling into Voice Messenger always remember to: 

• Dial each response slowly and deliberately (speed dialing is not supported) 
• Wait until each prompt finishes before typing your response 

 

��7R�FDOO�DQG�ORJLQ�WR�9RLFH�0HVVHQJHU��
1. Dial the dedicated phone number for the line that is plugged into the voice/data modem. 

2. Follow the voice prompts. If caller login requirements are enabled, type your WirelessOffice 
Full Name then the Pound (#) Key. The Full Name should be used as opposed to the Login 
User Name as defined in the user profile in WirelessOffice Administrator. Use the 1 key for 
any special characters, such as a space or punctuation. 

3. The user must have a password. Type it and then press the # key. 

4. The # key is required after each entry and the Star (*) key allows the user to go to the previous 
menu level or to exit. 

Note: Callers do not need any special user security levels or settings to call in and cancel or 
advance escalated messages. Grant access is the only requirement. 

 

��7R�HVFDODWH�RU�FDQFHO�D�PHVVDJH�
1. Type the escalation number only. The ID: is not required.  

Example: The following depicts what a WirelessOffice escalated message will look like on 
your wireless device: ID:2200 Lvl:1 Message text 

Where…ID:2200 is the Escalation ID. When responding with Voice Messenger you will 
type 2200 as the Escalation ID number. 

Lvl:1 is the escalated level. The range is 1 –5. 

2. Messages may be cancelled or increased to the next level. If cancelled, the caller is given the 
option to notify previous recipients. 

Command Action 

Cancel + Notify 
Previous 

Recipients 

Cancel escalated message. Notify previous recipients 
will send a cancellation notification and details the 
user that cancelled the message. 

Cancel + No 
Notification 

Cancel escalated message. Do not notify previous 
recipients. 

Increase the 
Escalation 

Level 

Escalate message immediately to next recipient level. 
All following levels will be rescheduled for the current 
time plus the originally defined Time Interval. 
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5HFRUGLQJ�&XVWRPL]HG�0HVVDJHV�

Voice Messenger allows customers to use their own customized recordings. You may add or 
reword information but always keep the prompts brief and make sure to record the key steps that 
callers need to correctly implement the system. For example, you may want to include your 
company name in the greeting.  

Messages must be recorded in the following .wav format: PCM, 8 kHz sampling, 16 bit data, 1 
channel (mono). You can record messages using the Windows 2000 operating system recorder or 
using a third-party recording product. 

�� 7R�UHFRUG�PHVVDJHV�XVLQJ�0LFURVRIW�6RXQG�5HFRUGHU��
For more information about configuring the recording software, refer to their on-line help. These 
steps reflect a Windows 2000 Server configuration at the time of publication and are provided for 
basic instruction purposes only. 

Note: These steps assume speakers, microphone and audio card are all properly configured. 
Before placing the new .wav files in the Voice Messenger directory, you may want to 
back up the default recordings in case you need to use them in the future. 

 

1. Refer to “Appendix B: Voice Messenger Prompts” on page 213 for a recording script and file 
names. 

2. Click Start, then Programs, Accessories, Entertainment and then Sound Recorder. 

3. Click File and then New. Record a message by clicking the Record button. When finished 
speaking the message, click the Stop button. 

4. Play back your recording to ensure sound quality. 

5. Click File and then Save As. Select the file location and then Name the file exactly as it is 
spelled in the prompts script.  

6. Click Change to adjust the recording format. In the Attributes drop-down list, select 8.000 
kHz, 16 Bit, Mono from the list. Make sure that the Format field is set to PCM. Click OK. 
Then click Save.  

7. To record the next message, repeat Steps 3 to 6. Record all prompts to ensure consistency. 
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(VFDODWHG�0HVVDJLQJ�

Escalated messages are intended to ensure that important events are properly taken care of by 
continuing to escalate a message until it runs its course or is cancelled. Up to five levels of 
escalation can take place with the last level repeated as often as needed, sending to various 
recipients or groups/departments. The time interval between sending to each level is configured 
according to the urgency and importance of the message. 

Escalated messages are configured in: 

• Command Messenger 
• Alarm Messenger 
• File Messenger 

 

Escalated messages can be cancelled and escalated using: 

• Two-way wireless device via E-mail Messenger 
• Internet via Web Messenger – Plus 
• Cell phone or telephone via Voice Messenger 
• Alarm Messenger 
• WirelessOffice Administrator 

 

The following diagram depicts WirelessOffice components and their role in escalated 
messaging:
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8VLQJ�$ODUP�0HVVHQJHU�

Alarm Messenger, formerly named SitePage, will automatically install when you select Alarm 
Messenger from the WirelessOffice installation. It will only function if your Authorization Code 
reflects an Alarm Messenger purchase or you are using the DEMO Authorization Code.  

Alarm Messenger uses wireless-messaging technology to communicate to the proper personnel 
that a critical condition exists in your automated monitoring system (see following diagram):  

Input data from an automated monitoring system is received by Alarm Messenger through an RS-
232 serial interface. Up to eight serial communications (COM) ports are supported per Alarm 
Messenger system. 

1. Alarm Messenger searches the data stream for defined keys, and then compares the data to 
specific values to determine if an alert exists. 

2. If an alert exists, Alarm Messenger addresses and composes an alphanumeric message and 
sends a messaging request to the WirelessOffice Server using the TCP/IP communications 
protocol.  

3. Alert messages can be configured to escalate to a series of personnel. These escalated 
messages may also be cancelled when the alert has been satisfied or manually accelerated to 
the next level to speed up the process. 

4. The WirelessOffice Server receives the message request and sends the alphanumeric message 
to the designated personnel using the appropriate wireless carrier. 

Note: Alarm Messenger can be installed on any Windows NT/2000 system, including the 
WirelessOffice Server system, as well any other WirelessOffice component systems. 
The firewall input port is 12398.  
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8SJUDGLQJ�$ODUP�0HVVHQJHU�

To upgrade from a previous version of SitePage, the Installation Wizard will convert and integrate 
the past version database and settings information. There is no need to remove the previous version 
of Alarm Messenger before upgrading. If you are upgrading from Site Alert, back up your 
database, load the new software and then refer to “Launching the Alarm Messenger Upgrade Tool” 
on page Error! Bookmark not defined. for database updating information. 

1HZ�$ODUP�0HVVHQJHU�)HDWXUHV�

• Escalated messaging for Alarm Messenger alerts, up to five levels (page 172) 
• Escalated message cancellation (page 182) 
• Manually accelerate message escalation (page 182) 
• Escalated message cancellation can notify previous recipients about cancellation (page 182) 
• User Name/Password authentication for server connections (page 162) 
• Send responses to satisfy monitoring equipment requirements (page 172) 
• Department messaging capability (page 172) 
• Export log views to comma-delimited file (page 185) 
• Security profiling 
• Windows 2000 compatibility 

6WDQGDUG�$ODUP�0HVVHQJHU�)HDWXUHV�

• RS-232 serial port interface 
• Simultaneous monitoring of up to 8 ports 
• Customer-defined alerts and keys 
• Selective alert disabling 
• Individual or group messaging notification 
• Time shift sensitive, computer generated notification 
• Send custom messages and extract input from specific fields in the data stream 
• Define and send canned messages 
• Send entire input as alert message 
• Option to extract pager ID from input for message addressing 
• Visually monitor data streams from each port 
• Freeze and analyze data stream information to set up “key” character positions 
• Error, message, rules and activity logging 
• Database backup and restore 
• Pageable alerts can be configured for specific software events 
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$ODUP�0HVVHQJHU�7HUPV�

The following terms are used throughout this chapter. Their definitions are provided to help you 
understand the Alarm Messenger application. 

Term Definition 

alert An event that requires human intervention. In Alarm Messenger you must 
define the parameters that constitute an alert (e.g., input port, key, message, 
time shift, and recipient). 

data stream The serial data that is sent by your monitoring system to Alarm Messenger 
through a serial communications (COM) port. 

escalation The ability to send a message to a series of up to five levels of recipients, 
ensuring that the message is properly responded to in a timely manner. The 
message continues to escalate until it is cancelled or all levels have been 
notified. 

event A single line of data sent by the monitoring system to indicate that something 
has occurred. Alarm Messenger considers an event to be an alert only when a 
defined key is found in the data stream.  

input port A serial communications (COM) port used to receive input from your 
monitoring system. 

key One or more words or numeric values contained in the data stream used to 
determine if an event is an alert. 

message The alphanumeric notification that is sent to designated personnel when an 
alert is detected. 

monitoring system The equipment being used to “watch” a process and send event information to 
Alarm Messenger. 

recipient A person, group or department to whom the appropriate message is sent 
when an alert is detected.  

response ASCII message sent from Alarm Messenger to the monitoring equipment 
when a specific alert is matched. 

time shift The period of time during which a message can be sent to a designated 
recipient. 

 

6WDUWLQJ�$ODUP�0HVVHQJHU�

1. Double-click the Alarm Messenger desktop icon or click Start, Programs, Emergin 
WirelessOffice and then Alarm Messenger. 

2. The WirelessOffice Login dialog displays. Type your User Name and Password to login to 
the WirelessOffice Server. You can only be logged in once at any given time to the server 
with your User Name. If you are using the ‘Administrator’ account, you will need to create a 
new user login account. 

3. Type the name or Internet address of the WirelessOffice Server you wish to access. Use the 
drop-down arrow to choose a previously selected server. Select Remember password if you 
wish to auto-login in the future. Click OK. 



Using Alarm Messenger 

   153

8VLQJ�WKH�$ODUP�0HVVHQJHU�:LQGRZ�

For your reference, the Alarm Messenger window is shown below to identify and describe the 
elements of its user interface. 

�� 0HQX�%DU�
The menu bar contains pull-down menus and commands that let you control, configure, and 
generally use Alarm Messenger.  

File Edit View 

New >                              
>Alert 
>Key 
>Time Shift  
>Port 
Database                      
>Backup                      
>Restore 
Print 
Print Preview 
Print Setup  
Exit 

Properties                       
Delete 
Delete All 
Copy Alert 
Paste Alert 

Toolbar 
Status Bar 
Port Monitor 
Escalation View 
Tabs 
>On Bottom 
>On Top 
>On Left 
>On Right  
Refresh 

Run Tools Help 

Start 
Stop 
Demo 

Configuration 
Recipient Validation 
Send Test Message 

Help Topics 
Tip Of The Day                                 
Emergin Knowledge Base                    
About Alarm Messenger 

Menu Bar 

Toolbar 

Tree View 

List View 

Tabbed View 

Tabs 

Status Bar 
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�� 7RROEDU�

 

The toolbar contains buttons that let you quickly access many of the commands that are available 
in the menu bar. You can turn the toolbar on and off with the View menu bar option.  

The following table describes each of the toolbar buttons: 

Icons Description  Icons Description 

 
Start input processing, which 
enables alert notification 

 
 Refreshes the view 

 
Stop input processing, which 
disables alert notification 

 
 

Configure setup, passwords, input, 
file logging and other parameters 

 Define a new alert  
 Send a test message 

 Define a new key  
 Open Port Monitor 

 Define a new time shift  
 Open Escalation View 

 
Define a new communications 
(COM) port 

 
 

Backup the database (which 
contains your alert properties, etc.) 

 
Modify the currently selected 
object (alert, key, message, etc.) 

 
 Restore the database from a backup 

 
Delete the currently selected 
object (alert, key, message, etc.) 

 
 

Access the on-line Help for Alarm 
Messenger 

�� /LVW�9LHZ�
This Alarm Messenger window displays the appropriate details for the object that is currently 
selected in the Tree View. For example, if you click on a key object, its properties appear in the 
List View.  

��
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7UHH�9LHZ�
This area of the Alarm Messenger window contains a hierarchical representation of the objects 
being used by Alarm Messenger. These objects are represented by icons, which include: alerts, 
keys, messages, time shifts, ports and recipients. The Tree View works much like the Tree View in 
Windows NT Explorer; you can expand or collapse portions of the tree to reveal or conceal 
subordinate objects by clicking on the plus (+) and minus  (-) boxes. Use the Tree View to select 
specific objects for which you want to perform a task, such as: view, modify, delete, and print. 

�� 7DEEHG�9LHZ�
This Alarm Messenger window displays three tabbed views, reflecting the Message Log, Rules 
Log and Activity Log tabs. 
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�� 3RUW�0RQLWRU�9LHZ�
This Alarm Messenger window displays the real-time data stream being read from any of the 
COM ports. You can select which COM port to monitor by clicking View and selecting Ports and 
clicking on the appropriate COM ports.  

Note: The Port Monitor should only be opened for diagnostic and configuration purposes. It 
should generally be closed during normal operation.  

(VFDODWLRQ�9LHZ�
This window displays all messages that are set to escalate. Messages can be configured to escalate 
up to five levels and may be cancelled at any point during the escalation process. They may also be 
manually escalated to the next level. These actions take place in the Escalation View, as well as in 
the WirelessOffice Administrator’s Escalated Messages tab. Cancellation may also be conducted 
in Web Messenger or via a recipient’s two-way wireless device using E-mail Messenger. Please 
see “Escalation Cancellation” in the Using E-mail Messenger and Using Web Messenger chapters. 

6WDWXV�%DU�
This area of the Alarm Messenger window displays informational messages that keep you 
informed about the current status of Alarm Messenger. You can turn the Status Bar on and off with 
the View menu bar option. 
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3ODQQLQJ�<RXU�6\VWHP�

After you have successfully installed Alarm Messenger, carefully plan your Alarm Messenger 
implementation by thoroughly analyzing all of the events processed by your automated monitoring 
system. Effective planning can simplify the configuration process and make your system easier to 
maintain. 

Planning your system includes: 

• Assessing your needs 
• Understanding Alarm Messenger capacities 
• Identifying your alerts 
• Identifying the keys for your alerts 

 

$VVHVVLQJ�<RXU�1HHGV�

Begin by analyzing your current manual dispatching process. Determine how you can improve 
overall productivity with automated dispatching. Keep the features of Alarm Messenger in mind 
when doing your analysis. Your implementation can take advantage of Alarm Messenger’s support 
for: 

• time shifts 
• recipient groups and departments  
• context-sensitive messages 
• file logging 
• escalation  

8QGHUVWDQGLQJ�$ODUP�0HVVHQJHU�&DSDFLWLHV�

Alarm Messenger has certain maximum capacities. You should consider these capacities while you 
are planning your alerts: 

Parameter Maximum Capacities 

Input ports 8 

Alerts 2500 

Keys 2500 

Keys per Alert 50 

Messages per Alert 20 

Recipients per Alert 25 

Time Shifts 20 

Escalation Levels 5 

Recipients per Escalation Level 25 

Input Length (in characters) 1024 

Response length (in characters) 100 
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,GHQWLI\LQJ�<RXU�$OHUWV�

To determine which alerts to define for your environment, consider the following questions: 

• Which areas need to be monitored for critical events? 
• What are the critical events you want to monitor for each area? Is action warranted for each critical 

event? 
• What should the message contain? Who should be notified? When? Does the message need to be 

escalated? 
 

Begin by making a list of the alerts you want Alarm Messenger to process, based on your answers 
to these questions. For each alert, answer the following: 

• From which communication (COM) port will the data stream be read? 
• What times of the day, days of the week, and months of the year should Alarm Messenger 

processing apply?  
• Should Alarm Messenger include part of the data stream in the message text?  
• Should the message be sent to a user, several users, a department or a group? Or should the PIN be 

extracted from the data stream? 
• Does the monitoring equipment require a response? 

 

,GHQWLI\LQJ�WKH�.H\V�IRU�<RXU�$OHUWV��

Each alert must have at least one key associated with it for Alarm Messenger to be able to detect 
the critical event. An alert’s key defines: 

• Where in the data stream Alarm Messenger looks to see if the event is an alert, 
• What Alarm Messenger compares the data with to determine if the event is an alert, 
• How the comparison should be made (equal to, less than, etc.), and 
• What type of data is being compared (numeric or alphanumeric). 

 
To help Alarm Messenger accurately detect critical events, you should consider defining multiple 
keys for your alerts, if possible. Using your alert lists, begin compiling the information and 
recording it for each alert’s key(s). When you have finished outlining your alert needs, review the 
information for common keys. You need only define a key once—even if it can be used by more 
than one alert. 

([DPSOH�,PSOHPHQWDWLRQ�

To demonstrate how to implement Alarm Messenger, we will use an example scenario. Assume we 
have an automated monitoring system for pressure vessels, and it is critical that their pressures 
remain above 120 pounds per square inch (PSI). The automated monitoring system sends its data 
stream over a serial cable that is connected to COM port 1 on the Alarm Messenger computer. 
WirelessOffice then issues a message to the maintenance staff, who share the responsibility of 
maintaining the pressure in these tanks. 
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� 7R�LGHQWLI\�WKH�DOHUW��
We want to notify the current maintenance person with the following message when the pressure 
in any of these tanks falls below 120 (PSI).  

Pressure reading for Tank <tank #> is below 120 PSI 

We have just identified our first alert: when pressure in a tank is less than 120 PSI, send a specific 
message (with the tank number) to the maintenance department’s wireless devices, no matter when 
the event occurs. An example is shown: 

Alert 
Name 

Port (COM) Time Shift Message Recipient(s) 

120 
PSI 

COM 1 ALWAYS Pressure reading for Tank <tank#> 
is below 120 PSI 

MAINT 

Key-1 Name Begin End A/N Operator Data for Comparison And/Or  

        

��  � 7R�LGHQWLI\�WKH�NH\V��
The automated monitoring system sends its data stream in the following format: 

                032797|11:12:36|TANK=05|PSI=215|AB9 

To ensure that Alarm Messenger will accurately detect the event, we will define two keys for the 
alert, as follows: 

Alert 
Name 

Port (COM) Time Shift Message Recipient(s) 

120 
PSI 

COM 1 ALWAYS Pressure reading for Tank <22,23> 
is below 120 PSI 

MAINT 

Key-1 Name Begin End A/N Operator Data for Comparison And/Or  

PSI 25 27 A = PSI And  

Key-2 Name Begin End A/N Operator Data for Comparison And/Or  

120 29 31 N < 120   

If Alarm Messenger receives an input line that does not contain “PSI” in character positions 25 
through 27, the first key is not satisfied, and the event is ignored. If Alarm Messenger receives an 
input line that contains “PSI” in character positions 25 through 27 and a numeric value less than 
“120” in character positions 29 through 31, both keys are true and the event is considered an alert. 
The defined message, which now contains the tank number from the data stream, is sent to the 
maintenance department’s users’ wireless device(s). 

Date
(Chars 1 – 6)

Tank Number 
(Chars 17 – 23) 

Pressure Level 
(Chars 25 – 31) 

Time
(Chars 8 – 15)
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&RQILJXULQJ�$ODUP�0HVVHQJHU�

Now that you have planned your implementation, it is time to configure Alarm Messenger. 
Configuring your system includes: 

• Configuring general setup parameters 
• Configuring pageable alerts and file logging parameters 
• Configuring input, data queue and escalation view requirements 
• Configuring the COM ports 

� 7R�FRQILJXUH�$ODUP�0HVVHQJHU���
1. Launch Alarm Messenger by double-clicking the desktop Alarm Messenger icon or click 

Start, Programs, Emergin WirelessOffice and then Alarm Messenger. Login with your 
User Name, Password and select a Server. See “Starting Alarm Messenger” on page 152. 

2. Click the  icon on the toolbar or click Tools from the menu and then Configuration. 

The Alarm Messenger Configuration dialog displays with the Setup tab open. 

The Alarm Messenger Configuration dialog contains five tabs: 

Tab Description 

Setup This tab lets you configure the startup mode, as well as start/stop and database 
access passwords. These passwords are not related to the Authentication 
password required to establish a connection to the server. 

WirelessOffice This tab allows you to view the User Name and Server name (or Internet 
address). It also lets you specify who will receive notification for specific system 
events that are pageable alerts. 

Logging This tab lets you configure the Activity Log and Rules Log settings. 

Input This tab allows you to convert hexadecimal data stream input into ASCII 
characters and set data queue size. 

Escalation This tab allows you to auto-open the Escalation View whenever an escalated 
message is submitted. 
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&KDQJLQJ�WKH�$XWKRUL]DWLRQ�&RGH�

If you did not purchase Alarm Messenger with your initial copy of WirelessOffice, you will need 
to enter a new Authorization Code into WirelessOffice Administrator to enable it. If the 
WirelessOffice system and Alarm Messenger are currently running under the DEMO 
Authorization Code, the software will only function for a limited period of time. At the end of this 
trial period, you will see the following message when you attempt to connect to the Server: 

Alarm Messenger cannot start because it is not registered.  

Please contact Emergin at 1-888-922-7638 or 1-561-361-6990. 

To re-enable Alarm Messenger, you must have a valid Authorization Code. When you purchase 
the product, you will be given an Authorization Code that will fully enable the software. Enter this 
new Authorization Code into the WirelessOffice Server using WirelessOffice Administrator. 
Please see “Modifying Server Configuration” in the Configuring WirelessOffice Server chapter. 

8VLQJ�WKH�6HWXS�7DE�

Use the Setup tab to configure or reconfigure the startup mode and Alarm Messenger passwords.  

� 7R�FRQILJXUH�WKH�VWDUWXS�PRGH��
You can choose to have Alarm Messenger automatically begin processing data from the input ports 
when Alarm Messenger is launched (Automatic start). With Manual start, you must manually 
start the processing function. 

1. Click the Configuration icon on the toolbar.  

The Alarm Messenger Configuration Setup dialog displays: 

2. In the Startup area, select the desired startup action. Select either Automatic start or 
Manual start. 

3. Click OK to exit and save your changes, or perform another configuration task while the 
Configuration dialog box is open. 
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� 7R�VHW�$ODUP�0HVVHQJHU�SDVVZRUGV��
Alarm Messenger allows you to password-protect the start and stop processing of Alarm 
Messenger and/or the ability to modify the Alarm Messenger database.  

1. In the Passwords area, click Required to enable password protection. 

2. To protect the Start/Stop function (allowing users to start and stop Alarm Messenger’s 
monitoring process), enter a maximum of eight characters for the password.  Re-enter the 
password to verify your spelling. 

3. To protect the Alarm Messenger database from unauthorized backup and restore operations, 
enter a maximum of eight characters for the password.  This may be the same password used 
for the Start/Stop function. Re-enter the password to verify your spelling. 

4. Click OK to exit and save your changes, or perform another configuration task while the 
Configuration dialog box is open. 

8VLQJ�WKH�:LUHOHVV2IILFH�7DE�

Use the WirelessOffice tab to view the logged in User Name and Server, to unsave a password, 
and to set up Pageable Alerts. 

� 7R�YLHZ�XVHU�QDPH�DQG�VHUYHU�DGGUHVV���
The specified User Name and Server are established during the Alarm Messenger login. To change 
User Name or Server, you must exit Alarm Messenger. Upon restarting, information can be 
changed in the WirelessOffice Login dialog. 

1. Click the Configuration icon on the toolbar and then select the WirelessOffice tab.  

The Alarm Messenger Configuration WirelessOffice dialog displays: 

2. In the Authentication area, view your User Name and Server name. Click Unsave 
password to undo the initial Remember Password selection in the WirelessOffice Login 
dialog. 

3. Click OK to exit or perform another task while the Configuration dialog is open. 
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� 7R�FRQILJXUH�3DJHDEOH�$OHUWV��
Pageable Alerts are system conditions that the system supervisor will receive a message about. 

1. If not already open, click the WirelessOffice tab in the Configuration dialog. 

2. In the Pageable Alerts area, select the message recipient you want to identify as being the 
recipient from the Supervisor list box. This recipient will receive messages for any of the 
conditions you select in the next step. 

3. Select all conditions for which you want the supervisor paged by selecting all appropriate 
check boxes. 

4. Click OK to exit and save your changes, or perform another configuration task while the 
Configuration dialog box is open. 

8VLQJ�WKH�/RJJLQJ�7DE�

Alarm Messenger lets you limit the size of the Activity Log and Rules Log files. It also lets you 
dictate whether all alerts that come in from your automated monitoring system are posted or only 
those that match a defined condition. 

� 7R�FRQILJXUH�ORJJLQJ��
1. Start the Configuration dialog. Click the Logging tab. 

 The Alarm Messenger Configuration Logging dialog displays (default settings): 

2. In the Activity Log area, enter the Maximum Size (in kilobytes) of the Activity Log file. The 
log rolls over to .old when the maximum is reached and a new .log file is created. This file, 
alarmerr.log, is located in C:\Program Files\Emergin WirelessOffice, unless the 
WirelessOffice was installed to a different directory. 

3. In the Rules Log area, select Log all alert comparisons if you want all alerts to be posted to 
the Rules Log. Select Log matches only if you want only those alerts that match an Alarm 
Messenger-defined condition to be posted. 

4. In the Rules Log area, enter the Maximum Size (in kilobytes) of the Rules Log file. When 
the Rules Log file reaches this limit, the log rolls over to .old and a new .log file is created. 
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This file, alarmrul.log, is located in C:\Program Files\Emergin WirelessOffice, unless the 
WirelessOffice was installed to a different directory. 

5. Click OK to exit and save your changes or perform another configuration task while the 
Configuration dialog box is open. 

Note: If you select Log all alert comparisons, system performance will be affected.  This 
should be used for diagnostic purposes only. 

8VLQJ�WKH�,QSXW�7DE��

Alarm Messenger lets you automatically convert hexadecimal data stream input into ASCII 
characters. It also lets you control the data queue size.  

� 7R�FRQILJXUH�LQSXW�VHWWLQJV��
1. Start the Configuration dialog. Click the Input tab. 

The Alarm Messenger Configuration Input dialog displays: 

2. Select Convert hexadecimal input to ASCII for automatic input data conversion. This 
setting is selected by default. 

3. Select No input character translation if your input data requires no special ASCII 
translation. 

4. Data Queue size reflects the maximum number of input lines allowed to be stored in the data 
queue to await processing. Default data queue size is 25,000 entries (range 0-25,000). Adjust 
this setting if you will be sending responses back to your monitoring equipment. Please see 
“Configuring Alerts” on page 172 for more information about alert responses. 

For example: If an alert is matched, a response can be sent to the equipment to let it know not 
to send any more messages of that type. In the meanwhile, by setting the Data Queue size to a 
lower number in the range of 0 to 2, you will eliminate possible outdated messages.   

5. After making any changes to this dialog, exit and restart the application. Please see “To start 
and stop Alarm Messenger” on page 179. 
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8VLQJ�WKH�(VFDODWLRQ�7DE��

Alarm Messenger lets you configure the automatic opening of the Escalation View whenever an 
escalated message is submitted. The Escalation View lets you monitor the status of escalated 
messages, escalate messages or cancel messages when escalation is no longer needed. Please see 
“Viewing and Canceling Escalated Messages” on page 182 for more information. 

� 7R�FRQILJXUH�WKH�(VFDODWLRQ�9LHZ��
1. Start the Configuration dialog. Click the Escalation tab. 

The Alarm Messenger Configuration Escalation dialog displays: 

2. Select this setting to allow the Escalation View to auto-open when escalated messages are 
submitted.  Please see “To view escalated messages” on page 181 for more information about 
the Escalation View. 

3. Click OK to exit when configuration is completed. 
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&RQILJXULQJ�,QSXW�&20�3RUWV�

� 7R�DGG�D�QHZ�&20�SRUW��
You must configure each COM port that will be used to receive input from the automated 
monitoring equipment. 

1. Click the  icon on the toolbar. 

The Choose Input Port dialog displays:  

2. Select the port you want to configure and click Next.  

The Port Parameters screen displays: 

3. Accept or modify the Port Parameters then click Next. Match these settings to the input 
device’s parameters. 

4. The Input Delimiters dialog displays. Select one or two input delimiters according to the 
needs of your input monitoring equipment. At least one choice is required. Click Next.  

5. If you have selected flow control, the Choose Flow Control screen displays. Make the 
appropriate choice(s) then click Next. For more detailed information, please see the next page. 

6. The DSR Notification screen displays. Make the appropriate choice then click Finish. 

Note: Restart Alarm Messenger for input to take affect. 
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� 7R�PRGLI\�&20�SRUWV��
After configuring a new port, review and modify changes in the Port Properties – Modify  dialog. 

1. From the Tree View window, double-click the port you wish to modify. 

2. Or select the port you wish to modify from the Tree View window then right-click and select 
Properties.  

The Port Properties - Modify dialog box displays: 

3. If not already selected, click the Setup tab. Select the port you want to configure from the 
Port list box. 

4. Optionally enter a name for the port in the Name text box. 

5. In the Status area, select Enabled if you want the port to accept input from a monitoring 
device. Select Disabled if you want to stop the port from accepting input. 

6. In the Log Mode area, select On to enable logging for the current port. Click Off  to suppress log 
transactions for the port. 

Note: When the log mode is on, COM logs are created in the install directory with the template 
amcomx.log (x signifies the COM port number). This information can be useful for 
diagnostic purposes. 

  

7. In the Communication Parameters area, use the list boxes to select the baud rate, data bits, 
parity, and stop bits for the current port. 

8. In the Input Delimiters  area of the dialog box, use the slider controls to set the two-character, 
end-of-line (EOL) character sequence for the data stream. As you slide the bar, various 
delimiters display with their hexadecimal and ASCII representations. Stop at the appropriate 
delimiter for each character; or, if necessary, select none. 

Note: Use the left and right arrow keys on your keyboard for the Input Delimiters  to 
move the slider controls one value at a time. 
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9. To further configure the current port, click the Advanced tab.  

The advanced Port Properties-Modify Advanced dialog displays: 

10. Select the Line Settings, Flow Control, and Time Out values that match the RS-232 settings 
used by the monitoring device. 

11. Click OK to exit and save the changes. Repeat these steps for any remaining COM ports. 

&UHDWLQJ�$OHUWV�DQG�'HILQLQJ�7KHLU�3URSHUWLHV�

For each event you want Alarm Messenger to consider an alert, you must create a unique alert and 
define its properties. You will use the information you gathered during the planning phase. See 
“Planning Your System” on page 157. Alert properties include: 

• Keys — which define the criteria for an alert. You will create a pool of keys that can be used for 
any defined alert. 

• Messages — which define the content of the alphanumeric message. 

• Time shifts — which determine when an event should be considered an alert. Alarm Messenger 
comes with several predefined time shifts, but you can define your own, if necessary. 

• Recipients — which determine to whom the message will be sent. 

When creating alerts, you must associate existing keys (and time shifts, if necessary) with the alert. 
You should, therefore, define your keys and time shifts before creating your alerts. 

Note: Recipients must be defined in WirelessOffice Administrator before you can define 
Alarm Messenger alerts. 
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'HILQLQJ�.H\V�

An alert will only be processed if one or more keys are defined and associated with it. Alarm 
Messenger searches the data stream for data that matches the criteria in any of an alert’s defined 
keys. Keys are common resources and can be associated with multiple alerts.  

To ensure that the application recognizes each alert accurately, you must enter detailed information 
about each key; including its data type, start and end of input location, type of comparison 
(operator), and the actual data for comparison. Alarm Messenger extracts an input string from the 
data stream to use for the comparison. When a match exists for all keys associated with an alert, 
Alarm Messenger initiates the appropriate message. 

� 7R�GHILQH�NH\V� 

1. Click the  icon on the toolbar or click File and select New and then Key.  

The Key Properties - Add dialog box displays: 

2. Type a unique identifier for the key in the Key Name box. To simplify administration of your 
system, we recommend that you make the Key Name the same as the data used for 
comparison. 

3. In the Key Type list box, select the data type for the key: Alphanumeric or Numeric. 

4. In the Start and End fields (in the Location in Input area) enter the starting and ending 
character positions within the data stream where the data associated with this key is located. 

Note: In the Port Monitor you can highlight desired Key content and click the Copy 
Range button. To paste these values into the Start and End fields of the Key 
Properties – Add dialog select Paste Range.  

Also, you can quickly designate keys from within the Port Monitor. Let your 
incoming data stream start, freeze the screens where you need to define keys. Copy 
the range for a new key and then click the Create New Key button to automatically 
create a key with the selected information and character range. 
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5. Select the appropriate Operator from the list box to reflect the type of comparison to be 
performed between the selected input string and the key. Alphanumeric keys are not case 
sensitive.  

The valid operators are described below: 

Operator Description 

Exact match The input string is equal to the key (alphanumeric and numeric). 

No match The input string is not equal to the key (alphanumeric and numeric). 

Found in field The key data is contained in the input string (alphanumeric and 
numeric). 

Not found in field The key data is not contained in the input string (alphanumeric only). 

Less than The input string is less than the key (numeric only). 

Less than or equal The input string is less than or equal to the key (numeric only). 

Greater than The input string is greater than the key (numeric only) 

Greater than or equal The input string is greater than or equal to the key (numeric only). 

 

6. In the Data for Comparison area, type the actual data you want Alarm Messenger to compare 
the input string with in the Entry text box. 

7. Click Apply to save your new key and repeat these steps for any additional keys you may 
define. Or click OK to save your new key and exit. 

'HILQLQJ�7LPH�6KLIWV�

Like keys, time shifts are common resources that can be associated with multiple alerts. Their 
attributes consist of the name of the time shift, the month and day the shift is applicable, and the 
starting and ending times for the shift. Alarm Messenger provides predefined time shifts; however, 
you can define your own, if necessary. The predefined time shifts include: 

Predefined Time Shifts Description 

1st Shift Every month, weekdays, from 9:00 AM to 5:00 PM 

2nd Shift Every month, weekdays, from 5:00 PM to 1:00 AM 

3rd Shift Every month, weekdays, from 1:00 AM to 9:00 AM 

Always Every month, every day, all day 

Weekend Every month, weekends, all day 

 

If you want an alert to be processed differently based on a time range other than those listed above, 
you must define a new time shift. A time shift starts at the indicated time, and is valid until (and 
including) the specified end time. If an alertable event occurs outside the time defined by the 
alert’s time shift, no alert is sent. Time shifts are associated with messages, and an alert can have 
up to twenty messages. Therefore, if you want different messages to be sent during different time 
shifts (or if you want a message to be sent to a different recipient during different time shifts) you 
must create multiple messages for the same alert. 
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� 7R�GHILQH�WLPH�VKLIWV��

1. Click the  button on the toolbar or click File, select New and then Time Shift.  

The Time Shift - Add dialog box displays: 

2. Enter a unique name in the Shift Name text box. 

3. In the Month list box, select a month for which the time shift applies, or select Every month. 

4. To indicate the active days, select Day of Week and select from the list box: Every day, 
Weekdays, Weekends, Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, or 
Saturday. 

5. To indicate that the time shift only applies for a specific day of the month, select Specific 
Date and enter the day of the month (1 through 31). 

6. If the time shift you are defining is a 24-hour period, select All Day. 

7. To select a range of hours, select Specific Hours and enter the Start and End times for the 
time shift. 

8. Click Apply to save your new time shift and define another. Or click OK to exit and save 
your new time shift. 
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&RQILJXULQJ�$OHUWV�

Now that you have your COM ports, keys and time shifts defined, you can define your alerts. For 
each event you want a message sent, you must define a unique alert. In order to incorporate server-
defined recipients into your alert, they must first be defined in WirelessOffice Administrator. 

� 7R�FUHDWH�D�QHZ�DOHUW� 

1. Click the  icon on the toolbar or click File, select New, and then Alert.  

 The Alert Wizard – Step One dialog displays: 

2. Type a unique Name for the alert, then select a COM port. 

3. To allow Alarm Messenger to monitor ports for the alert, click Enabled in the Status area. To 
prevent Alarm Messenger from monitoring ports for the alert, click Disabled. 

4. In the Ports area, edit the serial (COM) port that Alarm Messenger should monitor for the 
current alert. If the event is associated with more than one port, select All Ports . 

5. Response area information is optional and is implemented if your monitoring equipment is 
either expecting or can respond to Alarm Messenger input. Use the Entry  box to enter ASCII 
text and/or control characters in the form ‘\nn’, where nn is a hexadecimal number 0-FF and 
view the hexadecimal conversion in the Result box. If you type \0D\0A in the Entry text box, 
the Result will depict;. Click Next.  
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The Alert Wizard – Step Two dialog displays: 

6. Find the desired key in the list of Available Keys, select it, and click the Add button (or 
double-click on the desired key). The selected key moves from the Available Keys list to the 
Selected Keys list. 

Note: If you realize that you need a key that has not yet been defined, you can click on the 
Create New Key icon to access the Key Properties - Add dialog. 

  

7. If you want to add more keys to this alert, select the operator Or  or And to specify how 
subsequent keys are to be used for this alert. Then select the additional key. If required, repeat 
this step for additional keys. 

8. To delete a key from the alert, select the key in the Selected Keys list and click Remove. The 
key will move from the Selected Keys list to the Available Keys list. Click Next.  

 The Alert Wizard – Step Three dialog displays: 

9. Select Entire Input  if you want to send the data stream as it is to the message recipient(s). 

10. Select Custom Message if you want to create your own message, with or without elements of 
the data stream. In the Custom Message text box, type the alert message. If you want the 
message to contain data stream (extracted data) information enclose the starting and ending 
character positions of the data in less-than and greater-than symbols.  

For example: If you wanted a security alert to indicate which door is open, you could create a 
custom message such as “Door #<10,15> is open. Please investigate”. 

Create New Key 
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11. Select Canned Message if you want to use one of the canned messages. Select the message 
from the Canned Message list box.  

12. To add a canned message to the list, click the Add button. The Add Canned Message dialog 
box displays. Enter your new canned message, then click OK. To remove a canned message, 
click the Remove button. The canned message removal will be confirmed. 

13. In the Time Shift list box, select a pre-defined time shift by name. If you have no need to use 
time shifts, select Always to cover all times. If you need a time shift that does not exist, you 
can add one now by clicking the New Time Shift button. The Time Shift - Add dialog box 
will appear. Please see “To define time shifts” on page 171 for instructions. Click Next.  

14. For the recipient type of the Alert Wizard – Step Four dialog, choose either Select 
recipient(s) from WirelessOffice Server or Extract Pager ID from input . If you choose to 
extract the pager ID, the next dialog will instruct you to type the Start and End positions of 
the pager ID and to select a pre-configured carrier. 

 The Alert Wizard – Step Five dialog displays:  

15. Select the desired server-defined recipients from the Directory list. To make your selection, 
click once on the entry and then click the >> button, or simply double-click the entry to move 
it into the Recipients list.  Repeat this step for each recipient/group/department to receive the 
message. To remove a recipient, click the recipient name and then click the << button. 

Note: The Recipients list reflects the access and security rights of Alarm Messenger’s 
login account.  

 

16. Click Use Escalation if you would like the message to be sent to a series of recipients. An 
alert will be sent to all recipients defined for Level 1. After the designated time interval, the 
next level of recipients will be sent the message, etc. until the escalated message is cancelled 
or runs its course to the final level. 

17. Select the No. of Levels  (up to 5) for the alert to be sent to. Click Advanced to configure the 
escalated message to be repeatedly sent to the last level of recipient(s) until escalation is 
cancelled. 
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The Advanced Escalation Properties dialog displays: 

18. Select Repeat last escalation level. Select Repeat x time(s), choosing a number between 1 
and 254 representing the number of times to repeat the last escalation level. Or select Repeat 
until cancelled which will infinitely repeat the message until it is cancelled. 

19. If you have selected Use Escalation, you will need to define recipients for all escalation 
levels. Select the Level number and Time Interval and then define your recipients for that 
level. Continue until all levels have been defined. Time Interval (23 hours, 59 minutes and 59 
seconds) reflects the wait time until sending the message to the next level. Please see 
“Viewing and Canceling Escalated Messages” on page 182. Click Finish. 

0RGLI\LQJ�$OHUWV�

You can modify any component of an alert after it has initially been configured, including the alert 
itself, the keys associated with it, time shifts, recipients, escalation levels, and time intervals. 

� 7R�PRGLI\�DQ�DOHUW��

1. Select the alert to modify and click the  icon on the toolbar or double-click the specific 
alert name from the Alert List View.  

The Alert Properties - Modify dialog box displays: 

2. Click the Alert tab. Edit the alert name in the Name field. Click Enabled or Disabled in the 
Status area. 
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Note: You can stop Alarm Messenger from sending messages for a specific alert by setting 
its status to Disabled. For example, if a machine’s temperature increases but the 
machine must continue to work until it is repaired later in the day, the alert can be 
disabled temporarily. 

 

3. In the Ports area, edit the serial (COM) port that Alarm Messenger should monitor for the 
current alert. If the event is associated with more than one port, select All Ports. 

4. Edit the Response entry if necessary. This field sends response information to the monitoring 
equipment. Use the Entry box to enter ASCII text and/or control characters in the form ‘\nn’, 
where nn is a hexadecimal number 0-FF and view the hexadecimal conversion in the Result 
box. If you type \0D\0A in the Entry text box, the Result will depict;. 

�� � 7R�PRGLI\�DOHUW�NH\V��
1. In the Alert Properties - Modify dialog box, click the Keys tab.  

2. Edit the Selected Keys as needed. If a new key needs to be created, click the Create New 
Key icon above the Available Keys area. Please see “To define keys” on page 169. 

3. Ensure that the correct Or or And operator is being used. Click Apply to incorporate your 
changes. 

� 7R�PRGLI\�DQ�DOHUW�PHVVDJH��
1. In the Alert Properties - Modify dialog, click the Messages tab. Select the message you wish 

to edit and click Properties. You may also choose to Add or Delete messages.  

The Message Properties dialog box displays: 

2. Select either Entire Input, Custom Message or Canned Message to be sent. Type 
appropriate message content if a Custom Message is selected. 

3. Select the appropriate Time Shift or click the New Time Shift button to create a custom shift. 
Please see “Configuring Alerts” on page 172 for more detailed instructions. Click OK to save 
your message assignment.  
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� 7R�PRGLI\�DOHUW�UHFLSLHQWV�
1. In the Message Properties dialog box, click the Recipients tab. 

The Recipients tab dialog displays: 

2. Select either Extract Pager ID from input or Select Recipients. 

3. To extract pager ID information, type the Start and End character positions and then select 
the Carrier from the drop-down list. 

4. Select or remove recipients to receive the alert message using the >> and << keys or by 
double-clicking the recipient name. If you need to update recipients for all alerts, use the 
Recipient Validation feature. Please see “Recipient Validation” on page 184. 

5. Select Use Escalation to send messages to a series of different recipient levels. Adjust the No. 
of Levels to escalate (up to 5). If you wish to have the last level repeated for a configurable 
number of times, select the Advanced button. Select Repeat last escalation level. Select 
either Repeat x time(s), choosing a number between 1 and 254 representing the number of 
times to repeat the last escalation level. Or select Repeat until cancelled which will infinitely 
repeat the message until it is cancelled. 

6. Detail recipient(s) for each Level. Set the Time Interval between each message level sending. 
For detailed information on how to configure recipients and escalation, please see 
“Configuring Alerts” on page 172. 

7. Click OK to exit. 
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2SHUDWLQJ�DQG�0DLQWDLQLQJ�$ODUP�0HVVHQJHU�

This section shows you how to send a test message; start and stop Alarm Messenger processing; 
monitor COM ports; run various Alarm Messenger simulations to learn more about its capabilities; 
view, cancel and escalate “escalated” messages, modify alerts, keys, messages, time shifts, and 
recipients; update invalid recipients; maintain log files; maintain the database; assign sound events 
and review performance considerations. 

6HQGLQJ�D�7HVW�0HVVDJH�

� 7R�VHQG�D�WHVW�PHVVDJH��
This task assumes that recipients have been defined in WirelessOffice Administrator.  

1. Click the  icon on the toolbar or use the keyboard shortcut command by simultaneously 
pressing the CTRL+S keys or select Tools from the menu bar and then select Send Test 
Message. 

The Send Test Message dialog displays: 

2. You may choose to use the default message, which requires no input from you, or you may 
enter a custom message in the Message text box. 

3. To select the user from those stored in the server database, click To and select the recipient 
name from the list. 

4. To select the recipient by PIN and carrier, click the  (FastPIN) button.  Enter the 
recipient’s PIN number in the PIN text box and select their carrier from the drop-down server-
defined Carrier list. 

5. Click the Send button to have the message transmitted, or click Cancel to close the dialog box 
without sending the message. 

FastPIN 
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6WDUWLQJ�DQG�6WRSSLQJ�,QSXW�3URFHVVLQJ�

Depending on your startup mode, you may need to manually start Alarm Messenger. 

� 7R�VWDUW�RU�VWRS�$ODUP�0HVVHQJHU��

1. Click the appropriate button:  or  on the toolbar or select Run from the menu bar and 
choose either Start or Stop. 

2. Alarm Messenger will start or stop processing incoming data from the COM port(s). When 
started, you should see the data stream in the Port Monitor. When alerts are detected, 
messages will be sent. When stopped, no incoming data will be processed and no messages 
will be sent. 

0RQLWRULQJ�&20�3RUWV�

Alarm Messenger provides a Port Monitor that lets you monitor the real-time data being read from 
any of the COM ports defined in your system. If you are running an Alarm Messenger 
demonstration, the Port Monitor displays the simulated data. Do not leave Port Monitor open. 

� 7R�PRQLWRU�&20�SRUWV��

1. Selelct View and then Port Monitor or click the  button on the toolbar. 

2. Select View from the Port Monitor menu bar, select Port, and then select the COM port you 
wish to monitor. 

3. The data being read from the selected COM port begins to display in the Port Monitor on the 
Alarm Messenger window. 

4. This feature is especially useful when defining your alerts and their keys. You can use the 
Create New Key and Copy Range options in the Port Monitor to capture starting and ending 
character positions of the data elements in the data stream coming from your monitoring 
equipment. Please see “To define keys” on page 169 for more information. 

�� 7KH�3RUW�0RQLWRU�:LQGRZ�
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�� 7KH�3RUW�0RQLWRU�7RROEDU�

 

The following table depicts the Port Monitor toolbar and a description of each button: 

Icons Description Icons Description 

 Freeze Mode  Copy selected text range  

 
Translate Mode changes invisible 
characters into numeric equivalent   Font Properties 

 Clear the window  
Save Port Monitor view to text or csv 
file 

 Define New Key based on selection   Close Window 

5XQQLQJ�'HPRQVWUDWLRQV�

Alarm Messenger provides a variety of demonstrations that you can use to create alerts and keys, 
test your data, conduct a training course, or demonstrate the software to show what happens when 
alerts are detected. 

The following types of demos are included:  

• Health, 
• Manufacturing,  
• Dispatch, 
• Information Systems, and 
• User Defined.  

 

Note: The User Defined option lets you run your own demo. You can create your own 
sample data in a DEM file using any text editor. User Defined mode accesses your 
DEM file in C:\Program Files\Emergin WirelessOffice. 

� 7R�UXQ�DQ�$ODUP�0HVVHQJHU�GHPRQVWUDWLRQ��
1. Stop the Alarm Messenger service by clicking the Stop icon on the toolbar. 

2. Select Run from the menu bar and select Demo. The Demonstration Settings dialog 
displays. 

3. Select a Demo Type (industry types are listed above). You can adjust the Data event 
interval. One second adds a new entry every second.  

4. Click the Start button. Notice the information reported in the Status Bar as well as the Alarm 
Messenger - Port Monitor dialog. To open it, click the Port Monitor toolbar icon or click 
View and select Port Monitor. 

5. Click the Stop icon on the toolbar when you want to stop the demonstration. 
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9LHZLQJ�DQG�&DQFHOLQJ�(VFDODWHG�0HVVDJHV�

Alarm Messenger allows you to send, cancel and “escalate” escalated messages. Escalated 
messages are set up in the recipient dialog of the Alert configuration. They are intended to ensure 
that important events are properly taken care of by continuing to escalate a message until it runs its 
course or is cancelled in Alarm Messenger, WirelessOffice Administrator, Web Messenger or via a 
two-way wireless device implementing E-mail Messenger. 

�� � 7R�YLHZ�HVFDODWHG�PHVVDJHV��

1. Select View and then Escalation View, or click the  button on the toolbar. 

The Escalated View dialog displays: 

2. To review an escalated message’s properties, double-click the specific message. 

The Message Escalation Properties dialog displays:  

3. Click the Properties tab to review the owner, Escalation ID, current level, number of levels, 
status, next escalation time, message origination time, and message text. 

4. Click the Recipients tab to view the recipients for each level. Double-click the level to open 
up and view the recipient list. If message is active, the current level of recipients will display. 

5. Click the Escalate button to immediately escalate the message to the next level. Click the 
Cancel button to cancel the escalation. See “To cancel escalated messages” and “To escalate 
an escalated message” on the next page for more information. 

Note: Alarm Messenger can auto-open the Escalation View whenever an escalated 
message is sent. Please see “To configure the Escalation View” on page 165. Alarm 
Messenger can also be configured to use sound notification for escalation events. 
Please see “Sound Events” on page 186. 
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�� � 7R�FDQFHO�HVFDODWHG�PHVVDJHV��
You can cancel a message before it has completed its series of messaging levels using four 
different methods: 

• Select the specific message in the Alarm Messenger Escalation View, right-click and select 
Cancel or click the Cancel icon on the Escalation View toolbar. You can also double-click 
the message to view the Message Escalation Properties dialog and click the Cancel button.  
The message will be cancelled and no further levels will be escalated to and sent messages 
for. Canceling a message signifies that the message has been appropriately responded to and 
does not need to alert any other recipients on the escalation level list. After selecting Cancel, a 
message will ask if you would like to notify previous recipients. If ‘Yes’ is selected, a 
message will be sent to all previous level recipients stating that the message was cancelled and 
by whom. 

• In WirelessOffice Administrator, click the Escalated Messages tab and select the specific 
message. Right-click and select Cancel. You can also double-click the message to view the 
Message Escalation Properties dialog. On the Properties tab, click Cancel.   

• Two-way wireless device response implementing E-mail Messenger. Please see “Cancellation 
and Escalation” on page 125. 

• In Web Messenger, if the escalation tab is enabled, web clients can use the Escalation ID 
number to cancel messages. Please see “Cancellation and Escalation” on page 137. 

�� � 7R�HVFDODWH�DQ�HVFDODWHG�PHVVDJH��
 
You can escalate a message to send earlier than its scheduled time using four different methods: 

 
• Select the specific message in the Alarm Messenger Escalation View, right-click and select 

Escalate or click the Escalate icon on the Escalation View toolbar. You can also double-click 
the message to view the Message Escalation Properties dialog and click the Escalate button. 
The escalated message will be upgraded to the next level status and the message will be 
immediately sent to the predefined recipients. Any levels beyond the current one will be 
escalated as well. The next level is rescheduled for the current time plus the originally defined 
Time Interval. 

• In WirelessOffice Administrator, click the Escalated Messages tab and select the specific 
message. Right-click and select Escalate. You can also double-click the message to view the 
Message Escalation Properties dialog. On the Properties tab, click Escalate. 

• Two-way wireless device response implementing E-mail Messenger. Please see “Cancellation 
and Escalation” on page 125.  

• In Web Messenger, if the escalated message tab is enabled, web clients can use the Escalation 
ID number to escalate messages. Please see “Cancellation and Escalation” on page 137. 
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�� 7KH�(VFDODWLRQ�9LHZ�7RROEDU�

 

The following table depicts the Escalation View toolbar and a description of each button: 

Icons Description  Icons Description 

 Escalated message properties   Refreshes the view  

 
Manually escalates the 
message to the next level 

 
 

Save Escalation View to text or 
csv file 

 
Cancels an escalated message 
from sending to further levels 

 
 Prints Escalation View 

 Clear the window   Close Window 

0RGLI\LQJ�2EMHFWV�LQ�$ODUP�0HVVHQJHU�

You may need to change the properties of a defined alert when the data stream from your 
monitoring equipment changes, if a recipient or message must change, or if you want to add more 
functionality to an alert. You can modify alerts, keys, messages, time shifts, and COM ports 
directly from the Tree View of the Alarm Messenger window. To update Alarm Messenger 
recipients against the server, please see “Recipient Validation” on the next page. 

1. To modify an alert, key, message, time shift, recipient, or port, select the desired object in the 
Tree View on the Alarm Messenger window. 

2. Click the  icon on the toolbar, or double-click the object in the Tree View (or in the List 
View) or select Edit on the menu bar, then select Properties. The appropriate modify dialog 
box will appear.  

'HOHWLQJ�2EMHFWV�LQ�$ODUP�0HVVHQJHU�

If you no longer need an alert, key, message, time shift, recipient, or COM port in your system, 
you can delete the object directly from the Tree View on the Alarm Messenger window. 

1. To delete an alert, key, message, time shift, or port, select the desired object in the Tree View 
on the Alarm Messenger window. Recipients must be opened to their Properties dialog and 
deleted there. 

2. Click the  icon on the toolbar or select Edit on the menu bar, then select Delete or press 
the Delete key.  An Alarm Messenger message box appears asking you to confirm your 
request to delete the object. Click Yes to delete the object. 
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5HFLSLHQW�9DOLGDWLRQ�

This feature performs a scan of all configured alerts and checks for invalid recipients. A recipient 
becomes invalid if it is deleted from the WirelessOffice Server, but is still in use by Alarm 
Messenger. The log results depict the alert name, time shift and recipient name involved. 

� 7R�YDOLGDWH�DOHUW�UHFLSLHQWV��
1. Select Tools from the menu, then click Recipient Validation. 

2. Press Start to begin. When the operation is complete, press View Log to view the results. 

0DLQWDLQLQJ�/RJ�)LOHV�

Alarm Messenger creates log files that you can view or print to help you monitor system 
performance, identify potential problem areas, and provide troubleshooting assistance. You can 
also export log views to a comma-delimited file for troubleshooting analysis. 

Alarm Messenger allows you to display three types of log views: 

• Message Log —records the outgoing messages sent to recipients when an alert was detected. 
It also shows message status (queued, successfully sent, etc.). Please see “Message Log status 
icons” in the Using WirelessOffice Administrator chapter for information on message status. 

• Rules Log —records information about each event that matches a defined alert. It also records 
significant Alarm Messenger events such as starting and stopping operations and modifying 
ports and the database. 

• Activity Log —lists the date, time, and a description of errors that occurred in the system. 

Note: The maximum size of each log file defaults to 128 KB, which is usually more than a 
sufficient amount of data. 

� 7R�YLHZ�ORJ�ILOHV��
1. In the Tab View on the Alarm Messenger window, select the log you wish to view (Message 

Log, Rules Log, or Activity Log). 

2. As you are viewing the log file, new entries may be appended. To make sure you are viewing 
the latest entries, select View on the menu bar and then choose Refresh. 
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� 7R�SULQW�ORJ�ILOHV��
You can print the contents of any log. You may want to print your log files before purging them. 

1. Select the desired Log in the Tab View on the Alarm Messenger window. 

2. Select File from the menu bar, then select Print or simultaneously press the CTRL+P keys. 
The Print Setup dialog box displays. Provide the appropriate printer requirements. Click OK 
to print. 

� 7R�H[SRUW�ORJ�YLHZV�WR�D�ILOH��
You can export the contents of any log to a comma-delimited (CSV) file. You may want to export 
and save your log files before purging them. 

1. Select the desired Log in the Tab View on the Alarm Messenger window. 

2. Right-click and select Save As. In the Save as type field, select the CSV format. Choose the 
folder destination to save the log then click Save.  

�� � 7R�FOHDU�ORJ�ILOHV��
When your Activity Log or Rules Log becomes full, or any time you want to clear either log file, 
perform the following procedure: 

1. Select the desired Log in the Tab View on the Alarm Messenger window. 

2. Select Edit from the menu bar, then select Delete All or right-click any log entry in the Tab 
View on the Alarm Messenger window. A context menu will appear. Select the Clear All 
option to purge all entries from the log file. 

0DLQWDLQLQJ�WKH�'DWDEDVH�

Alarm Messenger provides an easy method for maintaining the system database, which contains 
your defined alerts, keys, messages, etc. This includes performing routine backups and restoring 
the current database with a backup copy. Routine backups are recommended. 

� 7R�EDFN�XS�WKH�GDWDEDVH��
 

Note: Always stop Alarm Messenger first, then stop WirelessOffice prior to performing 
the backup. 

 

1. Click the  icon on the toolbar or enter the keyboard command by simultaneously pressing 
the CTRL+B keys or from the File menu, select Database, then Backup. 

2. Select the name and location for the backup database to be stored. 

3. The Alarm Messenger database parameters are stored at the specified location. 
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� 7R�UHVWRUH�WKH�GDWDEDVH��
Restore allows you to replace the current database with a backup copy. This should only be done 
when the current database has been corrupted, destroyed, or has become obsolete. Restore 
permanently overwrites the current database and cannot be undone. 

Note: Always stop Alarm Messenger first, then stop WirelessOffice prior to performing 
the restoration. 

 

1. Click the  icon on the toolbar or enter the keyboard command by simultaneously pressing 
the CTRL+R keys or from the File menu, select Database, then Restore. 

2. Select the name and location where the Alarm Messenger parameters database can be 
retrieved. 

3. The Alarm Messenger database parameters are restored and will be executed the next time 
Alarm Messenger is launched. 

6RXQG�(YHQWV�

You can receive audio notification of certain events that occur in Alarm Messenger.  

� 7R�DFWLYDWH�VRXQG�HYHQWV��
1. Click Start from the taskbar, select Settings then Control Panel. Click the Sounds icon. The 

Sounds Properties dialog displays. 

2. Highlight the Alarm Messenger event(s) to associate with audio notification. Events include 
message cancelled, message escalated, message response, and new escalated message. 

3. In the Sound area, click the Browse button to select your sound choice. Click OK. 

3HUIRUPDQFH�&RQVLGHUDWLRQV�

Depending on your monitoring traffic, the system’s performance may appear to diminish. If you 
believe your system is slow, consider the following ways to improve its performance: 

• Increase RAM from 64 MB or 128 MB or greater. 

• Run Alarm Messenger on its own computer. 

• If you use the Port Monitor, remember that it is intended for diagnostic use, and can 
affect system performance if left open. 

• Run multiple Alarm Messengers on different computers to balance the traffic load. 

• If sending more than 100 escalated messages at one time, increase clock speed and 
system RAM. 
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$SSHQGL[�$��$GPLQLVWUDWRU�7RROV 

The WirelessOffice suite of products includes Administrator Tools, which allow you to upgrade 
previous versions of Air Apparent, Site Alert, WirelessOffice and SitePage databases to a format 
compatible with WirelessOffice Server 3.0 and Alarm Messenger 3.0. A wizard for exporting a 
WirelessOffice Server Microsoft Access database to Microsoft SQL Server is also included. The 
upgrade and conversion tools are installed on your system when you choose to install them from 
the Administrator Tools option in the Components dialog box. Please see “Installing 
WirelessOffice” on page 8.  

The Administrator Tools utility contains a variety of useful features: 

• Acrobat Reader Installer 

• Database Upgrade Tool 

• Alarm Messenger Upgrade Tool 

• SQL Server Upsizing Wizard 

• SQL Support Notes 

 

Note: The upgrade and conversion tools run within the Access 97 Runtime environment, 
which is installed along with the tools.  There is no need for a separate installation of 
Microsoft (MS) Access.  Moreover, the runtime environment installed with the 
upgrade tools does not interfere with any previous or later versions of MS Access on 
your system, and does not reassign the associations of your current Access databases 
to use the runtime version as opposed to the full version of MS Access.  The runtime 
version of MS Access will only be invoked when you choose to launch the upgrade 
tools from the Start | Programs | Emergin WirelessOffice | Administrator Tools 
menu. 
 

Note: WirelessOffice Server 2.0 and SitePage 2.0 do NOT require the use of the 
Administrator upgrade tools in order for WirelessOffice 3.0 to install and upgrade 
properly from version 2.0. If you upgrade your database using the Installation 
Wizard you will not have the option to convert the database again using these tools. 
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8VLQJ�WKH�'DWDEDVH�8SJUDGH�7RRO�
The WirelessOffice database upgrade can be launched by selecting Database Upgrade Tool from 
the Administrator Tools folder in the Emergin WirelessOffice program group.  This will launch 
the Access runtime environment and load the Access form that governs the upgrade tool. Air 
Apparent NT, Air Apparent OS/2, and WirelessOffice 2.0 can be upgraded using this tool. When 
upgrading, first make a backup of your original database(s). Install the new software and then use 
the database upgrade tool. The upgrade tool will automatically place the newly converted database 
in the correct system folder. 

�� 'DWDEDVH�8SJUDGH�,QIRUPDWLRQ�

• The conversion routine does not change the Access database version.  For example, 
converting a Version 1.1 database does not convert its format from Access 95 to Access 97, it 
simply alters the table structure to allow the database to work with WirelessOffice. 

• The WirelessOffice database tools are not copied into the converted database. 
• The database must be writeable before converting. 
• Make a backup copy of air.mdb or wirelessoffice20.mdb before converting. 
• The database to be converted should be on a local or network drive, not a floppy drive. 

8SJUDGLQJ�$LU�$SSDUHQW�17�

This option upgrades a database from a previous version of Air Apparent NT to WirelessOffice 
3.0.  This procedure does not import data into the current database; it alters the structure of the 
previous database to match WirelessOffice.  No data is lost, but the database will no longer work 
with versions of Air Apparent. 

� 7R�XSJUDGH�$LU�$SSDUHQW�17��
1. Select the Air Apparent NT button. The Air Apparent NT Upgrade dialog displays. Click 

Next. 

2. The Select Air Apparent Database to Upgrade dialog box displays. Select the file location 
of your Air Apparent database (air.mdb) and click OK. 
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3. The conversion tool will determine the version of the selected database and convert its 
structure to WirelessOffice version 3.0 format.  Any errors or warnings will appear as 
message boxes. 

4. You may then start WirelessOffice Administrator and see the converted database in place. If 
the old database displays or the database is unable to open, you will need to enter the ODBC 
to switch WirelessOffice databases. Exit WirelessOffice. 

5. Click Start, then Settings, then Control Panel. Select ODBC Data Sources. You should see 
the old and new databases listed on the System DSN tab. Select the new database, 
WirelessOffice 3.0. Exit Control Panel. 

6. Re-open WirelessOffice Administrator. 

8SJUDGLQJ�$LU�$SSDUHQW�26����

This option allows users of Air Apparent for OS/2 to upgrade their existing OS/2 database to a 
format compliant with WirelessOffice 3.0.  The database to be converted should be on a local or 
network drive, not a floppy drive. Data from the OS/2 database will be added to the current 
WirelessOffice database.       

� 7R�XSJUDGH�$LU�$SSDUHQW�IRU�26�����
1. Select the Air Apparent OS/2 button. 

2. In the Air Apparent OS/2 Upgrade dialog, click Next to upgrade. The Browse for Folder 
dialog displays. 

3. Select the folder containing the Air Apparent OS/2 database files (it can be local or network). 
Click OK to start the database upgrade. 

4. You will be notified of any database errors and warnings with popup dialogs. 

5. You may then start WirelessOffice Administrator and see the converted database in place. If 
the old database displays or the database is unable to open, you will need to enter the ODBC 
to switch WirelessOffice databases. Please refer to Steps 4-6 in the preceding section above 
“To upgrade Air Apparent NT”. 

8SJUDGLQJ�:LUHOHVV2IILFH�����

This option allows users of WirelessOffice 2.0 to manually convert their existing database to a 
format compliant with WirelessOffice 3.0. This procedure does not import data into the current 
database; it alters the structure of the previous database to match WirelessOffice 3.0.  No data is 
lost, but the database will no longer work with WirelessOffice 2.0.  

Note: The WirelessOffice 3.0 Installation Wizard will automatically upgrade 
WirelessOffice 2.0 and SitePage 2.0 databases to a compatible format.  

�
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� 7R�XSJUDGH�:LUHOHVV2IILFH������
1. Select the WirelessOffice button. The WirelessOffice Upgrade dialog displays. Click Next. 

2. The Select WirelessOffice Database to Upgrade dialog box displays. Select the file location 
of your database (wirelessoffice20.mdb) and click OK. 

3. The conversion tool will determine the version of the selected database and convert its 
structure to WirelessOffice version 3.0 format.  Any errors or warnings will appear as 
message boxes. 

4. You may then start WirelessOffice Administrator and see the converted database in place. If 
the old database displays or the database is unable to open, you will need to enter the ODBC 
to switch WirelessOffice databases. Please refer to Steps 4-6 in the preceding section “To 
upgrade Air Apparent NT” on page 189. 

8VLQJ�WKH�$ODUP�0HVVHQJHU�8SJUDGH�7RRO�
The Alarm Messenger upgrade tools can be launched by selecting Alarm Messenger Upgrade 
Tool from the Administrator Tools folder in the Emergin WirelessOffice program group.  This 
will launch the Access runtime environment and load the Access form that governs the Alarm 
Messenger upgrade tools.  When upgrading, first make a backup of your original database(s). 
Install the new software and then use the database upgrade tool.  

�� $ODUP�0HVVHQJHU�8SJUDGH�,QIRUPDWLRQ��

• The conversion routine does not change the Access database version.  For example, 
converting a Version 1.1 database does not convert its format from Access 95 to Access 97, it 
simply alters the table structure to allow the database to work with Alarm Messenger. 

• The Alarm Messenger upgrade tools are not copied into the converted database. 
• The database must be writeable before converting. 
• Make a backup copy of sitealrt.mdb or sitepage20.mdb before converting.  
• The database to be converted should be on a local or network drive, not a floppy drive. 
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8SJUDGLQJ�6LWH�$OHUW�17�

This option upgrades a database from a previous version of Site Alert NT to Alarm Messenger 3.0.  
This procedure does not import data into the current database; it alters the structure of the previous 
database to match Alarm Messenger. 

� 7R�XSJUDGH�6LWH�$OHUW�17��
1. Select the Site Alert NT button from the Alarm Messenger Database Upgrade window. The 

Site Alert NT Upgrade dialog box displays.   

2. Click Next to bring up the standard file Open dialog.  Select the location of your Site Alert 
NT database (sitealrt.mdb) and click OK. 

3. The upgrade tool will determine the version of the selected database and convert your Site 
Alert NT database structure to Alarm Messenger format.  Any errors or warnings will appear 
as message boxes. 

4. You may then start Alarm Messenger and see the converted database in place. 

8SJUDGLQJ�6LWH�$OHUW�26����

This option allows users of Site Alert for OS/2 to convert their existing OS/2 database to a format 
compliant with Alarm Messenger 3.0.  The database to be converted should be on a local or 
network drive, not a floppy drive. Data from the OS/2 database will be added to the current Alarm 
Messenger database.       

� 7R�XSJUDGH�6LWH�$OHUW�26�����
1. Select the Site Alert OS/2 button from the Alarm Messenger Database Upgrade window.  

2. The Site Alert OS/2 Upgrade window displays. Click Next. The Browse for Folder dialog 
displays. 

3. Select the folder containing the Site Alert OS/2 database files (it can be a local or network 
folder). Click OK to continue. The Select WirelessOffice Database dialog displays. 

4. Select the database location and click Open. 

5. You will be notified of any database errors and warnings with popup dialogs. 

6. You may then start Alarm Messenger and see the converted database in place. 

8SJUDGLQJ�6LWH3DJH�����

This option allows users of SitePage 2.0 to manually convert their existing database to a format 
compliant with Alarm Messenger 3.0. The database to be converted should be on a local or 
network drive, not a floppy drive. Data from the SitePage 2.0 database will be added to the current 
Alarm Messenger database. 

Note: The WirelessOffice 3.0 Installation Wizard will automatically upgrade 
WirelessOffice 2.0 and SitePage 2.0 databases to a compatible format.  



Appendix A: Administrator Tools 

   193

� 7R�XSJUDGH�6LWH3DJH������
1. Select the SitePage button from the Alarm Messenger Database Upgrade window. The 

SitePage Database Upgrade dialog box displays. 

2. Click Next to bring up the standard file open dialog.  Select the location of your SitePage 
database (sitepage20.mdb) and click OK. 

3. The upgrade tool will determine the version of the selected database and convert your 
SitePage database structure to Alarm Messenger 3.0 format.  Any errors or warnings will 
appear as message boxes. 

4. You may then start Alarm Messenger and see the converted database in place. 

64/�6HUYHU�'DWDEDVH�&RQYHUVLRQ�

This describes how to convert the WirelessOffice Miscrosoft Access database to Microsoft SQL 
Server.  There are two ways of setting up SQL Server for use with WirelessOffice.  The easiest 
way is to use the SQL Server Upsizing Wizard to export the WirelessOffice Access database to 
SQL Server.  The other way is to create an empty database using a script provided. 

Note: These instructions assume familiarity with the SQL Enterprise Manager and 
configuring ODBC data sources. 

:KHQ�WR�8VH�64/�6HUYHU�

The Access database for WirelessOffice 3.0 should offer sufficient performance for all but custom 
server installations. 

SQL Server is recommended for any of the following conditions: 

• The number of users exceeds 3000. 

• The number of messages stored in the database exceeds 1500. 

• More than 200 clients are routinely connected to the server. 

8VLQJ�WKH�8SVL]LQJ�:L]DUG�

The Upsizing Wizard is a Microsoft tool to export Access 97 databases to SQL Server.  With the 
tool, any Access database (including its data, indexes and relationships) can be transferred to SQL 
Server.  The Wizard is an Add-In for Access 97.  

Note: If you have Access 2000 and try to open the WirelessOffice30.mdb file, you will be 
prompted to convert its file format. This is OK. The database will still work with 
WirelessOffice. However, you will need to obtain the Upsizing Wizard for Access 
2000 (it is not included on the WirelessOffice CD). The Upsizing Wizard for Access 
2000 can be obtained from the Microsoft web site.  
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Requirements: 

• Microsoft SQL Server 6.5 or 7.0 

• Full version of Microsoft Access 97 and Upsizing Wizard for Access 97 

Note: The SQL Server does not have to be installed on the same system as the 
WirelessOffice 3.0 Server.  

If using SQL Server 7.0, do not use the DTS Wizard for importing data. The 
WirelessOffice table relationships are lost using the DTS import tool.  

� 7R�H[SRUW�WKH�$FFHVV�GDWDEDVH�WR�64/�6HUYHU��
1. Install Access 97 full version (required). Install WirelessOffice 3.0 (make sure Administrator 

Tools | Upsizing Wizard is installed on the same machine as Access 97).  

2. Launch Access 97.  Open the WirelessOffice database you wish to export. 

IMPORTANT: Hold down the SHIFT key while the database opens.  

3. From the Tools menu select Add-Ins then Upsize SQL Server. 

4. Follow the directions in the wizard to select the SQL Server.  You may be required to first 
create a file DSN to gain access to the SQL Server. If so, do not confuse this file DSN with 
the WirelessOffice DSN, which will be created in Step 6.  

a. Create New Database. Select Data Source Dialog. Click New. 

b. Create New Data Source Dialog. Scroll down and select SQL Server. Type DSN Name 
(can be anything). Click Next. Click Finish. 

c. Create a New Data Source to SQL Server Dialog. “How do you want to describe the data 
source?” - leave blank. “Which SQL Server do you want to connect to?” - choose the 
SQL Server that WirelessOffice will connect to. “How should SQL Server verify 
authenticity of login?” – choose “WinNT using Network login” or “With SQL Server 
Authentication” (preferred because this is required when changing Data Source in 
WirelessOffice.  Need to get the login/password from customer's SQL expert.) 

d. Leave defaults on the next screen. Click Next. Leave defaults on next screen. Click 
Finish. 

e. ODBC Microsoft SQL Server Setup.  Verify settings. Click Test Data Source. You 
should receive "Tests Completed Successfully". If not, check SQL password or if SQL 
has been stopped since File DSN entry was created. Click OK. Click OK. 

f. Select Data Source Dialog. Should see DSN entry in list now. Highlight it and click OK. 

g. SQL Server Login Dialog. Enter login/password. Click OK. 

h. Upsizing Wizard Dialog. Name the new SQL Server Database: WirelessOffice30. Click 
Next. “Which Tables do you want to export to SQL Server?” - select all. Click Next. 
Leave defaults on next screen. Click Next. Create report if needed (not required). Click 
Finish. 

i. Upsizing Wizard creates new SQL Database. Upsizing complete. 



Appendix A: Administrator Tools 

   195

Use the following options: 

Device Creation (pre-SQL 7.0 only): 

- Create a new data device called “WODATA”, 50 MB in size. 

- Use the same device for logging. 

5. When the Wizard has completed, close Access 97 and create an ODBC Data Source on the 
system running WirelessOffice 3.0. Click Start, then Settings, Control Panel, ODBC Data 
Sources. Using ODBC Data Source Administrator, create a System DSN using the 
following parameters: 

a. ODBC Data Source Admin Dialog. Click the System DSN tab, You should see 
WirelessOffice 3.0 already. Click Add. 

b. Create New Data Source Dialog. Scroll to SQL Server and click Finish. 

c. Create a New Data Source to SQL Server Dialog. “What name do you want to use to 
refer to...?” - type "WirelessOffice 3.0 SQL Server”. “Which SQL Server do you want to 
connect to?” - choose the SQL Server (local if SQL was installed on same machine). 

d. Create a New Data Source to SQL Server Dialog. Select either “WinNT authentication” 
or “SQL Server” (preferred). MUST CLICK CLIENT CONFIGURATION. 

e. Edit Network Library Configuration Dialog. Select TCP/IP and leave defaults. Click 
OK. 

f. Create a New Data Source to SQL Server dialog. Type SQL Server login/password. Click 
Next.  

g. Change default database to: WirelessOffice30. Deselect “Create temporary stored 
procedures for prepared SQL statements and drop the stored procedures”. Click Next. 
Leave defaults on the next screen. Click Finish. 

h. ODBC Microsoft SQL Server Setup Dialog. Click Test Data Source. Should get “Tests 
Completed Successfully”. Click OK. Click OK. ODBC Data Source Administrator 
Dialog. Click OK. 

Note: You may need to install the Client Utilities from your SQL Server CD if you 
need to change the network library used to communicate with SQL Server. 

  

6. Change the WirelessOffice Server data source: 

a. Start the WirelessOffice Server. 

b. Start the WirelessOffice Administrator and connect to the server. 

c. Click Tools from the menu bar and select Server Configuration. Select the Database 
tab. 

d. Select the “WirelessOffice3.0 SQL Server” from the Data Source Name area and provide 
a valid SQL Server Authentication User ID and Password. Click OK. 

e. Restart the WirelessOffice Server to begin using the new database. 
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� 7R�FUHDWH�DQ�HPSW\�GDWDEDVH�XVLQJ�WKH�VFULSW�SURYLGHG��
 Requirements: 

• WO30.SQL script (should exist in this directory) 

• Microsoft SQL Server 6.5 or 7.0 

1. Open the Microsoft SQL Enterprise Manager. 

2. Create a new Database Device (for pre-SQL 7.0 only): 

Name: WOData 

Size (MB): 50 (recommended) 

3. Create a new Database: 

Name: WirelessOffice30  

For SQL 6.5:  Data Device: WOData; Log Device: (none); Size (MB): 50 

For SQL 7.0:  Select Automatically grow file and select the default settings. 

4. Edit the "WirelessOffice30" database properties and set the following options in the Options 
dialog: 

• Select Into / Bulk Copy 

• Truncate Log on Checkpoint 

5. Create Database Schema: 

a. Open the SQL Query Tool (for SQL 6.5) or the Query Analyzer (for SQL 7.0). 

b. Switch to the WirelessOffice30 database in the "DB:" combo box. 

c. Load and execute the "WO30.sql" file. In SQL 6.5 you should see several messages 
reporting "Default bound to column". When finished, a "Complete" message should 
appear. 

d. At this point the database has been created and populated with the required tables and 
initial data.   

6. Create an ODBC Data Source on the system running WirelessOffice 3.0. Using ODBC Data 
Source Administrator, create a System DSN using the following parameters: 

Name: "WirelessOffice 3.0 SQL-Server" 

Server: <the name of your SQL Server> 

Network Address: default 

Network Library: default (TCP/IP is recommended) 

Database Name: "WirelessOffice30" 

Deselect Generate Stored Procedure for Prepared Statement 
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Note: You may need to install the Client Utilities from your SQL Server CD if you 
need to change the network library used to communicate with SQL Server. 

  

7. Change the WirelessOffice Server data source: 

a. Start the WirelessOffice Server. 

b. Start the WirelessOffice Administrator and connect to the server. 

c. Click Tools from the menu bar and select Server Configuration. Select the Database 
tab. 

d. Select “WirelessOffice 3.0 SQL Server” from the Data Source Name area and provide a 
valid SQL Server Authentication User ID and Password, and click OK. 

e. Restart the WirelessOffice Server to begin using the SQL database.
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$SSHQGL[�%��7URXEOHVKRRWLQJ�

This appendix lists some of the more common errors or problems that you may encounter when 
using WirelessOffice. For the most current and complete troubleshooting, please refer to our web 
site at www.emergin.com. The web site Knowledge Base includes Frequently Asked Questions 
(FAQs), Knowledge Base information, Resources and Troubleshooting. 

This section is broken down by WirelessOffice Server and component name and includes 
knowledge base information in the format of Problem and Solution with step-by-step instructions 
where applicable. 

�� :LUHOHVV2IILFH�$GPLQLVWUDWRU�

Reported Problem Solution 
Access denied error: Network client 
error “access denied”. 

In Windows 95/98 you need to be logged into Microsoft 
networking. 

Administrator not working: 
WirelessOffice Administrator is not 
able to run. 

Administrative rights are not set correctly for the system. You 
must be logged on with Administrative rights on the NT/2000 
domain, or locally to access WirelessOffice Administrator. 
Configure this on NT by going to Start | Programs | 
Administrative Tools (Common) | User Manager. 

Firewall ports: What TCP/IP port do I 
connect to for a firewall to open? 

The following ports are used with firewalls: 
To the Server: 1024+  - Dynamic port 
From the Server: Internet Java 1515 – Web Messenger 
12397 – WirelessOffice Administrator 
12398 – Alarm Messenger 
12396 – WirelessOffice Messenger 

Incorrect Authorization Code Entry: The Authorization Code may not be valid for the current 
version. E-mail support@emergin.com for assistance. 

No modem listed in Ports tab: 
Installed new modem driver in Control 
Panel, but modem does not show up 
when adding a new port. 

The WirelessOffice Server must be stopped and re-started. In 
WirelessOffice Administrator, click File | Change Server. The 
modem should now be available when adding the new Port. 

RPC Error Received: RPC Error 
Connecting (Error 1723, 1722, 1702 & 
1825). 

This is a service-specific error indicating that TCP/IP and a 
network card adapter may not be properly configured. If no 
network card is in place and the WirelessOffice system is a 
standalone, MS Loopback adapter can be set up in place of 
the network card adapter. 

1. To set up TCP/IP, go to Start | Settings | Control 
Panel | Network | Protocols tab.  

2. If TCP/IP is not listed as a protocol, click on Add and 
select TCP/IP from the Select Network Protocol screen. 

3. To set up MS Loopback, go to Start | Settings | Control 
Panel | Network | Adapters tab. 

4. Click on Add and select MS Loopback Adapter from 
the Select Network Adapter screen. 

5. During setup, Specify an IP Address. Type in 127.0.0.1 
as the IP Address. Type in 1.1.1.1 as the Subnet Mask. 
The Default Gateway does not need to be changed. 

Server stopped error: Received error 
“Server is stopped”.  

Restart the server from within WirelessOffice Administrator by 
going to File | Change Server. Select the server you wish to 
start. Click the Start Service button. 
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�� $GPLQLVWUDWRU�7RROV�

Reported Problem Solution 
Received error message: “This 
database is not a recognized version.  
Exiting.” 

The file selected is not a WirelessOffice database.   

No current record error message: This can be caused by an empty Version table in 1.1 or 1.1.1 
databases.  (Version 1.0 databases do not have a Version 
table.)  Solution:  Open your 1.1 or 1.1.1 database in Access 
97.   
Important: Hold down the SHIFT key while the database is 
opening.  Open the Version table, this allows you to examine 
the tables.  Double-click the Version table, if there are no 
records, type 1.1 to close the database.  Try converting the 
database again.  If you do not have Access 97, contact an 
Emergin representative. 

No dbf file found: <filename>.dbf file 
not found 

The dbf file was not found in the directory.  All OS/2 dbf files 
are required before the import can take place.   

�� :LUHOHVV2IILFH�6HUYHU�

Reported Problem Solution 
Server stopped error: Received error 
“Server is stopped”.  

Restart the server from within WirelessOffice Administrator by 
going to File | Change Server. Select the server you wish to 
start. Click on the Start Service button. 

Unable to initialize variable error:  WirelessOffice Server must be loaded onto a Windows 
NT/2000 system. 

WOSRV.exe Dr. Watson error: 
WOSRV.exe locks up or receives a 
Dr. Watson error. 

Several things could cause this: 
1. Customer’s e-mail gateway is down.  
2. Unipage hardware is locking up. 
3. 56k line to the direct connect is overloaded. 
4. If the direct connect plug (e.g. Unipager or Pagebridge) is 

unplugged while sending messages, the server will lock up. 
5. The database may have grown too large due to temp file 

accumulation. You need to Repair and Compact ODBC. 
Go to Start | Settings | Control Panel | ODBC Data 
Sources. Click on the System DSN tab. Click 
WirelessOffice 3.0 then click on Configure. In the 
Database field, click on Repair, then OK. After that 
finishes, click on Compact from the Database field, then 
OK. 

6. If you have converted from OS/2, inputting more than 20 
time shifts in Alarm Messenger causes this error. 
Streamline shifts down to 20. 

�� �
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�� 'LVSDWFKHU��PHVVDJH�VHQGLQJ��

Reported Problem Solution 
Adding Ports- No modem listed: 
Unable to see the configured modem 
when adding new Ports. 

To see newly configured modems, you must restart the 
WirelessOffice service. Go to File | Change Server. Stop and 
re-start the service. 

Auto Resend is not working: 
Message sending works fine. 

Auto resend only works with carriers that support TAP version 
1.6 or greater. TAP error code 512 (signifying device busy or 
out of range) must be returned to our system in order for the 
auto resend to function. 

Error - Cannot process multi block 
pages: In the Message Log Status 
Description field, messages fail.  In the 
Carrier log the following error is 
reported, “Error: Cannot process multi 
block pages". 

Block size and message length settings are set incorrectly.  
Verify with carrier the correct block size, which is typically 256 
with a message length of 240, but may vary. If the error is 
occurring for only one user, verify that individual’s maximum 
message length, which may differ from the carrier’s settings 
due to the user’s paging plan.  

Message fails - modem never dials: 
In the Message Log Status Description 
field, message becomes Fail status 
and the modem never dials. 

1. Make sure the correct COM port is selected for the modem. 
Go to Start | Settings | Control Panel | Modems to see 
which port a particular modem is configured on.  

2. Make sure modem is configured with appropriate driver. If 
new modem driver is installed, start and stop Administrator 
service and then enter Ports tab.  

3. Enter COM port information for that modem in the 
WirelessOffice Administrator Ports tab. 

4. Test modem with HyperTerminal.  
Message fails - only one carrier: The 
Message Log status is fail, unable to 
send to just one carrier. All other 
carrier’s messages report success in 
the Message Log. 

Solution 1: Call the carrier and ask if they are having any 
problems on their side. Verify the following settings: Is the 
terminal you are dialing TAP protocol version 1.3 - 1.8 
compliant? Are you dialing the correct terminal dial-up phone 
number? Are you using the correct User PIN? In User 
Properties in WirelessOffice Administrator verify: Maximum 
message length (our default is 240), Maximum number of 
fragments (our default is 5). In the Carrier's properties verify: 
Maximum block size (our default is 256), Maximum messages 
per connection (our default is 20), baud rate (our default is 
2400), parity (our default is even), data bits (our default = 7), 
flow control (our default is on). 
Solution 2: Enable and review the COM port logs and look for 
a lack of login response (ID=), as some carriers require more 
time to go through the login and connection sequence than 
WirelessOffice provides.  
To adjust login and connection timeouts: 
1. Enter the registry, by clicking Start from the taskbar, point 

to Run. Type regedit in the Open text box. Click OK. 
2. Click Registry | Export registry file. Type in the file name 

for a backup of your registry (registry_backup). Press 
enter. You have now backed up your registry to 
c:registry_backup.reg. 

3.  Next find the following key 
HKEY_LOCAL_MACHINE\SOFTWARE 
\Emergin\WirelessOffice\Dispatcher. For the following 
settings, use the following values (in hex mode) and test 
message sending. When finished, close the registry editor. 
Changes are already saved. 

redial_delay_sec 0 (but may be adjusted if needed, useful if 
the terminal goes through busy phases) – this must be 
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Reported Problem Solution 
manually added. 
timeout_connect_ms 2500 (which equals 2.5 seconds, use 
500 to increment, default is 2000) 
timeout_thresh_connect 5 (default is 3) 
timeout_thresh_login 5 (default is 3) 

Message fails - sending fine 
yesterday: In the Message Log Status 
Description field, all messages stay 
queued or fail. Messages were all sent 
successfully 1 day ago. 

1. Make sure all cables are properly connected and 
connections are plugged in on WirelessOffice Server 
system. 

2. Contact carrier. Ask them to check their RS-232 cable 
connections on their side. 

3. Ask if carrier terminal is down. Ask them to reboot terminal. 
4. Review modem driver information in Control Panel. Modem 

may have been changed or removed. Replace the modem 
driver. 

Sent message not received on 
device: Pages are accepted in the 
logs but are never received on the 
devices. 

Reception or terminal problem. Carrier may be busy at that 
time. Contact carrier if problem persists. 

TAPI Errors - All  Go to www.emergin.com. Open the Knowledge Base, click 
the Search tab. Search for the Error Message Codes topic. 

TAPI Error 1000 - No ID=: In the 
Message Log Status Description field, 
received TAPI error 1000: "No ID=". 
Message goes to Fail status. 

For direct connections, check baud rate with carrier. Test 
different baud rates. If baud rate changes do not resolve issue, 
change modem driver from USR 56k to standard 28,800.  
For SMTP connections:  
1. Verify that the SMTP carrier is correctly configured. Verify 
that the user is correctly linked to the carrier. 
2. Click Tools | Options and select the SMTP tab. Review 
those settings. 
3. Confirm a connection with the SMTP carrier. Go to the 
Command Prompt utility and type ping [IP address of the 
carrier]. For example, ping mail.MIA.bellsouth.net. Four reply 
lines indicate a positive connection. 
4. If all settings are correct and no connection is available, 
check that your firewall is not blocking the connection and the 
computer you are working on is connected correctly to the 
network. 
5. Contact the Internet Service Provider if no resolution is 
found. 

TAPI Error 1001 - Error 
handshaking: All messages report 
Fail in the Message Log Status 
Description field with TAPI Error 1001- 
"error handshaking".  

1. Call carrier for their preferred baud rate. 
2. Test different baud rates.  
3. If unresolved, review your modem driver in the Control 

Panel. Test with correct/most current driver in place. If 
necessary, change the driver to a Standard 28,800 Driver.  

TAPI Error 1030 - Modem is in use: 
In the Message Log Status Description 
field, received TAPI error 1030 & 
1042: "Modem is in use". Message 
becomes Fail status. 

1. Close or uninstall RAS (Remote Access Service) program 
or stop RAS service. To stop the RAS service, go to Start | 
Settings | Control Panel | Services. Make sure all remote 
access and telephony services are stopped and set to 
manual. Re-boot system.  

2. Close or uninstall Fax program.  
TAPI Error 1064 - No ID=: In the 
Message Log Status Description field, 
received TAPI error 1064: "No ID=". 
Message goes to Fail status. 

Solution 1: Incorrect carrier phone number. Test phone 
number by calling it. Call carrier for correct call in number. 
Solution 2: This solution applies to cases that are failing only 
to one carrier. Call the carrier to see if they are having any 
problems on their side. Review COM logs and look for a lack 
of login response (ID=), as some carriers require more time to 
go through the login and connection sequence than 
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Reported Problem Solution 
WirelessOffice provides. Please see Message fails - only one 
carrier, Solution 2. 
Solution 3: In cases where a 56k direct connect line to the 
carrier has been installed, adjust the timing thresholds in the 
registry outlined in the “Message files- only one carrier” 
dispatcher problem. Experiment with different settings until a 
successful message is sent.  

:LUHOHVV2IILFH�0HVVHQJHU�����No reported problems.�

&RPPDQG�0HVVHQJHU�

Reported Problem Solution 
RPC 1722 server is unavailable 
error: Received RPC 1722 error, 
“RPC Server is unavailable”. 

Before sending messages from your third-party software or at 
the Command Prompt, you must first type the internet address 
(or name) to configure Command Messenger. Type cmdmsgr 
–i[internet address] –u[user name] –
w[password ]. If you receive PASS messages for all three 
commands, Command Messenger is ready to send messages. 

�� )LOH�0HVVHQJHU�

Reported Problem Solution 
Misspelled word not accepted: 
Misspelled word caused UNIX script to 
not be accepted.  

Verify all spellings in scanned files. 

Page-enabling UNIX:  You can ftp UNIX files to a shared directory on a File 
Messenger system. File Messenger is pre-configured to 
monitor that particular directory for certain file extensions. 
When a new file is placed into that directory with a specific 
extension, File Messenger reviews the data and if it composed 
in the correct file format the message is sent. 

�� (�PDLO�0HVVHQJHU�

Reported Problem Solution 
E-mail Messenger not accepting e-
mail: Either e-mail messaging is not 
working and/or a test message does 
not work. 

1. In Control Panel double-click the E-mail Messenger icon. 
Click the Service tab. If the service is running, click on the 
WirelessOffice tab and click Test Connectivity. 

2. If you were able to confirm that the E-mail Messenger 
service is accepting connections, then verify that the domain 
of the computer is resolved in the DNS server. Otherwise, e-
mail coming from any Internet mail server will not reach E-
mail Messenger. You can verify this by going to the 
Command Prompt and typing: ping wireless.domain. 
com for example. If you receive four reply lines then the 
domain is configured. 

3. If a negative response of bad IP address returns, confirm 
that your IT Department has added the DNS record 
correctly. A domain name for the messaging gateway (i.e. 
wireless.domain.com) must be mapped to the Internet 
address of the E-mail Messenger workstation.  
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�� :HE�0HVVHQJHU�

Reported Problem Solution 
Cannot see newly added user, 
group or department: Just added in 
WirelessOffice Administrator, but 
cannot see it in Web Messenger. 

In Web Messenger, press SHIFT and Refresh at the same 
time for an updated screen. The new user/group/department 
will display in the Public Address Book (if available to the User 
Name login account’s accessibility and security rights). 

Gray box displays instead of Web 
Messenger during setup: 

1) Verify that a Web server is installed and configured on the 
PC running the Web Messenger service.  
2) Verify that your Internet browser has Java capabilities. If 
you are using Microsoft Internet Explorer V5.0 or greater, you 
are required to install the Java Virtual Machine. 
3) Verify that your company firewall supports Java. 

Server not started error: Error 
received “Server not started”. 

Go to Start | Settings | Control Panel | Web Messenger. The 
Web Messenger control screen appears. Start the service by 
clicking the green arrow on the Service tab. 

�� $ODUP�0HVVHQJHU�

Reported Problem Solution 
Install COM port cable error: Error 
received after each successful send, 
“Please install COM port cable”. 

Replace COM cable with one that is not Null (reverse pin). 

No data received: Not receiving data 
from RS-232 port. 

1. Review settings, make sure they are the same as device. 
Use trial and error to find correct baud, parity, data bit and 
stop bit settings.  

2. Check to see if RS-232 cable is unplugged or incorrectly 
cabled. 

Port Monitor not receiving data: 1. If you can view data using HyperTerminal, you may just 
need to click Start to begin streaming. To start data, click 
Run from the Alarm Messenger menu, and select Start. 
Also make sure in the Port Monitor that you have the right 
ports selected for viewing (in the monitor click View | Ports 
and select the port(s) to monitor). 

2. If data is not able to show, this could be caused by the 
input device settings not being in sync with the port settings 
in Alarm Messenger. Check your input device 
documentation for its specific settings (baud rate, parity, 
data bits, stop bits, flow control, etc.). You may need to use 
trial and error to find correct baud, parity, data bit and stop 
bit settings. Modify port information within Alarm 
Messenger by clicking Ports from menu tree. Click desired 
port. Right-click, select Properties. 

3. Check to see if the RS-232 cable is unplugged or incorrectly 
cabled. 

 

�� 9RLFH�0HVVHQJHU�

Reported Problem Solution 

When calling in, Voice Messenger 
will not accept my User Name: Have 
double-checked the spelling in 
WirelessOffice Administrator. 

1. Make sure you are using the Full Name listed on the 
User Properties tab rather than the Login User Name. 

2. You must use a 1 to indicate a space or any punctuation. 
Jane Doe would thus be typed into the phone as 
52631363. 

3. A password is required and must be defined in the user’s 
WirelessOffice Administrator profile. 
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When calling into Voice Messenger, 
I do not receive any prompts or 
directions. 

1. Check to make sure Voice Messenger is started in the 
control panel application’s Service tab. 

2. On the WirelessOffice tab, ensure you have valid user 
name, password and server entries. Click Test 
Connectivity. The User Name here should reflect the 
Login User Name. 

3. On the Voice Wave Files tab, make sure all .wav files 
are in the specified wave file folder. Play the 
greeting.wav file to make sure there is a message in 
place. 

4. Check the dedicated line connection and the voice/data 
modem. If the modem is correctly installed it will display 
on the Settings tab. We recommend using a 3COM U.S. 
Robotics 56K Voice Faxmodem Pro internal or external. 

5. Ensure that the wave sound device for the modem is 
properly installed. It will usually be visible as a “Half 
Duplex Serial Wave Device” in Start | Settings | Control 
Panel | Multimedia.  
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WirelessOffice offers a variety of server, carrier, port and archive logging. The following table 
depicts the logging description, the log file name, and configuration screen. All configuration takes 
place in WirelessOffice Administrator and log files are saved by default in C:\Program 
Files\Emergin WirelessOffice\Logs (you can select another location in Server Configuration). 

Logging options are also available for E-mail Messenger, File Messenger, Command Messenger, 
Voice Messenger and Alarm Messenger. 

Description File Name Configuration Screen 

Carrier Log, 
where logging is 
enabled per 
carrier 

Wocarriername.log Click the Carriers tab of the Server 
Administration window. Select the carrier you 
wish to log for and double-click to display 
properties. On the Carrier tab, select Enable 
Logging. 

Port Log, where 
logging is 
enabled per port 

Wocom#.log (com# 
reflects the com port 
number) 

Click the Ports tab of the Server 
Administration window. Select the port you 
wish to log for, right-click and select Logging 
Enabled. 

Message Log – 
monthly archive 

MLyymm.log Click Tools, then Server Configuration. 
Select the Logging tab. 

Message Log – 
weekly archive 

MLyymmww.log Click Tools, then Server Configuration. 
Select the Logging tab. 

Message Log – 
daily archive 

MLyymmdd.log Click Tools, then Server Configuration. 
Select the Logging tab. 

Activity Log 
archive 

Activity.log Click Tools, then Server Configuration. 
Select the Logging tab. 

Backup Activity 
Log 

Activity.old Open this log by clicking Tools and selecting 
View Backup Activity Log. 

Dispatch Log  Wodispatch.log To disable Dispatch logging: 

1. Open c:\winnt\wolog.ini. 

2. Set Logging=NO under the [dispatch] 
section. 
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�� &DUULHU�/RJ�([DPSOH�
The following carrier log depicts a successful conversation between WirelessOffice and the 
wireless carrier: 
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The following log example depicts a successful transmission interaction: 
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�� &DUULHU�4XHVWLRQQDLUH�

When configuring new carriers, it is recommended that you contact each carrier’s customer service 
representative and confirm the following information. Enter all information using the Carrier 
Wizard (please see page 33).  

 

 Carrier #1 Carrier #2 Carrier #3 Carrier #4 

Carrier Name     

Modem Connection Info     

Modem access phone 
number  

    

Baud Rate     

Parity     

Stop Bits     

Flow Control (on or off?)     

Maximum messages 
allowed per connection 

    

Largest block size allowed 
(message length) 

    

Volume of messages 
allowed per minute 

    

Modem Specific   
User Info 

    

PIN Number     

Maximum message length 
allowed for user (if 

different than carrier 
default) 

    

SMTP Connection Info     

Destination Domain 
(carrier’s e-mail domain) 

    

SMTP Specific User Info     

PIN Number or Address     
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Thinking ahead and planning your security implementation will ensure a secure WirelessOffice 
system. After reading through the security definitions and examples starting on page 26, configure 
your default user settings (see page 28). Then plan out your system using the following worksheet. 

�� 6HFXULW\�6HWWLQJ�&KRLFHV��

Security Level 

• 0 to 100 
• 0 allows 

FastPIN or 
PIN/Carrier 
messaging only 

User Rights 

• Same/Same or lower 
• Departmental Msg (DM) 

Decide which depts. will be 
accessible to user  

• Group Msg (GM)  
• Message Scheduling (MS)  
• Personal Addressbook (PA)  
• Device Editing (DE) 
 

 

Administrative 
Security Level 

• 0 to 100 
• 0 denies access to 

Administrator 

Administrative Rights 

Same/Same or lower 

Server Admin:  
• Users (U)  
• Groups (G)  
• Departments (D)  
• Carriers (C) 
• Ports (P) 

Server Activity:  
• Connections (C2)  
• Activity Log (AL) 
• Message Log (ML)  
• Scheduled Msgs (SM) 
• Escalated Msgs (EM) 

 

Step 1: Define users who will send messages via WirelessOffice Messenger or Web Messenger 
(Administrative Security Level should be set to 0. To define departments first go to Step 4): 

Full Name of User User Security Level User Rights 

Bobby Simpson 50 Same, GM, PA 
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Full Name of User User Security Level User Rights 
   

   

   

   

   

   

   

   

   

 

Step 2: Define users who will send messages and access WirelessOffice Administrator (note that 
the ‘Administrator’ account is not adjustable): 

Full Name of 
User 

User Security 
Level 

User Rights Administrative 
Security Level 

Administrative 
Rights 

Jane Benedict       
(Sales Manager) 

80 Same or lower, DM (all 
depts.), GM, MS, PA, DE  

80 Same or lower, U, G, D, 
SM 

     
     
     

     

     

     

     
 

Step 3: Define login accounts for applications (the ‘Administrator’ account can only be used to 
login to one application at a time): 

Full Name of 
User 

User Security 
Level 

User Rights Administrative 
Security Level 

Administrative 
Rights 

Command 
Messenger 

100 Same or lower, DM 
(technical and repair 
depts.), GM, MS 

0 none 
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Step 4: Define departments and their security level: (Security level only evaluates WirelessOffice 
Administrator users’ department editing ability. Message sending ability is dependent on 
department access definitions with Departmental messaging selected in each users’ profile.) 

Department name Security 
Level 

Department members Message sending departmental 
access (enter in each users’ profile) 

Marketing Department 50 Melissa Anderson, Malika Smith, 
Tom Banks, Marvin Gladstone, 
Luis Espinosa, Henry Caldwell 

All members, Steve Jackson, Melinda 
Baker, Bob Haskins, Enrique Gomez, 
Susie Teale, Lucy Calderon 

    

    

    

    

    

    

    

    

    

    

    

 

Step 5: Define groups and their security level: (Security level evaluates both message sending and 
WirelessOffice Administrator access. A user must have Group messaging enabled in their 
profile.) 

Group name Security Level Group members 

Field Reps 80 Toby Danski, Alegria Marquez, Miles Thompson, Lourdes 
Marcel, Alysa Nandoori, Manny Neukarelli  
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The .wav files must be saved using the exact file name and the following format: PCM, 8 kHz 
sampling, 16 bit data, 1 channel (mono).  

�� )LOH�1DPH� 0HVVDJH�
greeting.wav Welcome to WirelessOffice Voice Messenger. Please enter your name, 

followed by the Pound key. 

enter_pw.wav Please enter your password followed by the Pound key. 

enter_id.wav Please enter the ID number of the escalation to which you are responding, 
followed by the Pound key. 

greet_id.wav  Welcome to WirelessOffice Voice Messenger. Please enter the ID number 
of the escalation to which you are responding, followed by the Pound key. 

escl_mnu.wav The escalation is currently active. Press 1 to cancel the escalation, press 2 to 
escalate to the next level, or press the Star key to exit. 

notf_mnu.wav Press 1 to cancel the escalation without notifying previous recipients, press 2 to 
cancel the escalation and notify previous recipients, or press the Star key to exit. 

esc_cancel.wav The escalation has been canceled. Please enter the next escalation ID number, or 
press Star to exit. 

esc_level.wav Message has been escalated. Please enter the next escalation ID number, or 
press the Star key to exit. 

max_level.wav The escalation you entered was already at its maximum level.  Please enter the 
next escalation ID number, or press Star to exit. 

bad_un.wav I’m sorry, the name you entered is not recognized. Be sure to use the 1 key for 
any special characters and try again. Contact your WirelessOffice administrator 
for further assistance. 

bad_pw.wav The password you entered is invalid. Be sure to use the 1 key for any special 
characters and try again. 

dup_login.wav  I'm sorry, you are already logged into WirelessOffice at another station.  Please 
exit any other WirelessOffice applications and call back again. Good-bye. 

log_fail.wav   You currently do not have access to the WirelessOffice Server. Please contact 
your administrator and call back again. Good-bye. 

bad_id.wav The ID you entered is not recognized by the system.  Please check the number 
and try again. 

inval_opt.wav The key you pressed is invalid. Press Pound to hear your choices again. 

bad_cancel.wav I’m sorry, the escalation could not be canceled.  Please double-check the 
escalation ID and try again. 
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bad_level.wav I’m sorry, the escalation level could not be increased.  Please double-check the 
escalation ID and try again. 

moretime.wav Press any key now to make the system wait. Otherwise this call will be 
disconnected momentarily. 

waiting.wav The system is waiting.  Press any key to return to the previous function. 

limit.wav Login attempt limit exceeded. Please contact your WirelessOffice administrator, 
goodbye. 

goodbye.wav Thank you for using WirelessOffice Voice Messenger, goodbye. 
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access rights................................... Types of messaging and administrative rights assigned to 
each user limiting and allowing full access. 

activity log ..................................... A log that displays server activity, such as server additions, 
deletions and modifications, message sending, server 
connections, and system errors. 

Address Book ................................ A collection of users, departments and groups defined in the 
server’s database. 

auto resend..................................... A feature that automatically resends failed messages to 
dispatch at later time intervals. 

baud rate ........................................ A measurement of digital signaling speed, often used 
interchangeably with bits per second (bit/s) to specify the 
data-throughput rate of a modem.  

carrier............................................. Wireless carrier terminal that transmits messages to users. 

client .............................................. Software that requests actions from a server program running 
on another computer.  

COM port....................................... Communication Port. See Port. 

components.................................... Software modules that make up WirelessOffice. 

connect type................................... The type of connection to make with wireless carrier, such as 
modem dial-up or on-site direct connection. 

connection ..................................... An active WirelessOffice client application currently running 
on the server. 

data bits.......................................... Defines how many bits (7 or 8) represent a character when 
transmitting data. Always coupled with a parity setting. 

data source..................................... A database provider, being either Microsoft Access or SQL 
Server. 

database ......................................... A collection of data defined and maintained by the system 
administrator on the server. It includes hardware connection 
settings; user and device data; group and department 
membership data; and wireless carrier details. 

department record .......................... A collection of data about a department defined in the 
server’s database such as the name of the department, its 
members and security level. 

device............................................. In WirelessOffice, a device is the type of equipment that will 
receive the message (one-way pager, two-way pager, digital 
phone or PDA). 
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DNS ............................................... Domain Name System. The DNS translates the alphabetical 
domain name to a numeric IP address reflecting the E-mail 
Messenger system location. 

domain ........................................... E-mail addressing domain, such as 
jane.doe@wireless.domain.com with wireless.domain.com 
being the domain name. 

escalation ....................................... A type of messaging that ensures someone responds to an 
alert promptly. If a message is sent to one person and no 
response is returned, the message is escalated to the next 
level and another person is then alerted, ensuring that the 
message is received and addressed. 

FastPIN .......................................... WirelessOffice feature that enables messages to be sent to 
someone that may not be in the user database. The PIN and 
carrier name are used to address and send the message. 

firewall........................................... The main purpose of a firewall system is to control access to 
or from a protected network (i.e., a site). It implements a 
network access policy by forcing connections to pass through 
the firewall, where they can be examined and evaluated. 

flow control ................................... Used to control the transfer of messages or characters 
between two points and prevent the loss of data when the 
receiving device’s buffer begins to reach its capacity. 

fragments ....................................... A message is broken into pieces and sent in a series of 
fragments when it exceeds the maximum message length set 
by the carrier. 

group record................................... A collection of data about a group defined in the server’s 
database such as the name of the group, its members and 
security level. 

handshaking................................... The exchange of predetermined signals between two data 
terminals at the beginning and end of a call, in order to 
establish and then shut down a communications path 
between them. 

LAN............................................... Local Area Network. A network linking together computers, 
printers and related devices, usually over a short distance 
(less than 1 km) and normally within a single building or 
site. A LAN allows all users on the network to share 
resources, optimizing efficiency and avoiding unnecessary 
duplication of assets or effort.  

message.......................................... Alphanumeric text sent to a user’s mobile device. 

Message Log.................................. A log that displays messaging events. 

modem pooling.............................. Ability for multiple modems to dispatch messages to the 
same carrier. 
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ODBC............................................ An acronym for Open DataBase Connectivity. ODBC allows 
databases created by various database programs (e.g. Access) 
to be accessed by a common interface. 

parity.............................................. A binary bit appended to the data bits that enables the bit 
sum to always be odd or even. Used for error detection. 

PDA ............................................... A Personal Digital Assistant is a hand-held wireless device 
capable of receiving text messaging. 

Personal Address Book.................. WirelessOffice Messenger feature that allows the user to 
configure and maintain their own address book. 

PIN................................................. An acronym for Personal Identification Number. Usually the 
phone number for the device. 

pooling threshold ........................... The number of messages to be queued for the carrier before 
the system will begin using another modem in the modem 
pool. 

port................................................. Serial communications port used for output. Provides either a 
direct (on-site) or modem (dial-up) connection. Also called a 
COM port. 

protocol.......................................... A protocol sets standards and rules for two devices to 
communicate with each other relating to format and timing 
of data transmission. Carriers send messages using either the 
TAP or SMTP protocols. 

Public Address Book ..................... Another name for the server-based database of users, 
departments and group. 

recipient ......................................... User, group or department who is receiving a text message. 

RS-232........................................... A cable interface used for communicating between 
computers, terminals and modems. 

security........................................... A way of insuring server-based data is protected from 
unauthorized use. 

security level.................................. A security level reflects a range from 0 to 100, allowing 
different degrees of access. Each user, group and department 
is assigned a security level. 

server ............................................. Software that performs actions at the request of a client 
program running on another computer; a computer on which 
such software has been installed. 

SMTP............................................. An acronym for Simple Mail Transfer Protocol. SMTP is the 
TCP/IP protocol governing electronic mail transmissions and 
receptions. 

TAP................................................ An acronym for Telecator Alphanumeric Protocol. TAP has 
become the messaging industry standard protocol for sending 
message requests from automated equipment. 
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TAP response code ........................ A numeric code sent from the carrier to WirelessOffice 
signifying the status of the message. 

TAPI .............................................. Telephone Application Programming Interface or Windows 
Telephony API. TAPI is used by applications to manage 
telephony processes and allows several applications to share 
one port. TAPI error codes are reported to WirelessOffice as 
a troubleshooting aid.   

TCP/IP ........................................... An acronym for Transmission Control Protocol/Internet 
Protocol. The suite of protocols used to define membership 
of the Internet. TCP/IP specifies how data is sent and 
received over a network and how it should be routed and 
addressed. 

two-way messaging........................ The ability for a wireless device to receive messages and 
send a response to the sender.  

user ................................................ A person defined in the server’s database who can receive 
messages and/or login to the server to send messages. 

user record ..................................... A collection of data about a user defined in the server’s 
database, such as the user’s name and details about his/her 
mobile device. 

WirelessOffice client ..................... The software component of WirelessOffice that allows users 
to create and send messages to users defined in the server’s 
database; and view log entries, user and device data, and 
group membership. Also referred to as the computer running 
the client software. 

WirelessOffice Server.................... The software component of WirelessOffice that allows the 
system administrator to create and maintain the server’s 
database. Also referred to as the computer running the server 
software. 

WirelessOffice............................... Client/server software developed by Emergin to provide 
advanced wireless messaging to users of mobile devices.
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activity log, 56 
backup log, 56 
change defaults, 24 
deleting entries, 56 
icons, 17 

Administrator Alert, 52 
Administrator Tools, 188 
Adobe Acrobat install, 188 
Air Apparent upgrade, 189 
Alarm Messenger 

alert messages, 176 
alert responses, 172 
alerts, 158, 172 
capacities, 157 
configuring, 160 
convert input, 164 
data queue, 164 
database backup, 185 
demos, 180 
escalated messaging, 175, 181 
escalation view settings, 165 
input, 164 
input delimiters, 166, 167 
input ports, 166 
keys, 158, 169 
logging, 163, 167 
login, 152 
logs, 184 
operators, 170 
pageable alerts, 163 
passwords, 162 
port configuration, 166 
port monitor, 169, 179 
port monitor demos, 180 
recipient validation, 184 
sounds, 186 
starting, 152, 179 
stopping, 179 
system planning, 157 
test message, 178 
time shifts, 170 

alerts 
defining, 172 
identifying, 158 

authentication mode, 19 
Authorization Code, 8 

change, 22 
Auto-Resend, 53 

custom, 45, 53 
global, 25, 54 

block size, 37 
carriers 

adding, 32 

block size, 37 
connection type, 33 
deleting, 37 
enable logging, 35 
first-time setup, 209 
modem pooling, 36 
modifying, 35 
password, 37 
properties, 35 
questionnaire, 209 
requirements, 32 
viewing, 64 

client connections, 55 
Command Messenger 

commands, 95 
compatability, 93 
configuration, 94 
desktop shortcuts, 98 
escalated messages, 98 
logging, 95 
message sending, 96 

communication ports 
configuration, 30 

connection icons, 16 
database, 24 

importing, 65 
restoring, 186 

database upgrade, 189, 191 
departments, 38 

adding, 38 
deleting, 40 
membership, 42 
modifying, 40 
security, 38 
viewing membership, 63 

device availability, 52 
devices, 44 

enable responses, 45 
E-mail Messenger 

addressing rules, 123 
compatibility, 115 
configuring, 116 
domain configuration, 122 
escalation cancellation, 125 
failover domain, 120 
logging, 120 
login, 119 
message options, 120 
paging domain, 120 
starting, 118 
stopping, 118 
test message, 122 
two-way messaging, 124 

escalated messages, 61, 98, 113, 
137, 175 
cancel, 62 
escalate, 62 

escalated messaging, 149 
FastPIN, 51 
File Messenger 

capacities, 102 
configuring, 102 
directories, 103 
escalating messages, 113 
file types, 103 
logging, 105 
login, 107 
message sending, 109 
pageable alerts, 108 
scheduling messages, 112 
starting, 105 
stopping, 105 

firewall ports, 6 
fragments, 45 
groups 

adding, 47 
deleting, 48 
modifying, 48 
viewing membership, 63 

importing, 65 
undoing, 66 

input delimiters, 167 
installation, 8 

network, 10 
pre-installation, 6 

keys 
defining, 169 
identifying, 158 

knowledge base, 198 
logging, 131 

Alarm Messenger, 163, 167 
carrier log, 206 
carriers, 35 
COM port log, 207 
Command Messenger, 95 
defaults, 24 
E-mail Messenger, 120 
File Messenger, 105 
message log, 57 
server, 205 
Voice Messenger, 143 

login, 13 
message log, 57 

deleting entries, 57 
icons, 17 
resend messages, 58 



Index 

  221

statistics, 59 
two-way replies, 51 

messages 
adding a signature, 51 
Administrator Alert, 52 
escalated, 61 
FastPIN, 51 
numbering, 45 
options, 50 
resend, 58 
scheduled, 60 
scheduling, 50 
sending, 49 
spell check, 51 

modem pooling, 32, 36 
defined, 34 

passwords, 13 
personal address book 

adding groups, 88 
adding users, 87 
deleting entries, 89 
modifying entries, 88 

pooling threshold, 36 
ports 

configuration, 30 
deleting, 31 
viewing, 64 

printing, 18 
removing WirelessOffice, 11 
resend messages, 58 
saving to file, 18 
scheduled messages, 60 

deleting, 60 
disable, 22 
icons, 18 

scheduling messages, 50 
security, 26 

administrative rights, 29 
default settings, 28 
definitions, 26 
departmental access, 42 
departments, 38 
disable, 22 
examples, 27 
groups, 47 
levels, 28 
planning worksheet, 210 
rights, 26 
user rights, 28 

sending messages, 49 
Server 

activity log, 56 
adding users, 41 
authentication, 19 
capacity, 21 
carriers, 32 
client connections, 55 
configuration, 21 

database, 55 
deleting ports, 31 
departments, 38 
escalated messages, 61 
groups, 47 
importing, 65 
installation, 8 
logging, 205 
message log, 57 
modifying configuration, 21 
name location, 20 
ports configuration, 30 
scheduled messages, 60 
specification, 9 
starting, 13, 20 
statistics, 59 
stopping, 20 
system basics, 14 

Server configuration 
Auto-Resend tab, 25 
Database tab, 24 
Default User Rights tab, 28 
Logging tab, 24 
Setup tab, 22 
SMTP tab, 25 

Site Alert upgrade, 191 
SitePage upgrade, 191 
SMTP 

defined, 33 
SMTP settings, 25 
sounds, 54, 186 
spell check, 51 
SQL Server, 24 

conversion, 193 
starting the software, 13 
statistics, 59 

user, 63 
system requirements, 5 
TAP 

defined, 33 
technical support, 198 
time shifts, 171 
troubleshooting, 198 
two-way messaging, 124 

enable responses, 45 
reply pop-up dialog, 51 

upgrading, 8, 151 
Air Apparent, 189 
Site Alert, 191 
SitePage 2.0, 191 
WirelessOffice 2.0, 189 

users 
add devices, 44 
adding, 41 
auto-resend, 45 
deleting, 46 
modifying, 46 
password, 42 

security settings, 42 
statistics, 63 
viewing, 62 

Voice Messenger 
adding a modem, 146 
calling, 147 
cancelling a message, 147 
configuring, 139 
custom messages, 148 
disconnect timeout, 144 
escalated messaging, 149 
escalating a message, 147 
inactivity timeout, 144 
logging, 143 
login, 142 
message playback, 145 
modem configuration, 146 
modem selection, 143 
prompt scripts, 213 
recording messages, 148 
starting, 141 
stopping, 141 
voice wave files, 144 
wav file path, 144 

Web Messenger 
installation, 9 

Web Messenger – Plus 
about tab, 131, 132 
compose tab, 136 
configuring, 128 
escalation tab, 131, 137 
logging, 131 
login, 135 
message log tab, 136 
message sending, 136 
open in browser, 134 
PIN/Carrier method, 136 
public address book, 131, 135 
server address, 131 
starting, 130 
stopping, 130 
web server setup, 133 
WirelessOffice tab, 131 

web server setup, 133 
WirelessOffice 

features, 2 
installation, 8 
overview, 1 
removing, 11 
server capacity, 21 
sounds, 54 
system components, 2 
system configuration, 21 
system requirements, 5 
upgrading, 8, 151 
viewing server database, 55 

WirelessOffice Administrator 
activity log, 56 
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activity log icons, 17 
adding users, 41 
Administrator account, 13, 28 
authentication, 19 
carriers, 32, 64 
change Administrator password, 

23 
change server, 19 
client connections, 55 
connection icons, 16 
deleting ports, 31 
departments, 38, 63 
device availibility, 52 
disable security, 22 
enable responses, 45 
escalated messages, 61 
FastPIN, 51 
groups, 47, 63 
importing, 65 
main window, 14 
maximum message length, 22 
menu bar, 15 
message log, 57 

message log icons, 17 
message options, 50 
message replies, 51 
ports, 64 
ports configuration, 30 
printing, 18 
saving to file, 18 
scheduled message icons, 18 
scheduled messages, 60 
scheduling messages, 50 
security worksheet, 210 
sending messages, 49 
server configuration, 21 
spell check messages, 51 
starting, 13 
starting server, 20 
statistics, 59 
status bar, 18 
status icons, 16 
stopping server, 20 
system basics, 14 
toolbar, 16 
user statistics, 63 

users, 62 
window arrangement, 18 

WirelessOffice Messenger 
address book, 75, 84 
configuration, 68 
delete a message, 83 
device editing, 89 
FastPIN, 79 
login, 68 
message log, 71 
message options, 80 
message sending, 77 
network installation, 10 
personal address book, 87 
resend messages, 82 
scheduled messages, 73, 83 
scheduling messages, 80 
sound, 81 
starting, 67 
system basics, 69 
using, 67 

WirelessOffice Server. See 
Server 
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